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About this Documentation 

The aim of this documentation is to help you get up to speed with using IRISPowerscan™ 10.5.  

It covers IRISPowerscan™'s installation and setup, the basic processing steps and the application's commands and 
working areas. 

The descriptions in this documentation are based on the Windows® 7 or 10 Operating System.  

All information is subject to change without prior notice. 
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Legal Notices 

IPS10.5_sjo_15072018_5 

  

Copyright 

© 2019 I.R.I.S. All Rights Reserved. 

I.R.I.S. owns the copyrights to the IRISPowerscan™ software, the online help system and this publication. 

The information contained in this document is the property of I.R.I.S. Its content is subject to change without notice 
and does not represent a commitment on the part of I.R.I.S. The software described in this document is furnished under 
a license agreement which states the terms of use of this product. The software may be used or copied only in 
accordance with the terms of that agreement. No part of this publication may be reproduced, transmitted, stored in a 
retrieval system, or translated into another language without the prior written consent of I.R.I.S. 

This manual uses fictitious names for purposes of demonstration; references to actual persons, companies, or 
organizations are strictly coincidental. 

  

Trademarks 

The I.R.I.S. logo, IRISPowerscan™ and IRISPowerscan Server™, IRISXtract™ are trademarks of I.R.I.S. 

OCR ("Optical Character Recognition"), Linguistic technology, ICR ("Intelligent Character Recognition") technology, MICR 
("Magnetic Ink Character Recognition") technology, BCR ("Bar Code Reading") technology, OMR (Optical Mark 
Recognition), iHQC ("intelligent High Quality Compression") technology and HQOCR ("High Quality OCR") technology by 
I.R.I.S. 

Document Generation by I.R.I.S. 

Send to the Cloud by I.R.I.S. 

All other products mentioned in this User Guide are trademarks or registered trademarks of their respective owners. 

  

Patents 

IRISPowerscan™ integrates the following patent-granted I.R.I.S. technologies: US8068684; US8331706; US8666185; 
JP5501958; US8995780; EP2143039A2; BE1022166; BE1022635; US8913836; BE1022630; US8897600; BE1022636; 
US8811751; US8411940; BE1021013; US9058517; US9183636; US9311558; BE1025006; BE1022562; US9798943; 
BE1024194; US9836646; BE1024836. 
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1. About IRISPowerscan™ 

1.1 What is IRISPowerscan™? 

IRISPowerscan™ is a powerful production scanning and document classification solution. It is able to process large 
volumes of documents coming from any high-speed scanner and MFP (multifunction peripheral). 

The documents you process with IRISPowerscan™ can be fully indexed, hyper-compressed, converted into a wide range 
of editable and text-searchable output formats, and sent to any DMS (document management system), ECM 
(enterprise content management) or Cloud system you might already use. In other words, IRISPowerscan™ turns paper 
documents into structured knowledge that is easily accessible. 

1.1.1 General Features 

High-speed scanning 

IRISPowerscan™ can scan up to 10,000 pages per computer per day. Its scanning speed can be unlimited and only 
depends on the scanning speed of your scanner. 

IRISPowerscan™ is compatible with Twain scanners and with MFPs. It supports simplex and duplex scanning, and also 
multi-stream scanning (where color and black and white images are scanned simultaneously). 

IRISPowerscan™ also supports scanning from folders and from the Cloud. 

WARNING: when scanning documents to the Invoice Add-on (SPAP or Solution Package Accounts Payable), you 
must select the Force Simplex option of the Scan settings. This is because the Invoice module only supports front 
pages. 

Page Identification and Document Classification 

All paper documents / electronic files that are scanned in IRISPowerscan™ are classified into a logical structure of 
Batches, Documents and Pages. For each of those elements, you can define different types. To distinguish between the 
types, various separation criteria can be used. For instance, blank pages, OCR zones, barcode zones, patch codes, etc. In 
fact, in IRISPowerscan 10 each condition you configure can be used as separation method. 

What's also new is that IRISPowerscan™ can now also uniquely identify page types. That way, you can apply operations 
(like image processing, data extraction, page deletion etc.) only to those pages where they are required. Once 
IRISPowerscan™ has identified the page types, you can separate documents based on those page types. 

Image Processing 

The scanned images can be enhanced with IRISPowerscan™'s Image Processing features. IRISPowerscan™ can for 
instance binarize, despeckle, deskew and rotate them. Enhancing scanned documents improves the recognition 
accuracy and generates documents that are smaller in size and easier to process. 

The order in which IRISPowerscan™ executes the image processing operations is no longer fixed, but can be user-
defined. You can also choose to apply these operations only to specific batch/document/page types. You can also 
choose to apply these operations only to the front or rear side of a scanned page, or to both sides. 

Data Extraction and Document Indexing 

IRISPowerscan™ offers powerful data extraction features: it can extract data from scanned documents through OCR 
(optical character recognition), BCR (barcode recognition), PCR (patch code recognition) and ICR (intelligent character 
recognition). The extracted data can be used in several ways: as variables to define a page/document/batch type, or to 
populate user-defined index fields, etc. 
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The index fields you create in IRISPowerscan™ can be mapped to the index fields you already use in your DMS, ECM or 
Cloud system. Consequently, IRISPowerscan™ can send fully indexed documents to those systems. 

In terms of OCR, IRISPowerscan™ recognizes typewritten data in up to 137 languages. All American and European 
languages are supported, including Central-European languages, Greek, Turkish, the Cyrillic and Baltic languages. 
IRISPowerscan™ also recognizes 4 Asian languages (Japanese, Simplified Chinese, Traditional Chinese, Korean), Hebrew 
and Arabic. 

Quality Control and Validation 

When documents have been scanned they are displayed in Navigation mode, where a full range of tools are available 
for post-scanning operations. You can rescan, rotate and rename them, rearrange them by using splitting, merging, 
drag and drop, cut and paste, etc. 

All index fields can be validated and modified in Navigation mode. 

Document Formatting and Compression 

IRISPowerscan™ converts scanned documents into a wide range of output formats, such as searchable PDF, Word 
(in .docx and .rtf) and many more. The PDF documents you generate can be hyper-compressed with I.R.I.S.' proprietary 
and patented compression technology iHQC. 

Output Destinations 

IRISPowerscan™ can send processed documents to standard output destinations such as folders and email. You can also 
send them to various DMS, ECM and Cloud systems such as Therefore, Microsoft SharePoint, IRISNext, IRISXtract, 
FileNet, CMIS, Google Drive, OneDrive, box, Dropbox and Evernote. You can also set up customized destinations 
through IRISConnect™. 

1.1.2 IRISPowerscan™ Components 

IRISPowerscan 10 consists of the following three components: 

• IRISPowerscan™ main application: is where you configure projects to scan and process batches of paper 
documents. 

• IRISPowerscan™ Agent: alerts you when a new batch is awaiting user action. It can also be used to quickly 
open IRISPowerscan™. The Agent is displayed in the System Tray on the Desktop. 

• IRISPowerscan Server™: is used to share projects, batches, user rights, groups and permissions among multiple 
workstations. 

To access the IRISPowerscan Server™ documentation, open the IRISPowerscan Server™ application and 
click File > Help. 

Note: if you wish to process invoices in IRISPowerscan™ you need to install the IRISPowerscan™ Invoice Add-on. 
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1.2 Glossary 

Before you get started with the IRISPowerscan™ User Guide, it is recommended to familiarize yourself with the most 
important IRISPowerscan™ concepts and terminology. 

  

• Project: projects are the core of IRISPowerscan™. Each project is a specific configuration to scan and process 
documents. Within a project, scanned documents are always divided into a batch > document > page 
structure. 

• Batch: a batch is a collection of documents. 

• Document: a document is a collection of pages. 

• Page: a page is the scanned equivalent of one side of a paper sheet, or the equivalent of one image imported 
into IRISPowerscan™. A Page is either Front or Rear. 
A Page may contain multiple streams, i.e. bitonal, color and grayscale. 

WARNING: in the 10.3 versions of IRISPowerscan 10, a page used to be the scanned equivalent of a paper 
sheet, i.e. containing both the Front and Rear side. 
This has implications for Duplex scanning projects where the variables Page.Index or Page.Count is used to 
separate Documents or Batches. Suppose you configured the project to start a new Document every 2 
pages: Page.Index>2. Because of the new Page structure in IRISPowerscan™ this must be changed to 
Page.Index>4. 

• Identification: means uniquely identifying a page. 

• Classification: means classifying (or separating) pages into a document and batch structure. 

• Expression: an expression consists of literal values, variables, operators and functions. 

• Condition: is a Boolean expression. Its value is either true or false. Conditions are used as identification and 
classification criteria. 

Tip: see Using Expressions and Using Scripts for more information. 

• Unattended Mode: an unattended mode project is a project for which all  activities are executed 'as a Service' 
(Capture, Validation and Export). 

 

Unattended Mode 
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1.3 New features in IRISPowerscan™ 10.5.11 

This chapter highlights new features, improvements being dispatched at their right place throughout the full 
documentation. 

  

New parameter for Big Documents 

For trouble-free exports, we strongly recommend that you limit large documents to no more than 1000 pages per 
document.  

However, now that limit can be increased up to 4000 pages per document (200 or 300 dpi color) by adding and setting 
the new parameter BigDocumentExport to 'Yes'. 

See Chapter 5 > Configuration Pane > Parameters 
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1.4 IRISPowerscan™ Add-ons 

The following add-ons are available for IRISPowerscan™ 10.5: 

  

• iHQC Add-on (Volume based) 

• Invoice Add-on for IRISPowerscan™ (Volume based) 

• Additional connectors 
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1.4.1 iHQC Add-on 

iHQC stands for intelligent High-Quality Compression and is I.R.I.S.' proprietary compression technology. It is designed 
to convert standard document images into hyper-compressed color (or black-and-white) PDF and XPS documents, 
without loss of image quality, for easy sharing and cheap storage. 

Volume Licenses 

Several volume licenses are available for the iHQC add-on. Which add-on you should acquire depends on the number of 
pages you want to process per year. 

The volumes licenses are yearly renewable. They are reset automatically on the anniversary date of first use. 

Levels of iHQC 

Four levels of iHQC are available for PDF documents, and one level for XPS documents. 

In each level, you can use the Quality slider to favor quality over size and vice versa. 

Level 1 is available by default and does not require an add-on. 

Benefits 

• Extremely small output images, saving you a lot of disk/server space. 
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1.4.2 IRISFingerprint Add-on 

(This add-on is by default enabled in the Corporate, Business, Enterprise and Production versions of 
IRISPowerscan™ 10.5) 

  

Thanks to the Fingerprint add-on, IRISPowerscan™ is able to examine the layout of the scanned images. That way it can 
uniquely identify pages. Once IRISPowerscan™ has identified the page types, you can separate documents or batches 
based on those page types. 

Note: in order to use Fingerprint detection you must provide IRISPowerscan™ with binarized samples of the images 
that must be used for Fingerprint detection. 

Benefits 

• Very fast separation of batches and documents. 

• Easy to set up. 

• No need for separator pages based on barcodes, patch codes or OCR zones. 

• Efficient with bad quality OCR documents. 

Limitations 

• The geometric elements must be constant: handwritten text and non-separable, overlapping items are not 
suited for Fingerprint recognition. 
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1.4.3 ISISDriver Add-on 

(This add-on is by default enabled in all versions of IRISPowerscan™ 10.5) 

  

IRISPowerscan™ natively supports TWAIN and TWAIN-VRS. Thanks to the ISISDriver add-on, you can also use ISIS 
scanners in combination with IRISPowerscan™. 

ISIS stands for Image and Scanner Interface Specification. The ISIS drivers provide scanner support for over 400 ISIS 
scanners. 

Benefits 

Below you find an overview of the benefits ISIS drivers provide compared to TWAIN drivers. 

• ISIS drivers provide the most robust scan feature support. 

• The driver interface is consistent from scanner to scanner. This is not the case with TWAIN drivers. 

• ISIS drivers optimize the hardware scanner's performance, allowing it to always run at rated speed. 

• ISIS drivers provide a consistent interaction with all ISIS scanners and vice versa. 



IRISPowerscan 10.5 – User Guide 

11 

1.4.4 Central Management Add-on 

(This add-on is by default enabled in the Professional versions of IRISPowerscan™ 10.5) 

  

The Central Management Add-on allows you to connect IRISPowerscan™ to IRISPowerscan Server™. 

By means of IRISPowerscan Server™, Administrators can set up a Client Server Architecture between IRISPowerscan 
Server™ and multiple IRISPowerscan™ Workstations - or Clients on the same LAN network. This way the different 
activities of IRISPowerscan™ - being Capture, Validation and Export - can be divided over different Clients and you can 
set up an entire workflow process. Some users take care of the scanning, while others do the index validation and still 
others do the export. 

Note that on each computer you want to use as IRISPowerscan™ Client you need to install an instance of the 
IRISPowerscan™ application and activate the Central Management Add-on. 

Benefits 

It is no longer necessary to configure each IRISPowerscan™ station separately. Every scanning station can be 
synchronized automatically from the IRISPowerscan Server™. 

For more information see the IRISPowerscan Server™ documentation. 

WARNING: the Invoice Add-on module is not supported in this central management mode.   
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1.4.5 Background Processing Add-on 

(This add-on is by default enabled in the Corporate, Business, Enterprise and Production versions of 
IRISPowerscan 10) 

  

The Background Processing Add-on enables IRISPowerscan™ to have the Export done by the Service, i.e. in the 
background. This way, you don't have to wait for your batch to be processed before scanning the next batch. 

Note: the Background Processing Add-on is not required to have the Capture and Validation done by the Service. 

Also see Processing Documents in IRISPowerscan 10. 

Benefits 

• Increased scanner productivity. 
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1.4.6 Invoice Add-on for IRISPowerscan™ 

The Invoice Add-on for IRISPowerscan™ allows you to process invoices in IRISPowerscan™.  

For more information see the Invoice Add-on for IRISPowerscan™ documentation. 

  

WARNINGS:  
The Invoice Add-on is not compatible with the central management feature. You cannot use it in such 
configuration. The Invoice Add-on is for standalone single seat use only.  
The Invoice Add-on is not designed to work in the Unattended Mode (all activities as a service). 
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1.4.7 Canon Barcode Module 

The Barcode Module (III) is an add-on software program for adding the barcode reading function to the ISIS/Twain 
driver. 

Benefits 

This optional barcode software can automate many workflow processes such as indexing, batch separation, etc. 

Activation 

• Contact your Canon representative to obtain the Barcode Module. 

• Run the corresponding setup.exe file to install it. 

Configuration 

• Open your ISIS/Twain scan functionality. 

• Click the Others tab. 

• Click the Barcodes button. 

 

• Select Enable barcode detection and select the barcode types the module must detect: QR, PDF417 and Data 
Matrix. 

• In the IRISPowerscan Expression Editor, four new corresponding variables are now available. This means the 
module can read up to four barcodes per page. 

 

• These new variables can be used inside expressions like any other variables. 
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2. Installation and Activation 

2.1 System Requirements 

WARNING about Virtual Machines:  
Some virtual machines running on a laptop or small computer may not be usable. Some scanners are not 
recognized properly and the IRISPowerscan™ installation may fail if the Virtual Machine is not up to date with the 
latest Windows updates. Also note that a Virtual Machine must have at least 4 virtual cores (or vCPU).  
If your virtual machine has vSocket and vCore, you must multiply them to obtain the amount of vCPUs. 

Minimum System Requirements 

• 2.2 GHz processor (32- or 64-bit). 

• 4 GB RAM. 

• 5 GB free hard disk space. 

Recommended System Requirements 

• Processor Intel i5, i7 or similar. 2.6 GHz or faster (64 bit), with at least 2 cores. 

• 8 GB RAM. 

• 10 GB free hard disk space, preferably on a Solid State Disk drive. 

• Internet connection. 

Minimum System Requirements for Server 

• 8 GB RAM 

• 10 GB free hard disk space, preferably on a Solid State Disk drive. 

• At least 4 processors or more. 

IRISPowerscan™ will use all available resources. The more resources, the faster the processing. 

• SSD drives are highly recommended. 

Supported Operating Systems 

• Windows 7 (32 and 64 bit)  

• Windows 8 (32 and 64 bit)  

• Windows 8.1 (32 and 64 bit)  

• Windows 10 (32 and 64 bit) ** recommended 

• Windows Server 2012 R2 (64 bits) 

• Windows Server 2016 (64 bits) ** recommended 
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2.2 Supported Scanners 

• IRISPowerscan™ is compatible with virtually any Twain-based professional scanners. All the major scanner 
vendors are supported (Canon, Kodak, Panasonic, HP, Fujitsu, Inotec, Xerox, Epson...). 

• IRISPowerscan™ can be used in combination with ISIS-based scanners through the ISIS-driver Add-on. 

• IRISPowerscan™ is compatible with MFPs thanks to the scan from Folders functionality. 

Note: when using a Twain-based scanner, at least Twain version 1.9 or higher is required. 
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2.3 Installing IRISPowerscan™ 

WARNING: if you are upgrading from a previous version of IRISPowerscan 10, follow the instructions in the 
Installation and Activation Guide. 

• Download the IRISPowerscan™ package from: 

• the I.R.I.S Partner Portal  

• our website www.irislink.com/downloadcenterpro. 

• Run the IRISPowerscan 10.msi. 

Note: If you wish to share projects, batches, user rights, groups and permissions among multiple 
workstations, also run IRISPowerscan Server™.msi to install IRISPowerscan Server™. Note that the Central 
Management add-on is required to do so.  
If you want to process invoices in IRISPowerscan™, you need to install the Invoice Add-on for 
IRISPowerscan™. See the separate Invoice Add-on for IRISPowerscan™ documentation to learn how to do 
so.  
Attention, IRISPowerscan for Invoices is a stand-alone solution. It cannot be used in a Client/Server 
architecture. 

• Click Next and follow the on-screen instructions. 

• Click Finish to finish the installation. 

 

  

https://irisdatacapture.com/portal/
http://www.irislink.com/downloadcenterpro
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2.4 Activating IRISPowerscan™ 

WARNING: make sure to deactivate the anti-virus software on the computer before you try to activate 
IRISPowerscan™. Once the activation is complete you may reactivate the anti-virus software. 

• Double-click the IRISPowerscan™ shortcut on the Desktop. 

 

• Enter the Activation code. 
The activation code was sent to you by email. In case you have not obtained your activation code yet, contact 
I.R.I.S. at activation@iriscorporate.com. 

• Click Activate. 
Note that an internet access is required. If you cannot access the internet, do a Manual activation. 

 

• Click OK when the code has been accepted. 

Connector Activation 

If you have acquired a version of IRISPowerscan™ 10.5 that includes a professional connector, you are prompted to 
select the connector of your choice. 

WARNING: this choice is final. If you accidentally selected the wrong connector, see the topic How to obtain a 
Reset Code in the How To Guide. 

 

• Select the connector of your choice. 

• Then click Next, and Finish. 

mailto:activation@iriscorporate.com
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Manual Activation 

• In case the computer on which you are installing IRISPowerscan™ does not have internet access, click Manual 
activation. 

• Copy the Computer ID and the Activation code that was sent to you by email to a computer where you do 
have internet access. 

• Send both codes to activation@iriscorporate.com. 
In turn you receive the License code. 

 

• Enter the License code and click Activate. 

• Click OK when the code has been accepted. 

  

Note: once IRISPowerscan™ has been activated, its serial number can be found in the Application menu. Click File > 
Info > Generalities. 

 

Revocation of an activation code 

Some typical cases require a license reset: 

• Computer needs to be changed 

• Computer is damaged or needs a reformatting 

• Computer is lost or stolen -> you need to contact I.R.I.S 

In those cases, you first need to revoke your current activation code. This procedure revokes the license on the old 
machine and allows I.R.I.S to add a new activation on that license. Failing to do so will prevent new activation. 

Without proper revocation, no additional activation or license reset will be allowed. 

WARNING: After a successful revocation on one computer, it will never be possible to activate again the same 
activation code on the same computer.  

  

Procedure of revocation: 

Note: An Internet connection is needed. If not available, contact I.R.I.S. at activation@iriscorporate.com. 

1. Go to File > Info > Features 

2. Click Revoke in the right corner at the bottom of the screen 

 

mailto:activation@iriscorporate.com
mailto:activation@iriscorporate.com
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3. Follow the instructions on the screen 
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2.5 Activating Add-ons 

Multiple add-ons are available for IRISPowerscan 10. 

WARNING: make sure to deactivate the anti-virus software on the computer before you try to activate features 
and add-ons in IRISPowerscan™. Once the activation is complete you may reactivate the anti-virus software. 

To activate the add-ons you have acquired: 

• Click File > Info > Features. 
The features you have already acquired are listed. 

• Click Activate. 

• Enter the Activation code to activate the add-ons. 

Tip: you find your activation code on the packing slip you received from I.R.I.S. by email. 

Manual Activation 

• In case the computer on which you are installing IRISPowerscan™ does not have internet access, click Manual 
activation. 

• Copy the Computer ID, and the Activation code that was sent to you by email to a computer where you do 
have internet access. 

• Send both codes to activation@iriscorporate.com. 
In turn you receive the License code. 

• Enter the License code and click Activate. 

• Click OK when the code has been accepted. 

  

Note: when an add-on has been activated, you can retrieve its activation code in the Application menu. Click File > 
Info > Features. Now hover the cursor over your add-on to display its activation code. 

 

  

mailto:activation@iriscorporate.com
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2.6 Configuring your Anti-Virus Software 

The anti-virus installed on your PC scrutinizes all the files that are being written on your hard disk. This may 
dramatically slow down the writing speed of the images being scanned with IRISPowerscan™ or simply prevent 
IRISPowerscan™ from running. Your target production level may thus not be reached. 

In order to avoid such problem, you must properly configure your anti-virus and exclude from the process the list of 
folders into which your images are being placed. This configuration depends on the anti-virus used. Please refer to your 
anti-virus manual to define the required settings. 

  

In IRISPowerscan™, the folders to be excluded are: 

• %appdata%\IPSx 

• %programdata%\IPSx 

• C:\Program Files (x86)\IRISPowerscan 10 

Note: Some anti-virus do not support %FolderName% syntax. In those cases, enter the full path, i.e. 
C:\Users\YourName\AppData\Roaming\IPSx 

And the executable to be excluded are: 

• C:\Program Files (x86)\IRISPowerscan 10\IPSxConsole.exe 

• C:\Program Files (x86)\IRISPowerscan 10\IPSxService.exe 

• C:\Program Files (x86)\IRISPowerscan 10\IRISPowerscan.exe 

  

If you are using the Watched Folder feature, you must add all the watched folders in the exclusion list.  
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2.7 Uninstalling IRISPowerscan™ 

• Close IRISPowerscan™. 

• Go to Control Panel > Programs and Features. 

• Select IRISPowerscan™ from the list and click Uninstall. 
Then follow the on-screen instructions. 
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2.8 Product Support 

To get product support, please visit our website at www.irislink.com/support or at 
https://supportcenter.iriscorporate.com 

http://www.irislink.com/support
https://supportcenter.iriscorporate.com/
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3. Getting Started 

3.1 Starting IRISPowerscan™ 

• Double-click the IRISPowerscan™ shortcut on the Desktop. 

 

Tip: you can also start IRISPowerscan™ using the IRISPowerscan™ Agent in the System Tray. This tool also alerts 
you when batches are awaiting user action. 

 

• When you start IRISPowerscan™ for the first time, you are prompted to open one of the Demo projects. 

 

  

WARNING: it is recommended to explore the Demo projects to familiarize yourself with IRISPowerscan™ 10. 
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3.2 Exploring the Demo Projects 

The easiest way to familiarize yourself with IRISPowerscan 10 is to explore the Demo projects. Demo projects are 
preconfigured projects that scan images from a sample folder and show different document classification methods in 
IRISPowerscan™. 

In each demo project there are several example index fields that are extracted automatically from the sample images. 

  

WARNING: the Demo projects are just examples of what IRISPowerscan™ can do. They are not intended to be used 
as starting point to configure projects. To configure your own projects, use the Project templates instead. 

3.2.1 Accessing the Demo Projects 

• On the main toolbar, click File. 

 

• Click Open. The Demo projects are displayed. 

Tip: hover the mouse cursor over each project to get a short description of each project. 

 

• Select the demo project of your choice, and click the Open icon. 

3.2.2 Exploring a Demo Project 

• Open a Project of your choice. 

Note: we discuss the Barcode Recognition project here as example. 

• The project opens in Navigation mode. 
Navigation mode is the main working area of a project. It is used to scan and process documents. 

 

• Click Scan to scan some sample documents. 
The sample documents are scanned from the folder System.InputDirectory. 

• The documents are separated into Batches, Documents and Pages, based on the separation mode of the 
project in question. 
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• Notice that a few example index fields are filled in on batch and document level. 
In Navigation mode you can validate the index fields, edit them, create new ones, and link them to recognition 
zones. 

• When you are done scanning - and you have carried out all necessary operations - click Process to export the 
processed documents. 

 

• When IRISPowerscan™ is done exporting the documents, a scan summary is displayed. 
Note that documents are by default sent to your Documents folder as text-searchable PDF files. 

Note: an icon in the Navigation Explorer indicates which elements have been processed. 

 

Configuration in Navigation mode 

In Navigation mode you also modify the project settings: 

• You can rearrange the scanned documents, scan additional documents, modify the scan settings etc. 

• You can also use the Wizard on the Edit tab to add operations that must be carried out on all scanned images. 
Examples of operations are image processing and data extraction. 
Further configuration must be done in Designer mode. 
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• To see the effects of any configuration changes you make, click the down arrow beneath Scan, and then click 
Rescan. The changes are then applied to the documents you have already scanned, and to any subsequent 
documents you scan. 
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4. Creating Projects 

When you have explored the Demo projects and familiarized yourself with IRISPowerscan™, you can start configuring 
projects. Projects are the core of IRISPowerscan™ and determine how documents are classified and processed. 

There are two templates to create projects: 

• Wizard 

• Autodetection 

Note: when an Invoice Add-on has been activated, multiple Invoice templates are available as well. See the 
separate Invoice Add-on for IRISPowerscan™ documentation for more information. 

 

Once a project has been created, it can be fine-tuned in Navigation or Designer mode. A Wizard is again available to 
help you determine the settings. Any settings you apply in Navigation mode are also stored in Designer mode of 
IRISPowerscan™. There, you can do a full configuration of the project. 

Note: when you create a project and you choose to configure a DMS as destination for instance, index fields are 
automatically created. By default there is always one standard index field on Batch level and one on Document 
level. See Creating index fields to learn how to create and use index fields in IRISPowerscan™. 

Exporting / Importing Projects 

Once you have created a project, its configuration can be exported. That way you can import it into other 
IRISPowerscan™ workstations or into the IRISPowerscan Server™. 

• Click File > Open. 

• Select the project you want to export. 
Or Ctrl-click multiple projects to export multiple projects at once. 

• Then click the up arrow to export the project(s) as .zip file. 

Note: if you selected multiple projects, the .zip file will take the name of the project you selected first. 

  

 

  

• To import a project into another IRISPowerscan™ workstation, repeat the same procedure but click the down 
arrow to do the import. 
Or Ctr-click multiple projects to import multiple projects at once. 

Note: if you are importing a .zip file that contains multiple projects, all projects inside the .zip file will be added 
separately to the projects list. If one or more projects of the same name already exist the newly imported projects 
will be renamed. 
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Importing projects from an earlier version of IRISPowerscan™ 

Projects are backward compatible since IRISPowerscan 10.2.2. However, the new page architecture since 
IRISPowerscan 10.4 may require small changes in your projects. When you are using separation based on Page count, 
you need to double the page count because from version 10.3 on one page corresponds one side of a sheet, instead of 
to two sides like in the previous versions. Therefore it is recommended to review your project settings and validate 
their behavior when using projects created in an earlier version of IRISPowerscan. 

Note: The capture, validation and Export activities are not imported if it was set to Service or if the group is 
unknown by the target system (See Configuration pane).  

 

Exporting Log Files and Image Cache 

Besides exporting just the projects, you can now also export their corresponding log files and image cache. 

• Select the project you want to export. 
Or Ctrl-click multiple projects to export multiple projects at once. 

• Right-click and select Export... 

• Select the data you want to export: Image cache, Extended logs or both. 

• An Export window now opens. 
Name your project and click Save to save it as .zip file. 

• A second Export windows now opens to save the log file. 

Note: if you selected Extended log, it may take some time for all the data to be gathered. If you did not select 
Extended logs, a basic log file will be saved. 
Name the log file and click Save. 

 

Cloning Projects 

To clone one or more existing projects: 

• Right-click the project, and select Copy. 

• Or Ctrl-click multiple projects and then right-click and select Copy. 

• Right-click again inside the project list and click Paste. 
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4.1 Wizard template 

The Wizard template allows you to configure a project step by step. In the Wizard you determine the project 
properties, such as the name and input source, the image processing operations to apply, the batch and document 
separation criteria and the output formats and destinations. 

Notes: 
It is not required to go through all the steps of the Wizard; you may click Finish after each step. 
IRISPowerscan™ then applies default settings to the steps you have not configured. 
The number of steps in the Wizard depends on the source you select. When you select Folders or a Cloud 
source, additional configuration steps appear in the Wizard. 

Starting the Wizard 

• Click File > Create. 

• Double-click Wizard. 

 

Step 1 

• Enter a project Name and Description that are meaningful to you. 

• Select a Source: you can choose between Scanner, Folders, XMailFetcher, Box, Dropbox, OneDrive and 
SharePoint. 

• Select a Culture: this option is crucial to obtain good recognition results; it defines the default language for 
OCR zones, makes sure the correct units for currency, figures, measurement, etc. are used in the indexing 
fields. 

Step 2 

When Scanner is selected as input source, you are prompted to specify the Scanner settings: 

• Click the Settings icon to select the scanner driver. 

• Then select your scanner model from the Model list. 

• Select how you wish to split or merge the documents coming from the scanner in the Arrangement drop-down 
list: 

• Disabled: the pages will not be split. 

• Split long edge: splits pages along the long edge of the page. 

• Split vertically: splits pages vertically. 

• Split horizontally: splits pages horizontally. 

• Fold and Split horizontally (IPS9): folds and splits A3 pages horizontally into two A4 pages. 

• Merge long edge: merges two subsequent pages along the long edge of the pages. 

• Merge vertically: merges two subsequent pages vertically. 

• Merge horizontally: merges two subsequent pages horizontally. 

When Folders is selected, you are prompted to specify the Folders settings: 

• Click the browse icon to browse for the input folder. Or click the pencil icon to change the default input folder 
value: System.InputDirectory. 
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• If the folder you want to scan from is protected by a password, click the padlock icon ( ). 

• Enter your (domain ) User name. E.g. IRIS_DOM\MyName. 

• Enter your Password. 

• Confirm the password, and click OK. 

• Determine the File format options: IRISPowerscan™ by default searches for all files that end with the 
extensions *.jpg,*.jpeg,*.tif,*.tiff, *.png, *.bmp and *.pdf. In case you only want to process input .pdf 
documents for instance, delete the other extensions from this field. 

• Select the Sorting you want to apply: Unsorted, by name, by creation date or by modification date. 

• Select how you wish to split or merge the images in the Arrangement drop-down list. The same options are 
available as when using a Scanner as source (see above). 

• Set the other options: 

• Duplex: IRISPowerscan™ processes the uneven pages as front pages and the even pages as rear 
pages. Select this option when scanning in Duplex mode. 

• Recursive: IRISPowerscan™ also processes the files in the subfolders of the selected input folder. 

• Browse folders before scanning (not applicable when using a folder as Watched Folder): you are 
prompted to indicate the input folder each time you click Scan. 

• Browse files before scanning (not applicable when using a folder as Watched Folder): you are 
prompted to select one or more files each time you click Scan. 

• Ignore hidden files: when selected, hidden files will not be scanned. 

• Delete files after scanning: when selected, the files will be deleted after scanning. 

• Resolution: When importing PDF files you can select the Resolution in which they will be imported. You can 
select a resolution ranging from 100 DPI to 600 DPI. Note that a resolution of 300 DPI is generally 
recommended. This option does not apply to image files nor does it change the resolution of your scanner. 

• Timer: Indicate after how many seconds IRISPowerscan™ must process the images in the folder. 

Note: this option only applies when using a folder as a Watched Folder. 

• Signal: the Signal option is used when using Connected Projects. See the corresponding topic for more 
information. 

• Backup: If you want to make a backup of your files, click the browse icon and select the folder to store the files 
in. Or click the pencil icon to use an expression. 

For more information about the available options see Scanning from Folders. 

When a Cloud source is selected: enter the Username and Password of your Cloud account. 

Step 3 

Select the Image Processing Operations for IRISPowerscan™ to apply. To select multiple operations at the same time 
Ctrl-click them. 

Step 4 

Select a Batch Separation Criterion. This determines when IRISPowerscan™ starts a new batch. 

• None: IRISPowerscan™ scans everything to one single default batch. 

• Based on document count: indicate after how many documents IRISPowerscan™ must start a new batch. 

• Based on blank pages: IRISPowerscan™ starts a batch when it detects a blank page. 

• Based on barcode: IRISPowerscan™ starts a new batch when it detects a barcode on a scan. 

• Based on patchcode: IRISPowerscan™ starts a new batch when it detects a patch code on a scan. 

• Select Delete separator to have IRISPowerscan™ delete the pages containing the blank page / barcode / patch 
code. 

Obviously, the batch separation criteria can be refined. 
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Step 5 

Select a Document Separation Criterion. This determines when IRISPowerscan™ starts a new document. 

The same separation criteria are available as for batch separation. 

The document separation criteria too can be refined. 

Step 6 

Select an output Format and Destination. IRISPowerscan™ is able to generate a large number of editable, text-
searchable and compressed output documents to various target systems. 

Step 7 

When you select a Folder as Destination you are prompted to indicate the required Path. The default path is 
System.OutputDirectory + "\" + System.ProjectName + "\" + Batch.Name. This means IRISPowerscan™ creates a folder 
structure within the user's Documents folder. 

The default structure is: Documents > Project_n > Batch_n. 

To select other variables, click the drop-down list. You can also customize the variables by using the Expression Editor. 
Click the pencil icon to open the Expression Editor. 

 

In case you don't want to use variables and use a fixed path instead, click the browse icon and select a folder. Or type in 
the path manually. 

If the folder you want to scan to is protected by a password, click the padlock icon ( ). 

• Enter your (domain ) User name. E.g. IRIS_DOM\MyName 

• Enter your Password. 

• Confirm the password, and click OK. 

If the folder is part of a Connected Project use the Signal option. See the corresponding topic for more information. 

Step 8 

At the final step of the Wizard an overview appears of the settings you applied. 

When you are done configuring the project, click Finish to open the project in Navigation mode. It is ready for use, but 
can also be fine-tuned both in Navigation and Designer mode. 
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4.2 Autodetection template 

The Autodetection template is similar to the Wizard template. The difference is that the Autodetection template 
suggests batch and document separation criteria based on elements it finds on the scans. It detects for instance when a 
blank page, barcode or patch code is encountered and it prompts you whether to use them as separation criterion. 

WARNING: Autodetection occurs only once, so make sure you select the right options. If you want to 
modify the Autodetection settings afterwards you need to do it in Designer mode, or start over using the 
Autodetection template. 

Starting the Autodetection 

• Click File > Create. 

• Double-click Autodetection. 

 

• Go through the steps like in the regular Wizard. 

• When you are done, click Finish to start the Autodetection. 

Note: if you selected Scanner as source, the scanner now tries to initiate. Make sure the scanner is 
connected and powered on, and the scanner driver has been installed. 

• If color or grayscale images are detected, you are asked whether to apply binarization , i.e. to convert them 
into black-and-white images on which the processing will be done. 

• If blank pages, barcodes or patch codes are detected, you can choose to use them to separate documents or 
batches. 
The settings you select here are applied to any additional batches you scan. 

 

To apply the same settings to the first batch you had already scanned, click Rescan in Navigation mode. 

 

Note: if different barcode types are detected, you are prompted for each barcode type whether to use it as 
separator. 

• You can now process your documents in Navigation mode. And if necessary continue configuring the project 
both in Navigation and in Designer mode. 



IRISPowerscan 10.5 – User Guide 

35 

5. The IRISPowerscan™ Interface 

The IRISPowerscan™ interface consists of two main modes and an Application menu. Click the links below for an 
overview. 

1. Application menu 

The Application menu allows you to quickly access common tasks related to managing and sharing projects, configuring 
local users and groups, activating additional features, etc. 

2. Navigation mode 

Navigation mode really is the main working area of IRISPowerscan™. Navigation mode contains all commands and 
controls to process documents; in Navigation mode you scan documents, rearrange them, validate their index fields, 
generate output files and send them to the destinations of your choice. When a project is created or opened, it is by 
default displayed in Navigation mode. 

3. Designer mode 

Designer mode allows you to design projects on an advanced level. Any configuration you do in Navigation mode is also 
stored in Designer mode where you can configure it more elaborately. 
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Changing the Interface Language 

The Interface Language is defined on user level and can be customized for each user. 

To change the Interface Language: 

• Open a Project. 

• Click File > Info > Users. 

• Double-click the user who requires a different interface language. 

• Select the required language from the Language list and click OK. 

• Next time the user logs in, the interface is displayed in the selected language. 

 

 

WARNING: the settings you change here are only valid for local users, using one and the same computer. If you are 
an IRISPowerscan™ Administrator and want to change the interface language for different users who log in from 
different computers to the IRISPowerscan Server™, you must change the interface settings for each user in the 
IRISPowerscan Server™ interface. 

To access the IRISPowerscan Server™ documentation, open the IRISPowerscan Server™ application and click File > 
Help. 
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5.1 Application menu 

The Application menu allows you to quickly access common tasks related to managing and sharing projects, configuring 
local users and groups, activating additional features, etc. 

To access the Application menu click the File tab from either Navigation or Designer mode. 

Overview of the Application Menu Options 

Info 

The Info tab provides general information about the IRISPowerscan™ installed on your system. It consists of four 
sections: 

Generalities 

Displays the program version, the logged user, the actions the user has accomplished, etc. 

IRISPowerscan Server™ 

Here you can also connect to the IRISPowerscan Server™ (if the Central Management add-on is activated). 

To access the IRISPowerscan Server™ documentation, open the IRISPowerscan Server™ application and click File > 
Help. 

Reporting 

As of IRISPowerscan™ 10.5 there are advanced Reporting options to configure. 

Select Enable tray icon notifications if you want IRISPowerscan™ to display notifications in the Windows System tray. 

By default IRISPowerscan™ saves Error messages only to the Application log files and to the Service log files. You can 
also choose to save Error and warning messages or save All messages. 

When full reporting is required select All messages in the Application logging and the Service logging drop-down lists. 

Note: when you select All messages in the Service logging drop-down list, the application must be restarted. 

 

To export diagnostic data, click the Export diagnostic data button and select which data you wish to export: 

• Project: exports the project settings. 

• Image cache: exports the images that are visible in the Viewer. 

• Extended logs: exports Windows Event Logs. 
Logs are stored in C:\ProgramData\IPSx\LocalProjects\Logs. 

Note: if no project is open when you click Export diagnostic data, only the Extended logs option is 
available. 
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• When you are done, click OK. 

• An Export window now opens. 
Name your project and click Save to save it as .zip file. 

• A second Export windows now opens to save the log file. 

Note: if you selected Extended logs, it may take some time for all the data to be gathered. If you did not 
select Extended logs, a basic log file will be saved. 
Name the log file and click Save. 

 

WARNING: If watched folders are active, a concurrent access error may occur when saving logs:  stop the 
IPS service (via Windows Services or via the traffic light), export the logs and then restart the service. 

 

Send email on error: select this option if you want the user to receive a warning email when a project is on error in a 
fully automatic configuration, i.e. when the scanning, validation and export are done by the Service or Server. 

Batch on error: select this option if you also want the same user to receive a warning email when a batch is on error. 

Enter the recipient in the To field. 

Enter a recipient in Blind Copy in the CC field. 

Enter the Host name and Port number. 

Set the Timeout time after which IRISPowerscan™ stops trying to send the email. The default time is 60 seconds. 

If necessary select Use SSL to use a Secure Socket Layer. 

Enter your User name and Password. 
When you are done, click Send test to send a test email. 

Note: when using IRISPowerscan Server™ the same Reporting settings must be configured inside the 
IRISPowerscan Server™ application. 

  

Features 

Displays the features that are activated in the current version. 

• Click Activate to activate more features. 

• Click Copy to Clipboard to copy all license info to the Clipboard. Now you can easily paste it in a mail to contact 
Product Support for instance. 

Users  

Allows you to manage users in IRISPowerscan™. Click the plus sign to add users, or the pencil icon to edit existing users. 

WARNING: the users you add here are local users, and can only log in on the current machine. To configure 
user profiles that can be used among multiple workstations, use the IRISPowerscan Server™. 

• Groups: allows you to manage user groups in IRISPowerscan™. Click the plus sign to add user groups, or the 
pencil icon to edit existing groups. 
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WARNING: the groups you add here are local groups, and are only valid for the current machine. To 
configure groups that can be used among multiple workstations, use the IRISPowerscan Server™. 

• Achievements: displays a list of actions you are encouraged to do. 

• Updates: allows you to check for software updates. 

Login 

Here you can log in to IRISPowerscan™ using your personal credentials. When you use IRISPowerscan™ without logging 
in you are by default a 'guest' user. 

When specific user rights have been attributed to the credentials, you will only be allowed to execute corresponding 
actions after logging in. See Managing Users and Groups. 

Create 

On the Create tab you can create new projects using one of the templates. 

Also see Getting Started > Creating Projects. 

Open 

On the Open tab you can open demo projects and the projects you created. The projects can be displayed as icons or as 
detailed list. Click the list icon to switch to list view. 

Projects can be exported as .zip files and then can be imported in other IRISPowerscan™ stations. 

Projects can also be cloned by right-clicking and copy-pasting them. 

 

Save 

Saves all project settings, closes the Application menu and returns you to the project. 

Save as 

Saves a copy of the current project with a new name. 

Manage 

Allows you to manage the batches in process. See Processing in IRISPowerscan 10. 

Note: as of IRISPowerscan 10.4, when you delete an Invoice batch from this section it will also be removed 
from the WebVerify Job list. 

Print preview 

Displays a preview of how the selected Batch or Document will be printed. In order for the Print preview command to 
work you need to select a Document or Batch in the Navigation Explorer. 

Note: the Print preview command is only available if Navigation mode is active, not when Designer mode is 
active. 
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Print 

Allows you to print Documents and Batches. In order for the Print command to work you need to select a Document or 
Batch in the Navigation Explorer. It is not possible to print individual pages. 

Notes:  
The Print command is only available if Navigation mode is active, not when Designer mode is active.  

The Print feature does not work as a service. 

Help 

Opens the documentation. 
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5.2. Navigation mode 

Below you find an overview of Navigation mode and its commands. 

Tips:  
Many shortcuts can be used. To view the key tips on the ribbon simply press Alt.  
Any changes you make can be undone / redone using the undo / redo buttons on the Quick Access toolbar. 

Overview of the Navigation mode 

Navigation mode consists of the following elements: 

5.2.1 Quick Access toolbar 

5.2.2 Main toolbar 

5.2.3 Navigation bar 

5.2.4 Navigation Explorer 

5.2.5 Viewer 

5.2.6 Fields pane 

5.2.7 Service activity 

 

Ctrl+W shortcut 

You can toggle the focus from the Navigation Explorer (1) to the Viewer (2), from the Viewer (2) to the Fields pane (3) 
and then back to the Navigation Explorer (1) using the keyboard shortcut Ctrl+W.  
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5.2.1 Quick Access toolbar 

On the Quick Access toolbar you can do the following actions: 

• Scan documents 

• Process documents 

• Undo actions 

• Redo actions 

Note: other commands can be added to this toolbar. Right-click the required command and select Add to 
Quick Access Toolbar. 
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5.2.2 Main toolbar 

The main toolbar contains all required commands to scan and process documents. It also allows you to configure 
projects. 

 

The main toolbar consists of the following tabs: 

• File 

• Edit 

• View 
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5.2.2.1 File tab 

The File tab opens the Application menu. The Application menu allows you to quickly access common tasks related to 
managing and sharing projects, configuring local users and groups, activating additional features, etc. 

The Application menu is both accessible from Navigation and Designer mode. 
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5.2.2.2 Edit tab 

The Edit tab is the most important tab in Navigation mode. Its commands allow you to scan and rearrange documents, 
modify scan settings, create new batches and documents, add operations using the Wizard, and export processed 
documents. 

The Edit tab consists of the following groups: 

• Clipboard 

• Edit 

• Arrange 

• Wizard 

  

Note: the commands of the Edit tab can also be used by means of keyboard shortcuts. Click here for an overview. 

Clipboard 

Cut/Copy/Paste 
The Clipboard contains the standard Cut, Copy and Paste commands. You can cut 
pages, documents and batches from the Navigation Explorer or Viewer to the Clipboard 
and paste them to another location. 

Select All Selects all the pages, documents or batches currently displayed in the viewer. 

 

Allows you to go directly to the first/last page and the previous/next page. 

Edit 

The commands of the Edit group allow you to scan, edit and delete documents. 

 

Click Scan to scan documents from a configured input source. The input source may be a 
scanner, a folder or a Cloud repository. 

All documents you scan are by default added behind the last document. 

In case you want to insert documents before or after a certain position, select the 
position in the Navigation Explorer, click the down arrow beneath Scan and select 
Insert before or Insert after. Then click Scan. 

To apply any configuration changes you made to the documents that were already 
scanned, click the down arrow beneath Scan and then click Rescan. This way, you 
don't actually have to rescan them physically in order to apply changes. 

Note: only Document names and fields are re-evaluated when using Rescan. 
Batch names and fields are not. 

To select the input source, click the down arrow beneath Scan and select the 
required source. Then click Settings to configure the selected input source. 

 

This command is only available when the Input Source has been configured as Watched 
Folder , and in Invoice projects. 

It allows you to open batches that were scanned automatically, or that have been verified in 
Web Verify respectively. 
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This command either creates a new Batch or a new Document. 

Indicate the position in the Navigation Explorer where to add a new batch or document. 
Then click the down arrow beneath Create and select Batch or Document. 

Note that the structure batch > document > page is always maintained. This means 
documents or batches cannot be added between two pages. Nor can batches be added 
between two documents. 

 

To delete pages, documents and batches: 

• Select the element to delete, and then click Delete. 

• Or right-click an element and click Delete in the Context menu. 

• Or select an element and press the Delete key. 

Note that pages are not deleted immediately. Instead they are flagged 'for deletion' by a red 
cross. This way you can easily undo the deletion in case of a mistake. Pages that are flagged 
for deletion will not be processed. 

To undelete a page, first select a page that has been flagged for deletion. Then click the 
down arrow beneath Delete and click Undelete. 

 

The Reorder tool should only be used to reorder images that were scanned in Debookletting 
mode. See Operations > Reorder for more information. 

 

Click Process to have IRISPowerscan™ process your documents and send them to the 
configured destination. 

 

This command is only available in Invoice projects. It opens the WebVerify module in your 
default Internet browser. 
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Arrange 

 

To mark a page as attached: 

• Select a page and click the Attach button. 

• Or right-click a page and select Attach in the Context menu. 

• Or select a page and press the Insert key. 

The variable Page.IsAttached can be used as condition for classification, indexing, export, 
etc. 

  

To detach a page: 

• Select a page, and then click the drop-down button and click Detach to detach it. 

• Or right-click a page and select Detach in the Context menu. 

• Or select a page and press Ctrl+Insert. 

The variable Page.IsAttached will be removed. 

 

Click Split to split documents or batches. 

Important: to split a document, select one of its pages and click Split. To split a batch, select 
one of its documents and click Split. 

 

Click Merge to merge two documents or batches. 

Click the down arrow beneath Merge and indicate whether to merge with the previous 
batch/document or the next. 
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Reorder 

The Reorder tool allows you to reorder the scanned documents. 

Note however that the first two commands - Cover first and Cover last - should only be used 
to reorder images that were scanned in Debookletting mode. See Operations > Reorder for 
more information. 

Reverse order 

To reverse the order of all scanned pages: 

• Click Reverse order. 

Note that this only works on Document level. Only the order of pages inside a single 
document will be reversed. 

Swap sides 

The Swap sides command allows you to swap pages and flip their sides. 

To swap pages from position, you need to select a pair number of pages. 

Example: 

When you select pages 1 to 4, page 1 and page 2 are swapped from position and page 3 and 
4 are swapped from position. Their sides are also swapped, meaning Front becomes rear 
and vice versa. 

Note: if you select 5 pages, the fifth page will not change position, but its side will 
simply be flipped. 

Tip: hover the cursor over a page to check whether it is a Front or Rear side. 

 

Note: you can select multiple pages across different documents and batches. Note 
however that the pages and sides stay within their original document and batch. They 
are not moved from one document or batch to another.  
In case you only want to flip the side of a page, then select a single page and click Swap 
sides. Yo will notice that a Front becomes a Rear and vice versa. This needs to be done 
page per page. 

Tip: to undo any unwanted changes use Ctrl-Z. 
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Wizard 

 

Click Wizard to start the configuration wizard. 

Through the Wizard you can add operations, page types, document types and batch types, 
output types and data sources. 

 

5.2.2.3 View tab 

The View tab allows you to choose which images should be displayed, adjust the zoom of the displayed pages, rotate 
them, create data extraction zones, display or hide rulers and other layout tools. 

It consists of the following groups: 

• Color 

• Zoom 

• Tools 

• Zones 

• Show/Hide 

  

Note: the commands of the View tab can also be used by means of keyboard shortcuts. Click here for an overview. 

Color 

 

The Show tool displays the available streams of the scanned image. You can choose to 
display the image in: 

• Color 

• Grayscale 

• Black and white. 

 

The Check tool allows you to specify which stream of the selected image must be displayed 
and exported. 

To use it: click the down arrow beneath the Show tool and select which stream must be 
displayed. Then select one or more pages of which you want a different stream to be 
displayed and exported. Click the down arrow beneath Check and select the stream that 
must be used for the selected image(s). A checkmark icon is now added to the image 
thumbnail. 

Note: you can also right-click on an image, point to Check and select the required 
stream for the selected image. 
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In Designer Explorer, open the Output type you will be using. Enter Image.IsBest in the 
Condition field. The condition will be evaluated as true if the corresponding image/stream is 
checked and if the corresponding image/stream has the highest bits per pixel for that 
particular page. 

Tip: to export only the checked images use the condition Image.IsChecked. Or to export 
only the visible images, use Image.IsVisible. 

See the topic How to apply Image Filtering in the How To Guide for more information. 

Zoom 

(Only available at page level) 

 

Click the down arrow beneath Fit and select whether to: 

• fit the entire page in the Viewer 

• fit the page to the width of the Viewer 

• fit the page to the height of the Viewer 

 

Click Actual size to display the selected page in its actual size. 

 

Click Zoom in to zoom in on pages. 

 

Click Zoom out to zoom out from pages. 

Tools 

(Only available at page level) 

 

Click to rotate pages to the left. 

 

Click to rotate pages to the right. 
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Click to auto-rotate pages. 

Zones 

 

The Capture tool allows you to create data extraction zones. 

To use it: select a page. In the Viewer draw a frame around the zone you to capture. Then 
click Capture. 

To automatically detect extraction zones, click the down arrow beneath Capture, 
and click Analyze. 

 

The Crop tool allows you to crop a page to a certain size. 

To use it: select a page. In the Viewer draw a frame around the zone to which the page must 
be cropped. Then click Crop. 

 

The Fill tool allows you to cover up parts of a scanned image, to hide confidential 
information for instance. 

To use it: select a page. In the Viewer draw a frame around the zone you want to cover up. 
Then click Fill. Multiple colors are available. Click the down arrow beneath Fill to select one. 

  

Show / Hide 

Ruler 
Displays a ruler on page level. 

(Only available at page level) 

Thumbnail 

Displays a thumbnail of the scanned page in the top left corner of the Viewer, allowing easy 
navigation. 

(Only available at page level) 

Speedometer Displays a scanning speed indicator when scanning documents. 

Details 

Displays details about the scanned image, such as the scan date, at the bottom of the 
screen. 

 

Status Displays the status of the scanned image at the bottom of the screen. 

Advanced 
highlight  

By default, this option is disabled. 

When you click on a page, all the zones for which IPS has extracted data (or tried to) are 
highlighted. 
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When you click on a field, all the searched zones for that field are highlighted whether there 
is a result or not. (A field value can contain multiple data extraction zones). 

A color code is defined: 

• green: result found and valid 

• orange: no result found (empty) and valid 

• red: invalid result 

 

If you prefer dotted line rectangles instead of highlighting, then you can add the parameter 
DottedLineHightlights and set the value to 'Yes'. For more information on Parameters, go to 
5.3.5.10_Parameters  

Auto zoom 

By default, this option is disabled. 

When a field/index is selected in the Fields pane, the Viewer shows you the highlighted zone 
corresponding to that field. If enabled, the Auto zoom makes a zoom on that zone to have it 
centered and visible. If you want to keep the previous zoom factor, this option should 
remain disabled.  
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5.2.3 Navigation bar 

The Navigation bar allows easy navigation between the batches, documents and pages. 

 

In the Search section of the Navigation bar you do text searches inside the current project. 

Note that IRISPowerscan™ searches for matching results within the batches and documents in the Navigation Explorer 
and within the index fields. It does not search the text inside the scanned images. 

To do a search: 

• Click inside the Search field. 

• Type in the word you want to search and press Enter. 

• The number of matches is displayed in the Search section. 

• Click the list icon to display all search results. 
Or use the arrows to toggle between the results. 

 

• Click the red cross to end the search and start a new one. 
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5.2.4 Navigation Explorer 

The Navigation Explorer displays the hierarchical structure of the scans: batches, documents and pages. 

WARNING: in IRISPowerscan 10.4, a page corresponds to one side of a scanned paper sheet. A page does 
no longer contain both the front and the rear side. It is now either a front side or a rear side. This makes it 
much easier to delete front sides and rear sides separately. 

In the Navigation Explorer you can navigate across the different elements, rearrange them with Cut and Paste, Drag and 
Drop, and Split and Merge operations. 

Tips:  
Right-click inside the Navigation Explorer to display its Context menu.  
Right-click and select Expand all to display each element, or select Collapse all to get an overview of all 
batches. 

For more information on this see Checking and Rearranging Scanned Documents. 

The Navigation Explorer can be resized horizontally and is now also dockable. 

To resize the pane: 

• Drag the divider to a different position. 

To detach the pane: 

• Click the Windows icon in the top right corner. 

 

• Click Detach. 
The Navigation Explorer pane can now be moved to a different location. 

• To restore its original position, click the X icon. 

To hide the pane: 

• Click the Windows icon and then click Hide. 

• To make it reappear again click the Windows icon and click Show. 

Note: elements in the Navigation Explorer that contain invalid index fields are indicated by a warning sign. 

  

Note that the Navigation / Designer buttons at the bottom of the screen allow you to toggle between Navigation and 
Designer mode. 
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5.2.5 Viewer 

The Viewer in Navigation mode displays the scanned batches, documents and pages. 

When you select a batch, the underlying documents and pages are displayed as thumbnails. 

 

When you select a page in the Navigation Explorer, the entire page is displayed as shown in the image below. Now you 
can edit the image using the commands of the View tab. 

 

Also see Checking and Rearranging Scanned Documents. 
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5.2.6 Fields pane 

The Fields pane displays the index fields that have been created on batch, document and page level. 

As of IRISPowerscan 10.4 the index fields on Batch, Document and Page level are displayed simultaneously. 

The index fields have specific colors: 

• Correct index fields are white. 

• Manually edited index fields are yellow. 

• Erroneous index fields are red. 

The Search function allows you to search for text throughout the index fields. 

Dockable pane 

This Fields pane is dockable: 

• Click the Windows icon in the top right corner. 

 

• Click Detach. 
The Fields pane can now be moved to a different location. 

• To restore its original position, click the X icon. 

To hide the Fields pane, click the Windows icon and then click Hide. To make it reappear again click the Windows icon 
and click Show. 
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5.2.7 Service activity 

A progress animation appears on the bottom ribbon when the service is working on a capture, an export, an upload or a 
download to/from the server. When the progress animation is active, we highly recommend you to keep your 
computer switched on.  
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5.3. Designer mode 

Below you find an overview of Designer mode and its commands. 

Tips:  
Many shortcuts can be used. Click here for an overview. To view the key tips on the ribbon simply press Alt.  
Any changes you make can be undone / redone using the undo / redo buttons on the Quick Access toolbar. 

Overview of the Designer mode 

Designer mode consists of the following elements: 

5.3.1 Quick Access toolbar 

5.3.2 Main toolbar 

5.3.3 Designer Explorer 

5.3.4 Viewer 

5.3.5 Configuration pane 
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5.3.1 Quick Access toolbar 

On the Quick Access toolbar you can do the following actions: 

• Scan documents 

• Undo actions 

• Redo actions 

Note: other commands can be added to this toolbar. Right-click the required command and select Add to 
Quick Access Toolbar. 
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5.3.2 Main toolbar 

The main toolbar contains the commands required to add and modify configuration elements. 

 

The main toolbar consists of the following tabs: 

• File 

• Edit 

• View 



IRISPowerscan 10.5 – User Guide 

61 

5.3.2.1 File tab 

The File tab opens the Application menu. The Application menu allows you to quickly access common tasks related to 
managing and sharing projects, configuring local users and groups, activating additional features, etc. 

The Application menu is both accessible from Navigation and Designer mode. 
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5.3.2.2 Edit tab 

The commands of the Edit tab allow you to create or delete configuration elements. Note that the actual configuration 
is done in the Designer Explorer and the Configuration pane. 

The Edit tab consists of the following groups: 

• Clipboard 

• Edit 

• Wizard 

Note: the commands of the Edit tab can also be used by means of keyboard shortcuts. Click here for an 
overview. 

Clipboard 

The Clipboard contains the standard Cut, Copy and Paste commands. 

Edit 

 

This command creates a new configuration element. E.g. a page, document or batch type, an 
operation, an output type, a script, a data source etc. 

Select the configuration element you want to create, and then click Create. The configuration 
element is added to the Designer Explorer and can be configured in the Configuration pane. 

 

Select any configuration element to delete. Then click Delete. 

Wizard 

 

Click Wizard to start the configuration wizard. 

By means of the Wizard you can add operations, processing operations, page types, document 
types and batch types, output types and data sources. 
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5.3.2.3 View tab 

The View tab allows you to adjust the view of Sample images. 

WARNING: the commands of the View tab in Designer mode are only available to change the view of 
Sample images. In order to use these commands, you must first add Sample Images at the required level: 
general, page level, document level, or batch level. Then click Operations at the required level. 

The View tab consists of the following groups: 

• Zoom 

• Tools 

• Show/Hide 

Note: the commands of the View tab can also be used by means of keyboard shortcuts. Click here for an 
overview. 

Zoom 

 

Click the down arrow beneath Fit and select whether to: 

• fit the entire Image sample in the Viewer 

• fit the Image sample to the width of the Viewer 

• fit the Image sample to the height of the Viewer 

These commands are only available when viewing a sample in single image view. 

 

Click to display the Image sample in its actual size. 

 

Click to zoom in on the Image sample. 

 

Click to zoom out from the Image sample. 

Tools 

 

Click to rotate the Image sample to the left. 
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Click to rotate the Image sample to the right. 

 

Click to auto-rotate the Image sample. 

Show / Hide 

Ruler Displays a ruler. 

Thumbnail 
Displays a miniature of the sample in the top left corner of the Viewer, allowing easy 
navigation. 
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5.3.3 Designer Explorer 

The Designer Explorer gives an hierarchic overview of all the configuration elements. Click each element to display its 
properties. Also click the triangle in front of the elements to expand them  and display their underlying elements (or 
right arrow on the keyboard). 

 

There are different ways to add configuration elements: 

• Right-click the element of your choice and click Add. Its properties are displayed in the Configuration pane. 

 

• Or select an element, and click Create on the Edit tab. 

• Or use the keyboard shortcuts. 

The different parts of the Designer Explorer and their options are explained in the section Configuration pane. 

Note that the Navigation / Designer buttons at the bottom of the screen allow you to toggle between Navigation and 
Designer mode. 
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5.3.4 Viewer 

The Viewer in Designer mode displays image samples you have added to the project. 

To display samples in the Viewer: 

• Add at least one sample image. 

This may be at general level, page, document or batch level. 

• Click Images at the correct level. 

 

Example: Image samples at general level 

  

• Double-click the sample of your choice to display it in the Viewer. 

 

• When the sample image is displayed you can add Image Processing Operations. 
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5.3.5 Configuration pane 

The Configuration pane displays the settings of the configuration element you select in the Designer Explorer. The 
settings vary depending on the selected element. 

 

  

See the topics below for an overview of each configuration element. 

Note that the operations you configure are executed top-down. 

5.3.5.1 Properties 

The Properties section displays the properties of the current project. It also displays the Sources from which documents 
are scanned to the project. The settings you apply here are applied to the entire project. 

Name: contains the name of the project. 

Culture: this option defines the default language for OCR zones and indexing fields. 

Description: enter a description of the project that is meaningful to you. E.g. a description of the main settings. 

Activities: select which user group is allowed to carry out the activities Capture, Validation and Export. 

By default, these 3 activities may be carried out by Supervisors. 

Note that these activities can also be automated on the current workstation (by selecting Service) or on the 
server (by selecting Server). To use the Server the Central Management add-on is required. See Processing 
Documents in IRISPowerscan 10 for more information. 

When the Capture activity is done by the Service/Server and you selected a Folder as source, the folder now 
functions as Watched Folder. 

When the Validation activity is done by the Service/Server, index fields do not need to be validated manually by 
a user. 

When the Export activity is done by the Service/Server, the documents are exported automatically to the 
configured destination as soon as the processing is done. 

Note: in order for the Export to be executed by the Service, the Background Processing add-on is required. 

Counters: IRISPowerscan™ by default starts counting from 1 at every batch and document. This number can be 
changed by clicking the arrows. 
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Sources 

Click the plus sign to add a source. To delete a source, select it and click the trash icon. 

Note: you can add multiple sources inside a single project and switch between those sources if necessary.  

WARNING: it is strongly advised to use only one scanner protocol per project (either Scanner or Scanner Isis). 
Having both selected within the same project can lead to errors. If you need to switch between those two 
protocols, then turn off and turn on again your scanner in between.   

  

 

Folders 

The corresponding options are explained in Scanning from Folders. 

Scanner 

Click Scanner to see all scanner models for which a driver is installed on your computer. 

Select a model from the list and click the settings icon to configure it. Also see Using a Scanner. 

Box, Dropbox, OneDrive, SharePoint 

See Scanning from the Cloud. 

  

5.3.5.2 Images 

In the Images section you can add samples of the documents you will be scanning. 

To add samples, click the plus sign at the right side of the screen, and browse for the images to add. 

Note: In case you want to add samples for a specific page, document or batch type: expand the required type in 
the Designer Explorer, and click Images on that level. 

Note that sample images added at Page level can be used to train the Fingerprint recognition. 

 

Tip: you can rename the samples images by clicking Rename. 
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5.3.5.3 Operations 

In the Operations section you can add operations. These operations generate variables that can be used in any 
expression / condition, typically to do page identification, document and batch separation, indexing, etc. 

To add an operation: 

• Right-click Operations and select Create. 

• Select the required operation from the list and click Finish. 

Note: the operations you add at general level are applied to all the pages you scan inside the project. Note 
however, that you can also add operations on page, document and batch level and even to specific types of pages, 
documents and batches. In the later case you can configure IRISPowerscan™ to carry out certain operations only 
when it encounters specific types, which speeds up the processing. 

Tip: you can scroll the samples images by clicking the arrow buttons <>, or by using the keyboard shortcut Alt + 
down/up arrow. 

5.3.5.4 Pages 

In the Pages section you can create different Page Types you will be scanning. 

This provides a number of advantages: 

• The identified page types can be used to separate documents. 

• Operations can be applied to specific page types, which avoids IRISPowerscan™ having to apply them to all 
scanned pages. 

See Identification of Pages for more information. 

  

5.3.5.5 Documents 

In the Documents section you can create different Document Types you will be scanning. 

To add a document type: 

• Select Documents in the Designer Explorer and click Create on the main toolbar. 

To learn how to configure a document type, see Separation of Documents and Batches. 

  

5.3.5.6 Batches 

In the Batches section you can create different Batches Types you will be scanning. Creating Batch Types works in the 
same way as creating Document Types. 

Also see Separation of Documents and Batches. 

  

5.3.5.7 Outputs 

In the Outputs section you can determine in which output format and to which destination the processed documents 
must be sent. 
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5.3.5.8 Scripts 

In the Scripts section of each project a default script is available that offers a number of functions. The functions of the 
script can be used in Conditions and Expressions. 

To access the default script: 

• Expand Scripts. 

• Click the default Script. 
The available functions are now displayed. 

• To edit the script, click the pencil icon. 

Tip: hover with the mouse over a script to display a short description of its functionality. 

  

5.3.5.9 Data Sources 

In the Data Sources section you can add lists of values. These values must be entered manually, or can be retrieved 
automatically from external ODBC data sources like Microsoft Access. These values can be linked to the index fields in 
IRISPowerscan™. This way you can choose from the Data Source content when filling in index fields in IRISPowerscan™. 

See Indexing Scanned Documents > Using a Data Source for more information. 

  

5.3.5.10 Parameters 

Visible parameters 

In the Parameters section you can specify the following advanced parameters: 

WARNING: every time you change a parameter, you need to Save the project and re-open it for the changes to be 
taken into account. 

Note: some parameters are only available when you have created an Invoice project. They are mentioned at the 
end of the parameter list below. 

  

ShowLogs: if set to 'Yes', displays detailed logs after each scan. 

ShowScanSummary: if set to 'Yes', displays a scan summary after each scan. 

The Scan summary displays the total number of pages scanned and the total number of images scanned. The 
first digit indicates the number of pages scanned during the last scan (7 in our example below), while the second 
digit indicates the number of pages scanned since the opening of the application (14 in our example). 

 

Example Scan Summary 

  

ShowExportSummary: if set to 'Yes', displays an export summary after each export. 

The Export summary displays the total number of pages processed and the total number of images processed. 
Again the first digit indicates the number of pages processed during the last processing (21 in our example 
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below), while the second digit indicates the number of pages processed since the opening of the application (28 
in our example).   

The Export summary also displays the number of pages saved, the number of files created and the Output 
folder. 

 

  

JpegQuality: modifies the quality of JPEG images coming from the scanner. The default value is set to -1. This is the 
value of the scanner. You can modify this value between 0 and 100. The higher the value, the higher the JPEG quality. 

AutoSelectInvalid: if set to 'Yes', the cursor is automatically placed inside the first invalid index field, so you can correct 
it immediately. 

AutoZoom: if set to 'Yes', IRISPowerscan™ zooms in to the page on the linked data extraction zone when you click 
inside the corresponding index field. 

AutoCapture: if set to 'Yes', the zone you have drawn in Navigation mode will be kept in the project for future scans. 

AutoProcess: if set to 'Yes', all batches in cache will be automatically processed and exported to the configured 
destination without needing to click the Process button. 

History: allows you to determine the history depth of index fields inside a project. You can determine how many values 
are supported and whether they will be stored on disk. 

The default value is 0. This means the number of values is unlimited but the values are never stored on disk. In 
other words the projects will be cleaned up automatically. 

If the parameter is greater than 0, the values are limited to the indicated integer and are stored on disk. 

If the parameter is less than 0, the values are also limited to the indicated integer but are never stored on disk. 

Note that you can define the history depth for each field individually. To do so, add a new parameter and add 
the index field for which you want to define the history. E.g. Document.Barcode.History. 

ResetVariables: if set to 'Yes', this parameter allows IRISPowerscan™ to reset all working variables after scanning. These 
variables may have an impact on the manual creation of Batches and Documents. 

ResetExportFlag: by default this parameter is set to 'No'. If set to 'Yes' this parameter makes sure that the 'IsExported' 
status and its variables are reset to false just before the export on Document and Batch level. 

Note: the IsExported status can also be updated manually in the Details panel. To do so, select a batch or 
document that has already been exported. In the Details panel below the Viewer, click Reset. 

  

 

  

StrictIndexValidation: if set to ‘Yes’ batches that contain an invalid index field cannot be processed. The default value is 
'No'. 

StrictIndexEvaluation: by default this parameter is set to 'Yes'. This means that when an unknown variable is 
encountered, the expression will not be evaluated.  If this parameter is set to 'No', then unknown variables are replaced 
by an empty string. For instance, if the variable Page. Index is unknown or not found in the expression 'Page (' 
+Page.Index +')' then the expression will be evaluated as 'Page()'. 
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AllowSplitMergeInViewer: by default this parameter is set to 'Yes', meaning you can insert a divider between pages in 
the Viewer to separate a single document into multiple documents. When set to 'No' you are not able to insert a 
divider, to avoid accidental separation. 

 

  

LineItems: if set to 'Yes', Line Items are displayed in the IRISPowerscan interface and WebVerify interface. This 
parameters can only be used when the Invoice Add-on has been installed and activated. 

ScanAfterValidation: this parameter is by default set to ‘Yes’. This means users are allowed to add scans to Batches 
which are already in Validation or Export status. 

ExportAll: if set to 'Yes' all the different streams of the image will be exported. The default value is 'No'. This means that 
only the last stream is used. 

Note: if the condition Image.IsBest is used only the best stream will be used if this parameter is set to 'Yes'. 

  

Parameters for Invoice projects 

The parameters below can only be used when you have created an Invoice project. Most of them must be created 
manually as Custom parameter, as explained below. 

SkipWebVerify: if set to 'Yes', you can skip the WebVerify step in the invoice processing workflow and validate the 
extraction results within IRISPowerscan™ itself. 

ExportXtractErrors: this parameter must be set to 'Yes' when using the SkipVerify parameter. Erroneous fields will be 
flagged in IRISPowerscan™. 

UseMasterData: this parameter is by default set to 'Yes' in Invoice projects. Set it to 'No' if you don't want 
IRISPowerscan™ to use Master Data. In this case you need to fill in all index fields manually. 

OrderNumberKeywordSearch: if set to 'Yes' the search order number is based on keyword and regular expressions. If 
set to 'No' - which is the default value - the search is based on the database (i.e. Master transactions table). 

AutoValidateInvoiceNumber: if set to 'Yes' the invoice number is not flagged to be approved by the user. It is validated 
automatically. The default value is 'No', which means the user must approve the invoice number. 

AutoValidateDocumentType: if set to 'Yes' the document type is not flagged to be approved by the user. It is validated 
automatically. The default value is 'No', which means the user must approve the document type. 

TaxAmount3: if set to 'Yes' 3 tax rates are used in the Invoice Add-on: Net Amount 3, VAT Rate 3 and VAT Amount 3 
are visible in Verify. Note that the FSController must be restarted. The default value of the parameter is 'No'. To set this 
parameter to 'Yes' you must first create it as explained below and then enter 'Yes' as value. 

DocumentType: this parameter is set to 'Yes' by default. This means the document type is activated and visible in 
Verify. To set this parameter to 'No' you must first create it and then enter 'No' as value. 

ValueOfGoods: this parameter is set to 'Yes' by default. This means the fields Value of goods, Discount, Incidental 
costs 1, 2 and 3 are activated and visible in Verify. To deactivate these fields in Verify, create the parameter and set its 
value to 'No'. 

Search1: if set to 'Yes' the field Search1 is activated and visible in Verify. To deactivate this field, create the parameter 
and set its value to 'No'. 

Search2: if set to 'Yes' the field Search2 is activated and visible in Verify. To deactivate this field, create the parameter 
and set its value to 'No'. 
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WebVerifyPort: this parameter is set to 8082 by default. If you need to define a different TCP port for WebVerify, 
simply enter another value. 

Adding Custom Parameters 

Custom parameters can also be used to translate the labels of index fields. 

Suppose you created the index field 'Invoice number' in English and you want its label to be translated in French when a 
user chooses French as interface language: 

• Click the plus sign in the top right corner. 

• In the Name field, enter the name of the label of the index field. For instance Labels.InvoiceNumber[EN]. 

• In the Value field, enter the value of the label. For instance Invoice number. 

• Repeat these steps for the French label: 

• Click the plus sign in the top right corner. 

• In the Name field, enter the name of the label of the index field. In our example Labels.InvoiceNumber[FR]. 

• In the Value field, enter the value of the label. In our example Numéro de facture. 

When the user changes the interface language to French, the label of the index field above will be displayed in French. 

  

Using Custom Parameters to create Custom Error Messages 

As of IRISPowerscan™ 10.5 custom parameters can be used to create custom error messages. 

• Switch to Designer mode and click Parameters. 

• Click the plus sign in the top right corner. 

• In the Name field, enter the name of the field for which you want to create a custom error message, preceded 
by the prefix 'Conditions.' and followed by the language code between brackets. 
For example: Conditions.Field1[EN]. 

Note: these parameters may be composed of different elements. For example 
Conditions.DOCUMENTTYPE.FIELDNAME[LL] or Conditions.PAGETYPE.FIELDNAME[LL] or 
Conditions.BATCHTYPE[LL]. 

Note: thanks to the language code, the error message can be translated in all supported languages. 
The following language codes are available: 

EN: English 

FR: French 

NL: Dutch 

ES: Spanish 

PT: Portuguese 

IT: Italian 

JA: Japanese 

HU: Hungarian 

CS: Czech 

• In the Value field, enter the value of the error message. 
For example, 'This is a custom error message'. 

• Go to the field that requires a custom error message, and apply a Condition. 
For example, !IsNullOrEmpty(Field). 
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• Scan a test document. 
If the condition is not met for the field, the custom error message will be displayed when you move the cursor 
over the field. 

 

Additional Parameters 

The parameters below can be added manually if you want to change their default value. 

CleanTemporaryScanFolder: this parameter is set to 'Yes' by default. When using a scanner as source, the images are 
temporary saved in %AppData%/ipsx/scan folder. After a scan run, all images are deleted. This parameter allows you to 
prevent the deletion if you set the value to 'No'.  

DisableEnhancedNaming: this parameter is set to 'No' by default. If your project is not behaving as before because of a 
backward compatibility issue, you may set it to 'Yes'. It disables additional naming and counter expressions evaluation 
at document creation, transferring counters values in separation module from core context to global context and other 
enhancement.  

DisableRefactorInDesign: this parameter is set to 'No' by default. If you set it to 'Yes', it disables the refactor method 
when working in the Designer. If the zones (fields, checkmarks or fingerprints) of your page types exceed the number of 
100, then it is recommended to set this parameter to YES. The refactor method will then be executed when leaving the 
Designer. 

SkipInvalidImages: this parameter is set to 'No' by default. If you set it to 'Yes', then the import will not be stopped if 
the capture encounters non-supported or corrupted image files. This is mainly useful when importing files in 
unattended mode. In case of single images, only the invalid ones are skipped. In case of multipages (.tif or .pdf), the 
invalid multipage is skipped entirely and renamed with a trailing "_skipped" in the input folder.  
Use this parameter at your own risk. Skipping pages can lead to mis information or to miss a corrupted file that could 
actually be needed.  

DottedLineHightlights: this parameter is set to 'No' by default. If set to 'Yes', then the extracted data zones are shown 
with dotted line rectangles instead of color highlight. 

BigDocumentExport: this parameter is set to 'No' by default. If set to 'Yes', it forces iDRS to use only one thread to 
format PDF document. It does allow big document to be exported despite memory limitations (up to 4000 pages per 
document). 
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Restoring Deleted Parameters 

In case you decided to delete a parameter and want to restore it: 

• Click the plus sign in the top right corner. 

• Enter the exact name of the parameter in the Name field. 
The names of the default Parameters are listed above. 

• Then enter the values Yes or No based on your requirements. 

These values are case-sensitive. 

Note however that the drop-down list that allows you to switch from Yes to No will no longer be 
available for restored parameters. 
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6. Configuring Projects using the Wizard 

The easiest way to configure projects in IRISPowerscan™ is by using the Wizard. By means of the Wizard you can quickly 
define the page, document and batch types you will be scanning, how page types must be identified, how documents 
and batches must be separated, which image processing operations must be applied, in which output format the scans 
must be converted and to which destination they must be sent. 

You can access the Wizard from anywhere in the interface by pressing F12 on the keyboard. You can also start the 
Wizard both from Navigation and Designer mode by clicking the Wizard command on the Edit tab. 

  

Notes: 
The Wizard contains the same operations whether you start it from Navigation or Designer mode. 
All actions that are available in the Wizard can also be done manually in Designer mode. 

 

Purpose of the Wizard 

The Wizard tries to provide answers to the questions you might have when configuring a project. For instance, how do I 
separate batches, documents and pages? Which separation method would I use; blank pages, barcodes, patch codes, 
OCR zones, etc. Will I scan different types of documents? And do I want to store the different document types in the 
same location, or send them to different destinations? Do I want IRISPowerscan™ to apply image processing images to 
all scanned images? Or only to images belonging to a certain type, and so on. 

Tip: also see Parameters to Consider to have an idea of which parameters to take into account when configuring a 
project. 

The great novelty of the Wizard is that you can configure projects along the way, while you may be scanning documents 
already. You just start the Wizard - without needing to quit your project or enter a Project Setup - apply the settings you 
need. Then you use Rescan to apply the changes to the documents you have already scanned. Any subsequent 
documents are scanned under the same conditions. 

Wizard Actions 

By means of the Wizard you can do the following actions: 

• Add images to samples. 

• Define the page types, document types and batch types you will be scanning, and how they must be 
separated. 

• Determine identification and separation methods. You do so by adding Operations. 

• Select Image Processing Operations that must be carried out on all scanned pages. 

• Select the Output formats and configure the Destinations to which scanned documents must be sent. 

• Add Data Sources to link IRISPowerscan™ index fields to the ones you have in a list or in external databases 
such as ODBC. 
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6.1 Parameters to Consider 

In order to configure a project efficiently, it might be a good idea to take the following parameters into account before 
you get started. 

The types of documents to be processed... 

• Are there several types of documents to be dealt with? 

• Do they contain blank pages? 

• Should the document types be sorted automatically? 

• Should there be any image processing such as AutoRotation, Despeckling, Deskewing, etc. 

The types of files to be generated... 

• Which output files do you want to generate: PDF, compressed PDF, Word files, etc. 

• Where do you want to send the processed documents to: to a folder, via mail, to SharePoint, etc. 

The hierarchical structure... 

• How should the document structure of batches, documents, pages be organized? 

• What should be the maximum size of a batch/document? 

• After how many pages should a new document/batch start? 

• How should the batches, documents and pages be named? 

The page identification method... 

• Should pages be uniquely identified, so you can apply certain operations only to certain page types? 

The separation method... 

• Do the documents contain a barcode, an OCR zone, or a patch code that could be used to separate them? 

• Could their layout be used? 

• Could blank pages be used as separators? 

• Should the separation be done based on page count? 

The indexing values... 

• What should be the indexing values of each type of batch/document/page? 

• Should they be extracted from barcodes or from OCR zones? 

• Should there be special default values? 



IRISPowerscan 10.5 – User Guide 

78 

6.2 Add an Image to Samples 

WARNING: in order to add an image to Samples via the Wizard, you first need to scan pages to the current 
project. 

Purpose of adding samples 

One of the great novelties of IRISPowerscan 10 is its ability to do identification on page level. In other words, 
IRISPowerscan™ can uniquely identify each page that is scanned. That way, certain operations (like image processing, 
data extraction, etc.) can be applied only to particular pages, which increases the processing speed. But in order to do 
that IRISPowerscan™ needs at least one sample of the different pages that will be scanned. 

• Scan at least one page to your project. 

• In Navigation mode, select the page you want to add to samples. 
You can select the page either from the Navigation Explorer or from the Viewer. 

 

Image selected in Viewer 

• Start the Wizard (F12). 

• Click Add an image to samples. Then click Next. 

Note: if you have not selected a page, the operation Add an image to samples will not be visible in the 
Wizard. 

• Enter a Name for the sample. 

• Select on which level you want to add it: to the Samples collection or to one particular page / document / 
batch type. 

• Then click Finish. 

• To check which images have been added to samples, switch to Designer mode and click Images in the Designer 
Explorer. Or in case you added a sample to a particular Batch/Document/Page type, select the correct type and 
click Images. 

 

Sample images on Document type level 
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Note: besides using the Wizard, you can also simply copy-paste images to Images. Copy the image file you 
want to add, right-click Images at the desired level and click Paste to add it. 

Renaming the samples  

To rename the Images from the Designer mode: 

• Select the image form the list 

• Click Rename 

• In the pop-up window, enter a new name 

• Click OK 
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6.3 Add an Operation 

Purpose of adding operations 

The operations you add via the Wizard are used among others to configure the page identification, document and 
batch separation, image processing operations, etc. 

WARNING: if you already scanned documents in your project and add an operation afterwards, make sure 
to click Rescan (beneath Scan) on the Edit tab to see how the newly added operations affect the document 
classification. The operations will be applied to any subsequent documents you scan. 

• Start the Wizard (F12). 

• Click Add an Operation. Then click Next. 

• Select the operation you want to add. 

 

Note: the first two operations in the list - Image Processing and Data Extraction - are by default applied in 
each project. They are displayed in the Designer Explorer. 

 

With the Image Processing operations set you can determine which image processing operations must be carried out 
on all scanned documents. 

With Data Extraction you can configure which data must be extracted from the scanned documents. Those data can be 
filled in in index fields, but it can also be used as separation method. You can for instance separate elements based on 
barcode zones and OCR zones. 

See section Operations for more information. 

Scrolling the sample images 

To scroll the sample images: 

• Go to Operations in the Designer Explorer 

• Use the Arrow buttons left or right < >  

Or 

• Use the keyboard shortcut Alt+ down/up arrow 
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6.4 Add an Image Processing Operation 

Purpose of adding image processing operations 

In the Wizard you can not only activate the Image Processing operations set (explained in Add an Operation), but you 
can also apply specific image processing operations directly. These operations enhance the quality of the scans, which 
leads to better processing results. 

WARNING: if you already scanned documents in your project and add an operation afterwards, make sure 
to click Rescan (beneath Scan) on the Edit tab to see how the newly added operations affect the document 
classification. The operations will be applied to any subsequent documents you scan. 

• Start the Wizard (F12). 

• Click Add an image processing operation. Then click Next. 

• Select the operation you want to add. 
Note that you can only select one operation at a time. Once you have added it you can return to the Wizard 
and add a new one. 

• The order in which you select the operations is also the order in which they will be executed, but this can be 
changed afterwards by means of the up/down arrows. 

 

Note: the image processing operations you select through the Wizard are applied to all scanned pages. In 
Designer mode it is also possible to apply certain operations to specific pages, documents and batches only. 
See Image Processing for more information. 
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6.5 Add a Page Type 

Purpose of adding page types 

As already mentioned in this documentation, one of the great novelties of IRISPowerscan 10 is its ability to uniquely 
identify pages. By uniquely identifying pages, you can apply operations (like image processing, data extraction, page 
deletion, etc.) only to the pages where they are required, which increases the processing speed of IRISPowerscan™. 

When adding page types via the Wizard, the identification can be done in several ways. Note that when using 
Fingerprint detection, IRISPowerscan™ examines the layout of the scanned images. When using Data Extraction, 
IRISPowerscan™ examines the data extraction zones you have created and checks if the content matches the condition 
you defined. 

• Start the Wizard (F12). 

• Click Add a Page Type. Then click Next. 

• Name the Page Type. E.g. PageType1 in our example. 

• Browse for an image to use as sample. 

WARNING: if you select a page in the Navigation Explorer, you automatically add that page as sample. You 
cannot browse for another image. 

• Select the Identification Method: 

• None: no automatic identification will be done. 

• Based on blank page: IRISPowerscan™ adds the Condition Page.IsBlank to the PageType. If the 
condition is met, a Page will be considered of this PageType. 

• Based on Fingerprint: IRISPowerscan™ examines the layout of the sample. If scanned pages have a 
similar layout they will be recognized as belonging to the same page type. 

• Based on page index: IRISPowerscan™ adds the Condition "Page.Index==" to the PageType. If a Page 
matches the Index you indicate here, it will be considered of this PageType. 

• Based on Data Extraction: IRISPowerscan™ examines the data extraction zones you have defined on 
your pages. 

• Select the Data Extraction zone you want to use. 

• Select the Operator. 

• Then enter a Value. 
In the example image below, the Page Type will be recognized as PageType1 if the content of 
the selected Data Extraction zone equals "Bacchus". 

 

Once you have identified page types, you can use them to separate document types. You can either do this through the 
Wizard, or manually in Designer mode. Also see Add a Document Type and Separation of Documents and Batches for 
more information. 

Note: Page Types can be further configured in Designer mode. You can for instance define operations that should 
be carried out only to certain page types or under certain conditions. 
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6.6 Add a Document Type 

Purpose of adding document types 

IRISPowerscan™ classifies each stream of images/scans into a logical Batch > Document > Page structure. By default, 
you have 1 batch type, 1 document type and 1 page type. All pages you scan are added to the same document type. 

By adding document types you can customize IRISPowerscan™ to fit the structure of your documents. You can also 
choose to apply certain operations only to certain document types. 

• Start the Wizard (F12). 

• Click Add a Document Type. Then click Next. 

• Name the Document Type. 

• Select the separation method: 

• None: IRISPowerscan™ doesn't carry out any document separation when it encounters this document 
type. 

• Based on page count: IRISPowerscan™ starts a new document after the indicated number of pages. 

• Based on blank pages: IRISPowerscan™ starts a new document every time it encounters a blank page. 

• Based on page type: IRISPowerscan™ starts a new document every time it encounters the selected 
page type. This option is only available if you have defined at least two page types. See the previous 
section Add a Page Type. 

• Based on Data Extraction IRISPowerscan™ examines the data extraction zones you have defined on 
your pages. If the content of the extraction zones matches the one you have defined, IRISPowerscan™ 
starts a new document. 

• Delete first page: this option is available when you selected Based on blank pages or Based on Data 
Extraction. It deletes the first page of the document. 

• Configure the Naming options. 
The default naming items are Prefix + Document.Counter. For instance DocumentType2. 
The naming options can be a combination of a prefix, the value of a recognition zone, a date and time, a 
delimiter and a counter. Click the down arrow next to these fields to customize the naming options. 
In Designer mode you can also use the Expression Editor to configure more complex Naming options. 

 

  

Note: document types can be further configured in Designer mode. You can for instance create index fields on 
document level and define operations that should be carried out only to certain document types or under certain 
conditions. 

Also see Separation of Documents and Batches. 



IRISPowerscan 10.5 – User Guide 

84 

6.7 Add a Batch Type 

Purpose of adding batches 

IRISPowerscan™ classifies each stream of images/scans into a logical Batch > Document > Page structure. By default, 
you have 1 batch type, 1 document type and 1 page type. All pages you scan are added to the same document type. 

By adding batch types you can customize IRISPowerscan™ to fit the structure of your batches. You can also choose to 
apply certain operations only to certain batch types. 

• Start the Wizard (F12). 

• Click Add a Batch Type. Then click Next. 

• Name the Batch Type. 

• Select the separation method: 

• None: IRISPowerscan™ doesn't carry out any batch separation when it encounters this batch type. 

• Based on document count: IRISPowerscan™ starts a new batch after the indicated number of 
documents. 

• Based on blank pages: IRISPowerscan™ starts a new batch every time it encounters a blank page. 

• Based on Data Extraction IRISPowerscan™ examines the data extraction zones you have defined on 
your pages. If the content of the extraction zones matches the one you have defined, IRISPowerscan™ 
starts a new batch. 

• Delete first page: this option is available when you selected Based on blank pages or Based on Data 
Extraction. It deletes the first page of the batch. 

Note: batch types can be further configured in Designer mode. You can for instance define index fields on 
document level and define operations that should be carried out only to certain document types or under certain 
conditions. 

Also see Separation of Documents and Batches. 
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6.8 Add an Output Type 

IRISPowerscan™ can send scanned documents in a wide range of output formats and to many possible destinations. By 
adding an Output Type via the Wizard you can quickly select the required output format and configure the destination 
for your documents. 

• Start the Wizard (F12). 

• Click Add an Output Type. Then click Next. 

• Enter a Name that is meaningful to you. 

• Select the required output format from the list. Then click Next. 
If you have defined multiple Document Types you will be asked whether to apply the output to a particular 
document type or to all document types. Make your choice. Then click Next. 

• Now select a destination from the list, and click Next to configure it. 

 

• When you select eMail you are prompted to enter the recipient's address and configure the email 
settings. 

• When you select Folder you are prompted to enter a Path. The default path is the Documents folder. 

• When you select a Cloud destination you are prompted to enter the Server and/or User Name and 
Password. 
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6.9 Add a Data Source 

By adding a Data Source via the Wizard you can link the index fields in IRISPowerscan™ to a list of values or to an 
external ODBC database, like Microsoft Access. 

How to use it is explained in Indexing Scanned Documents > Using a Data Source. 
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7. Processing Documents in IRISPowerscan™ 

Main Processing Steps 

Documents go through three main steps when being processed in IRISPowerscan™: 

1. Capture 

2. Validation 

3. Export 

Depending on your user rights, you will be able to carry out one or more of these processing steps - or activities. 

Note: each of these three processing steps can also be run in the background. See Background Processing 
below. 

1. Capture 

The Capture can be done by means of a scanner, by scanning from folders and from the Cloud. 

2. Validation 

When documents have been scanned they are displayed in Navigation mode, where a full range of tools are available 
for post-scanning operations. You can now validate the images and the index fields you have created. 

3. Export 

When the documents and their index fields have been validated they are ready for export. IRISPowerscan™ can export 
documents in numerous output formats to various target systems. 

Tip: in order to export only the documents and batches that were not already exported previously, you can 
use the conditions !Document.IsExported and !Batch.IsExported. Also see Using Expressions. 

 

Managing Exported Batches 

During processing, the status of the batches in process can be checked in the Application menu. To do so, click File > 
Manage. 

There you get an overview of which batches are being processed, in which project and by which user, what their status 
is, which activity has been carried out on them. An error message is displayed in case of failure. 
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Checking the history of batches 

• Select a batch and click the History icon . 

 

Unlocking batches 

When a user - or the Service - executes an activity on a batch, the current batch is locked until the user/Service exports 
it. In case a batch should stay locked, it can be unlocked manually: 

• Right-click the batch you want to unlock. 

• Then click Unlock. 

Notes:  
This feature is meant as a recovery method. It should only be used for diagnostic purposes and not 
in standard procedures. 
If the unlock feature is unavailable, this means the batch has already been unlocked. 

Resending batches 

When a batch has the status "On Error", which means some errors have been encountered, the user can retry the 
processing: 

• Select a batch and click the History icon . 

• Select the required activity from the list. 

• Click the retry icon . 
The status of the batch is now changed to "Ready" and the batch can be processed again in Navigation mode. 

Browsing batches 

This function allows you to open the batch directly in the right project when you are in a different project. 

• Click the browse to open the corresponding project and import the selected batch. 

• Or right-click the batch and select Open. 

Note: if the browse function is unavailable, this means you have no batches in process in other projects, or 
the batches are still locked. 

Deleting batches 

• Select a batch you want to delete. 

• Click the delete icon to delete the selected batch. 

• Or right-click a batch and select Delete. 

Note: as of IRISPowerscan 10.4, when you delete an Invoice batch from this section it will also be removed 
from the WebVerify Job list. 
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Background Processing 

When carrying out an activity in the background, the activity is done by the IRISPowerscan™ service called IPSxService. 

The IRISPowerscan™ service is responsible for starting and stopping the IPSxConsole processes to handle the Capture, 
Validation and Export when they are being done by the Service. 

Depending on the resources available, and on the project settings (when the Capture is done by the Service), several 
IPSxConsoles may be started at once. 

The Service can be used for free for general tasks, Capture and Validation. In order for the Export to be done by the 
Service however, the Background Processing add-on needs to be activated. 

Note that the Service uses as much resources as your computer allows. The more cores your computer has, the more 
parallel processing the Service will be able to execute. 

To run any of the activities in the background by the Service: 

• Open a project and switch to Designer mode. 

• Click Properties. 

• In the Activities section you see which user groups are allowed to carry them out. 
By default the Supervisors group is allowed to do each activity. To learn how to customize the local user 
groups and users, see Managing Users and Groups. 

 

• Select the required activity, and then select Service. 

When the Capture activity is done by the Service and you selected a Folder as source, the folder now functions 
as Watched Folder. 

When the Validation activity is done by the Service, index fields do not need to be validated manually by a user. 

When the Export activity is done by the Service, the documents are exported automatically to the configured 
destination as soon as the processing is done. 

Note: you can also use the IRISPowerscan Server™ to carry out these activities. In that case it is no longer 
your local IRISPowerscan™ station that executes them, but the central Server. 

Note: in a Client/Server context, the IRISPowerscan™ service executes different tasks: 

• It synchronizes projects and user rights between the Clients and the Server. 

• It manages the Batch statuses between the Client and the Server. 

• It manages the Batch transfers between the Client and the Server. 

To access the IRISPowerscan Server™ documentation, open the IRISPowerscan Server™ application and click File > 
Help. 
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7.1 Managing Groups and Users 

In IRISPowerscan 10 you can create local users and local groups and define their permissions. When a user logs in using 
the credentials you provided him with, he is only able to execute the tasks for which he has the necessary permissions. 

Note: If you want to configure users and groups that can log on to the IRISPowerscan Server™, this must be 
done in the IRISPowerscan Server™ application. To access the IRISPowerscan Server™ documentation, open 
the IRISPowerscan Server™ application and click File > Help. 

To access the local users and groups settings in the IRISPowerscan™ main application, click File > Info > Users/Groups. 

 

Defining Groups 

The user permissions are defined in the Groups section. Each user belonging to the same group has the same 
permissions. This way you avoid having to determine the permissions for each user separately. 

There are 2 default groups in IRISPowerscan™: Operators and Supervisors. 

The Supervisors group has access to all permissions. In other words, Supervisors can do all configuration actions. The 
permissions of the Supervisors group cannot be modified. 

The Operators group is by default allowed to scan and process documents in IRISPowerscan™ but cannot do advanced 
configurations. The permissions of the Operators group can be modified. 

You can also create customized groups for which you determine the permissions of your choice: 

• Enter a Name for the new group. 

• To change the default user icon, select another icon from the icon list. 

• Select the permissions a user belonging to this group is allowed to do. Only the corresponding commands will 
be available in the interface. 

• Then click OK to confirm. 

Defining Users 

There are 2 default Users in IRISPowerscan™: guest and SysAdmin. Both belong to the Supervisors group and therefore 
have all Permissions. 

To add or edit a user: 

• Click the plus sign. 

• Enter a Name for the new user. 

• To apply a password, click Change password. 

• If this is the first time you attribute a password, leave the Old Password field empty, enter the 
password in the New Password field, and confirm it. 

• To change the default user icon, select another icon from the icon list. 

• If the user is/should be part of a domain, enter the domain in the Domain field. 

• The Status of the new user is by default set to Active. 

• To deactivate the user later on, return to this menu and select Inactive. 
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• Select the interface language from the Language list. 
When the user logs in, the interface is displayed in the selected language. 

• Select the Unit in which measurements must be displayed: centimeter, inch or pixel. 

• Select the Group to which you want to add the user. 
The default groups are Supervisors and Operators. 
To add the user to a different group, first create it in the Groups section. 
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8. Scanning Documents 

Once you have created a project and know how to navigate inside it, you can start scanning documents. 

WARNING: in IRISPowerscan 10 it is possible to change the configuration of a project as you go along, even 
when you have already scanned multiple documents. Just use Rescan to apply any changes to the 
documents you have scanned. 

 

There are different ways to scan documents in IRISPowerscan 10: 

• Using a Scanner 

• Scanning from Folders 

• Scanning from the Cloud 

• Scanning from XMailFetcher 

Switching between Sources in Navigation mode 

When you have configured multiple input sources, you can switch between them in Navigation mode: 

• Click the down arrow beneath Scan on the Edit tab. 

• Select the source of your choice. 

 

• Click Settings to access the settings of the source. 

Displaying the Scan Summary 

If you want to display a Scan summary after each scan, set the ScanSummary parameter to 'Yes' in Configuration 
pane > Parameters. 

The Scan summary displays the total physical pages scanned and the total number of images scanned. The first digit 
indicates the number of pages scanned during the last scan (7 in our example below), while the second digit indicates 
the number of pages scanned since the opening of the application (14 in our example). 
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8.1 Using a Scanner 

IRISPowerscan™ is compatible with virtually any Twain-based scanner that uses Twain version 1.9 and higher. 

If you are using an ISIS-based scanner, make sure the ISIS-Driver Add-on has been activated. 

WARNING:  
Before you try to use a scanner in combination with IRISPowerscan™, make sure the scanner is powered on 
and its driver is installed on your system.  
If you are using multi-streams – and especially 3 streams i.e. color, grayscale and black-and-white - you 
must use compressed images. Uncompressed images may lead to issues or very slow scanning. 

Configuring a scanner as scan source 

In a new project: 

• Create a new project using the Wizard. 

• Select Scanner as Source. 
Continue with the steps of the Wizard until you are done. 

• The project opens in Navigation mode. On the Edit tab, click the down arrow below Scan and click Settings. 

• Click the settings icon to select the driver. 

• Then click the drop-down list to display the available scanners. 

Note: if the list is empty, there are no scanners configured on your system. 

• Select a scanner from the list. Then click OK. 

 

• Select how you wish to split or merge the documents coming from the scanner in the Arrangement drop-down 
list: 

• Disabled: the pages will not be split. 

• Split long edge: splits pages along the long edge of the page. 

• Split vertically: splits pages vertically. 

• Split horizontally: splits pages horizontally. 

• Fold and Split horizontally (IPS9): folds and splits A3 pages horizontally into two A4 pages. 

• Merge long edge: merges two subsequent pages along the long edge of the pages. 

• Merge vertically: merges two subsequent pages vertically. 

• Merge horizontally: merges two subsequent pages horizontally. 

• If you want the scanner to scan one-sidedly only, select Force Simplex. 

WARNING: when scanning documents to the Invoice Add-on (SPAP or Solution Package Accounts Payable), 
you must select the Force Simplex option of the Scan settings. This is because the Invoice module only 
supports front pages. 

• Imprinter (this option is only displayed if your scanner supports it): enter a value you want the scanner to add 
to your scans. 

  



IRISPowerscan 10.5 – User Guide 

94 

In an existing project (which does not have a scanner as source yet): 

• Open your project and switch to Designer mode. 

• Click Properties. 

• Click the plus sign next to Sources. 

• Select Scanner and click Create. 

• Click the settings icon to select the driver. 

• Then click the drop-down list to display the available scanners. 

Note: if the list is empty, there are no scanners configured on your system. 

• Select a scanner from the list. Then click OK. 
The same settings as explained above are available. 

Start Scanning 

• Click Scan or the large scanner icon to start scanning. 
Your documents are divided into batches, documents and pages. 
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8.2 Scanning from Folders 

Although IRISPowerscan™ is a scanning solution it is not required to use a scanner. You can also scan from folders.  

To scan from folders you can either: 

• Create a new project and select Folders as source. 

• Add Folders as Source to an existing project. 

Configuring a Folder as source 

In a new project: 

• Create a new project using the Wizard. 

• Select Folders as Source. 

• Click Next to define the Folder settings. 
These settings are described at the bottom of this topic. 

• Proceed with the next steps of the Wizard and click Finish. 

In an existing project (which does not have a Folder as source yet): 

• Open your project and switch to Designer mode. 

• Click Properties. 

• Click the plus sign next to Sources. 

• Select Folders from the list and click Add. 
Folders is now added as source. 

 

The Folder Settings 

Path 

• Click the browse icon ( ) to select the scan folder. 
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• To customize the expression click the pencil icon ( ) to open the Expression Editor. 

WARNING: when customizing the expression, make sure to put '+ "\" +' between the different elements. 
Note that you can also use fixed values between double quotation marks. For example "C:\Images". 

• If the folder you want to scan from is protected by a password, click the padlock icon ( ). 

• Enter your (domain ) User name. E.g. IRIS_DOM\MyName. 

• Enter your Password. 

• Confirm the password, and click OK. 

 

File Format 

IRISPowerscan™ by default searches for all files that end with the extensions *.jpg,*.jpeg,*.tif,*.tiff, *.png, *.bmp and 
*.pdf. 

Sorting 

Select how the scanned files must be sorted: by name, creation date, modification date or unsorted. 

Arrangement 

• Disabled: pages will not be split. 

• Split long edge: splits pages along the long edge of the page. 

• Split vertically: splits pages vertically. 

• Split horizontally: splits pages horizontally. 

• Fold and Split horizontally (IPS9): folds and splits A3 pages horizontally into two A4 pages. 

• Merge long edge: merges two subsequent pages along the long edge of the pages. 

• Merge vertically: merges two subsequent pages vertically. 

• Merge horizontally: merges two subsequent pages horizontally. 

Other options 

• Select Duplex to make IRISPowerscan™ process the uneven pages as front pages and the even pages as rear 
pages. Select this option when using a duplex scanner. 

• Select Recursive to make IRISPowerscan™ also process the files in the subfolders of the selected input folder. 

• Browse folders before scanning (not applicable when using a folder as Watched Folder): you are prompted to 
indicate the input folder each time you click Scan. 

• Browse files before scanning (not applicable when using a folder as Watched Folder): you are prompted to select 
one or more files each time you click Scan. 

• Ignore hidden files: when selected, hidden files will not be scanned. 

• Delete files after scanning: when selected, the files will be deleted after scanning. 

Resolution 

When importing PDF files you can select the Resolution in which they will be imported. You can select a resolution 
ranging from 100 DPI to 600 DPI. Note that a resolution of 300 DPI is generally recommended. 

This option does not apply to image files nor does it change the resolution of your scanner. 

Timer 

Indicate after how many seconds IRISPowerscan™ must process the images in the folder. 

Note: this option only applies when using a folder as a Watched Folder. See below. 
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Signal 

The Signal option is used when using Connected Projects. See the corresponding topic for more information. 

Backup 

If you want to make a backup of your files, click the browse icon and select the folder to store the files in. Or click the 
pencil icon to use an expression. 

To overwrite files with the same name, select Overwrite. 

Drag-and-drop files to a project 

You can also drag-and-drop documents from a file folder or from your e-mail application to a project. 

8.2.1 Using a Folder as Watched Folder 

You can also have IRISPowerscan™ monitor a folder as Watched Folder. Whenever IRISPowerscan™ spots a new 
document inside one of the Watched Folders, it processes it. 

Thanks to the Watched Folders feature IRISPowerscan™ can easily be combined with MFPs. 

Rules of thumb when using Watched Folders 

• The Watched Folders feature is designed to handle a maximum of 10 Watched Folders. 

• One project can watch one folder at a time. 

So if you configure multiple Watched Folder projects, make sure that a single Watched Folder is not 

being monitored by several projects. 

• It is recommended not to insert big files in a Watched Folder. Files in any format should be limited to 300 MB. 

Bigger files will go through but will decrease overall performances. 

• It is better to use image files like TIFF, multiTIFF and JPEG as opposed to PDF. 

PDF also works well but it requires more processing power to be decompressed and treated. 

• The more cores your computer has, the better and faster the processing will be. 

• Separation based on barcodes and Fingerprint can also affect the overall performances. 

In a worst case scenario using complex separation schemes may decrease the overall speed to half of the 
normal speed. 

• The output format you select plays an important role as well. iHQC output can vary from 100% speed to 10% 
speed depending on the Quality factor. 

Configuring a project with a Folder as Watched Folder 

Before you configure projects with a Folder as Watched Folder: 

• Click the traffic light icon in the bottom left corner of the interface to stop the Service. 

When the Service has been stopped, the traffic light is red. 

WARNING: if you do not stop the Service and Copy-Paste projects to create several Watched Folders, the 
Service may start watching the same folders and unpredictable results may occur. 
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• Now configure the Watched Folder as explained below. 

• When you are done, save your project and click the traffic lights icon again to restart the Service. 

To use a Folder as Watched Folder: 

• Switch to Designer mode in your project. 

• Click Properties. 

• Set the Timer to the required number of seconds. (See the Folder Settings above). 

• In the Capture drop-down list next to Activities, select Service. 

Note: you don't need the Background Processing add-on to have the Capture done by the Service. 

 

Note: if you also select Validation and Export, the scanned documents go trough IRISPowerscan™ automatically 
and they are sent to the configured destination without requiring user intervention. If you want users to do a 
manual index validation, do not select Service in the Validation drop-down list. 

 

WARNING: in order to have the Export done as a Service, the Background Processing add-on must be activated. 

 

Note: you can also configure the IRISPowerscan Server™ to carry out the Capture. In that case, it is not the local 
instance of IRISPowerscan™ that monitors the Watched Folder, but the IRISPowerscan Server™. 

When you are done configuring Folders as input source, click Scan to start scanning documents. 

Tip: for more information and best practices, see the Technical Note on Watched Folders. 
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8.3 Scanning from the Cloud 

IRISPowerscan 10 can scan documents from Cloud services such as SharePoint, OneDrive, box and Dropbox. In order to 
do so, you must have a valid account and configure the connection correctly. 

To configure a Cloud repository as source: 

• Create a project and select one of the Cloud source. 

Or in an existing project: switch to Designer mode > Properties. Click the plus sign next to Sources and 
select one of the Cloud sources. 

 

• Enter the server and/or credentials of your Cloud account. 

Configuring SharePoint 

• Select SharePoint and click Next. 

Step 1 

• Enter the Server url. 

• Enter the User name and Password, if required. 

Whether or not a user name and/or password are required depends on your SharePoint configuration. If 
necessary, contact your System Administrator. 

If your computer is located in a domain, you may need to add the domain name followed by a back slash 
in front of the User name. E.g. Your_Domain\jsmith. 

• Click Next to establish the connection. 

Step 2 

• If the connection is successful, and if your SharePoint server contains any libraries, the list of available libraries 
is displayed. 

• Select a library from which you want to import the documents, and click Next. 

Step 3 

• Now you can select a specific folder inside the library from where the documents will be imported. 
If you do not select a folder, the documents are imported from the root of the library. 

Step 4 

• Now select a content type. 

• Follow the remaining steps of the Wizard. 

Configuring OneDrive, Box and Dropbox 

• Select your source and click Next. 

• Enter your credentials and click Next. 

• Select a folder and click Next. 

Note: if you do not select a folder, the documents are imported from the root. 
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8.4 Scanning from XMailFetcher 

WARNING: in order to scan from XMailFetcher, XMailFetcher must be installed and configured on your computer. 
Contact I.R.I.S. or your Canon representative to acquire XMailFetcher and its documentation. 

Introduction 

XMailFetcher is an easy to operate software application that monitors incoming emails and transfers them to an 
existing system, in this case IRISPowerscan™. The emails and their attachments are converted into Tiff files and sent to 
an output folder which in turn is monitored by IRISPowerscan™. 

By default, IRISPowerscan™ adds all emails to a single batch and document. All attachments are also added to the same 
batch and document. 

Tip: in case you want IRISPowerscan™ to create one document per email, use the condition Mail.PageIndex == 0 on 
Document level. The separation of emails works in the same way as 'regular' documents, the only difference is that 
you use Mail variables instead of Document variables. See Using Expressions for more information about the 
available variables. 

 

In case you want IRISPowerscan™ to create one document per attachment, use the condition Input.PageIndex 
==1 on Document level. 

Configuring a XMailFetcher as source in IRISPowerscan™ 

In a new project: 

• Create a new project using the Wizard. 

• Select XMailFetcher as Source. 

• Click Next to define the XMailFetcher settings. 
These settings are described at the bottom of this topic. 

• Proceed with the next steps of the Wizard and click Finish. 

In an existing project (which does not have a XMailFetcher as source yet): 

• Open your project and switch to Designer mode. 

• Click Properties. 

• Click the plus sign next to Sources. 

• Select XMailFetcher from the list and click Add. 
XMailFetcher is now added as source. 

The XMailFetcher Settings 

Path 

• Click the browse icon ( ) to select the scan folder. 

WARNING: the input folder must be the Output-Directory folder you configured in the XMailFetcher 
application. 

• To customize the expression, click the pencil icon ( ) to open the Expression Editor. 
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WARNING: when customizing the expression, make sure to put '+ "\" +' between the different elements. 

Note that you can also use fixed values between double quotation marks. For example "C:\Images". 

• If the folder you want to scan from is protected by a password, click the padlock icon ( ). 

• Enter your Domain User name. E.g. IRIS_DOM\MyName. 

• Enter your Password. 

• Confirm the password, and click OK. 

 

Arrangement 

• Disabled: pages will not be split. 

• Split long edge: splits pages along the long edge of the page. 

• Split vertically: splits pages vertically. 

• Split horizontally: splits pages horizontally. 

• Fold and Split horizontally (IPS9): folds and splits A3 pages horizontally into two A4 pages. 

• Merge long edge: merges two subsequent pages along the long edge of the pages. 

• Merge vertically: merges two subsequent pages vertically. 

• Merge horizontally: merges two subsequent pages horizontally. 

  

Duplex: select this option to process the uneven pages as front pages and the even pages as rear pages. 

Email body: select this option to retrieve the Email body from XMailFetcher. The Email body is added as first page of 
the document. 

Original images: select this option to retrieve the original images instead of the converted Tiff images. 

Delete files after scanning: select this option to delete the files once the signal file of the processed e-mail has the 
extension ".scanned". 

The following files will be deleted: 

.\Data\MailXXXX\ 

.\Signal\MailXXXX.scanned 

Note: if this option is not selected, no files will be deleted and the signal file of the processed e-mail keeps the 
extension ".scanned". 

The Scanning 

• Make sure emails are being sent to the Output-Directory you configured in XMailFetcher. 
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• Start the XMailFetcher application. 

• Check the activities in the main window. 
When an email has been converted, the following activity is displayed: Converting MailBody to Multipage TIFF 
done. 

 

• Return to IRISPowerscan™ and scan from within the XMailFetcher Project you configured. 

• Your emails are now inserted into IRISPowerscan™. 

  

Tip: in case you should need to reprocess a batch coming from the XMailFetcher, go to the Output-Directory you 
configured and open the Signal folder. Delete the ".scanned" file of the email you want to reprocess. Then click 
Scan again in IRISPowerscan™. If you do not delete the ".scanned" file, the email cannot be reprocessed. 
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9. Operations 

9.1 Image Processing 

IRISPowerscan™ offers a wide range of image processing features, which aim to obtain the best possible scan results. 
After all, the higher the quality of the scans, the higher the processing accuracy will be. 

There are different ways to apply Image Processing Operations: 

• During the creation of a project. 

WARNING: the operations you apply during the creation of a Project are applied to all images you scan 
within the project. If you need to perform some image processing operation on one or a subset of images 
within a batch, add those operations via the Operations pane in Navigation mode and click Save. 

• Through Operations in Navigation mode. 

The operations you add in Navigation mode are meant to be applied to one or a subset of images within 
a batch. Once the image operations are applied, the specific settings are lost. 

• By means of the Wizard > Add image processing operation. 

• Through Operations in Designer mode. 

WARNING: when adding operations via the Wizard or through Operations in Designer mode you can 
choose on which level you want to apply the operations: to all scanned images, or to specific batch, 
document or page types. The latter possibility increases IRISPowerscan™'s processing speed: operations can 
be applied only where they are strictly necessary, and it is no longer necessary to apply them to all scanned 
pages. 
It is also possible to apply these Operations to specific OutputTypes. 

An overview of the different Image Processing Operations can be found in 9.1.5 Overview of the Image Processing 
Operations below. 

9.1.1 Adding Operations during the creation of a project 

See Creating Projects > Wizard. 

9.1.2 Adding Image Processing Operations through the Operations pane in 
Navigation mode 

• Scan a batch of documents. 

• Check the scanned images. 

• If there are specific images on which Image Processing Operations need to be applied, select a page and then 
click the Operations tab in the bottom right corner. 

Note: the Operations tab is only visible on Page level. It is not visible when you select a Document or a 
Batch. 

• Click the plus sign and add the operations of your choice. 

 

• Now Ctrl-click the images in the Navigation explorer to which you want to apply these operations, and click 
Save. Once the images are saved, the image processing settings are lost. 
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• The operations you configured are now only applied to the images you selected. 

Tip: in case you need to undo the operations, press Ctrl-Z or click the Undo icon. 

 

9.1.3 Adding Image Processing Operations through the Wizard 

See Configuring Projects using the Wizard > Add an Image Processing Operation. 

9.1.4 Adding Image Processing Operations manually in Designer mode 

• Switch to Designer mode. 

• Determine on which level you want to add image processing operations: to all scanned images, or to a specific 
page, document or batch type. 

• Right-click Operations, and click Create. 

 

• Select Image Processing, and click Finish. 
Image Processing is now added to the Designer Explorer. 

• Select Image Processing in the Designer Explorer, and click the plus sign in the Properties pane to add the 
required operations. 
Or right-click Image Processing and click Create. 

 

• Select the required(s) operation from the Wizard and click Finish. 
Note that you can apply multiple image processing operations on each level in IRISPowerscan™. Simply select 
them one at a time in the Wizard and click Finish. 
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• The operations you add are displayed in the Properties section. Expand the operation to display its settings. 

 

• You can add as many image processing operations you want. When you add multiple operations, use the 
up/down arrows to sort them. This way you can determine which operations IRISPowerscan™ executes first. 
You can for instance tell IRISPowerscan™ to first binarize the scanned color images and afterwards despeckle 
the binarized images. 

 

• The different operations and their properties are discussed below. 

  

Note that you can apply a Condition to the Image Processing operations. This way you can choose to apply operations 
only to color, grayscale or black-and-white image for instance. Or only to the front or rear side of pages. 

To apply a condition, click the Wizard icon. Then select to which kind of images you want to apply the operations. 

You can also use the Expression Editor ( ) to build advanced expressions. 
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9.1.5 Overview of the Image Processing Operations 

Contrast Brightness 

Contrast Brightness can only be applied to color and grayscale images, not to black-and-white images. 

 

When scanning low-quality documents, adjusting the Contrast level is sometimes required to obtain an optimal scan 
result. 

• Enter a value for Contrast. The value can range from -50 to +100. The higher the value, the higher the contrast. 

When you are scanning dark, blurry images, or extremely light images, it may be necessary to adjust the Brightness 
settings. 

• Enter a value for Brightness. The value can range from -100 to +100. The higher the value, the higher the 
brightness. 

Crop 

Crop allows you to define the area to which the scanned image must be cropped. 

• Enter a value for the Top, Left, Right and Bottom margins you want to crop. 
Note that the value is in pixels. 

• To crop to a percentage of the image, select Percentage. 

Tip: scan a few test documents to see if the settings fit your requirements. 

Negative 

Negative inverts the colors of the scanned documents. 
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Binarize 

Binarize turns color and grayscale images into binary (black-and-white) images on which IRISPowerscan™ then executes 
its image processing operations. 

Binarize can therefore only be applied to color and grayscale images, not to black-and-white images. 

  

IMPORTANT TIP: Data extraction requires black and white images. From a color image, IRISPowerscan™automatically 
generates a black-and-white image with a binarize image processing. This default and implicit setting is the 'auto 
threshold' (it corresponds to the 'Adaptive binarize' being unchecked when you manually add a binarized image 
processing into the designer). In some cases of colored text or colored area, binarization with 'auto threshold' may 
result in loss of text or black area. We recommend that you carefully select the appropriate binarization for your 
documents. Not manually adding 'Adaptive binarize' at image processing level, and therefore using 'auto threshold', 
could result in less efficient data extraction. The implicit binarization used by IRISPowerscan™ is the fastest, but in some 
cases not the best.  

 

Implicit Binarization: Auto Threshold 

 

 

When adding Binarize image processing manually, then 
Adaptive binarization is selected per default. 

Recommended. 

  

• At this level, the option Adaptive (binarization) is selected by default . It determines the local thresholds. 

• The Brightness is set to 0. The higher the values, the darker the results will be. 

• The Contrast is set to 40. The Contrast enhances the image by increasing/decreasing the difference 
between image elements and their background. The lower the Contrast value, the darker the result. 

Tip: when scanning QR codes, set the Contrast level to 90 to obtain optimal results. 

• To select a manual threshold, clear the Adaptive option, and select Manual threshold. Then set the Threshold 
value. 

• The Smoothing option removes image noise from the scans. The higher the value, the more noise will be 
removed. 

• The Color dropout option allows you to remove the colors that cause problems during the binarization. 

• Tolerance: this is the precision to obtain the correct color. The smaller the value, the higher the 
precision. 

• Hue: enter a value, spin the wheel or select one of the color squares to change the hue. 

• Min value: a high value limits the dropout to light colors. 

• Min saturation: A high value limits too intense colors. 
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Grayscale 

Grayscale converts color images you scan into grayscale images. 

Auto Rotate 

AutoRotate rotates images automatically. 

Select the Method based on which IRISPowerscan™ will do the rotation: 

• barcode: images are rotated based on the orientation of the barcodes. 

• text: images are rotated based on the orientation of the text. 

• barcode+text: first the orientation of the barcodes is examined, if no barcodes are found then the orientation 
of the text is used to rotate images. 

• text+barcode: first the orientation of the text is examined, if no text is found then the orientation of the 
barcodes is used to rotate images. 

Rotate 

Rotate can rotate scanned documents by 90°, 180° and 270° degrees. 

Deskew 

Deskew deskewes images that were scanned skewed. 

Despeckle 

Despeckle can only be applied to bitonal images. Despeckling removes little parasitic dots that may appear on your 
documents. 

• Enter the Size of the dots you want IRISPowerscan™ to remove. The higher the value the bigger the dots that 
will be removed. 

• Enter the Dilatation degree. The higher the value the more isolated pixels will be removed and objects will be 
smoothened. 

Line Removal 

Line removal removes lines from scanned images. Note: it only works on bitonal images. 

When Line removal is activated IRISPowerscan™ by default removes horizontal and vertical lines. You can also choose 
to remove only vertical or only horizontal lines. 

• Orientation: the orientation of the lines that must be removed. 

• Clean radius: the radius around the lines to be cleaned. 

• Dilate: the dilate parameter helps the detection of vertical lines, especially for thin and/or skewed vertical 
lines. 

• Max gap: maximum line gap to close (in case of broken, interrupted lines). 

• Max thickness: maximum thickness of the lines to remove. 

• Min length: minimum length of the lines to remove. 
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Line Removal (vertical) 

Removes vertical lines from scanned images. 

The same options apply as for general Line Removal. 

Line Removal (horizontal) 

Removes horizontal lines from scanned images. 

The same options apply as for general Line Removal. 

Black Border Removal 

Black border removal removes black borders (or dark surroundings) from bitonal images. 

• Border: default value is 122. A pixel that touches the border is considered as dark if its gray-value is below the 
DarkBorder parameter. 

• Inside: default value is 122. The dark surrounding is composed of the dark pixels that touch the border of the 
image and the pixels connected to those pixels with a gray-value below the value of the Inside parameter. 

• Delta: default value is 30. A pixel is considered connected to another pixel, if the difference between its gray-
value and the gray-value of the other pixel is below the value of the Delta parameter. 

Remove holes 

Removes punch holes from images. 

This operation can be applied to color, grayscale and black-and-white images. 

WARNING: your scanner should generate black punch holes in order for them to be removed correctly. Removing 
whitish punch holes is not supported. 

Tip: if your scanner also has a Punch hole removal option, choose where you want to enable it: in your scanner 
settings or in IRISPowerscan™, but don't activate both. 

       

Remove dither 

Removes unwanted dither (noise) from images. 

This operation can only be applied to black-and-white images. So if you are scanning in color, make sure to use the 
Binarize operation first. 

Stamp 

Stamp is used to add stamps to scanned images. Stamps may contain the user name of the operator, the scanning date, 
etc. 

• Enter the text that the stamp must include. This may be a variable or an expression. 

• Determine the position of the stamp on the X and Y axes. 
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• Enter the size of the stamp. 

The stamp is displayed on the sample image you select. 

Stamp (Image) 

Besides a Text Stamp, IRISPowerscan™ can add an Image Stamp. 

• Determine the position of the stamp on the X and Y axes. 

• Click the plus sign and browse for the image you want to use as stamp. 

Stamp (Barcode) 

Besides a Text Stamp, IRISPowerscan™ can add a Barcode Stamp. 

• Determine the type of barcode to be printed. 

• Enter the value of the barcode. This may be a variable or an expression. 

• Determine if the content of the barcode is printed above or below or simply hidden. 

• Determine the position of the stamp on the X and Y axes. 

• Determine the width:  

o In case of 1D barcode, this refers to the ratio wide bars to narrow bars. Only valid for some types of 
barcode. 

o In case of 2D barcode, this refers to the width of the barcode. The height is automatically adjusted. 

• Determine the height. 

o In case of 1D barcode, this refers to the height of the bar. Only valid for some types of barcode. 

o In case of 2D barcode, this option is hidden because irrelevant. 

• Click the plus sign and browse for the image you want to use as stamp. 

WARNING: Once the barcode is printed on the image, you cannot remove it anymore. Therefore we recommend to 
use this plug-in as an output operation 

Downscale 

Downscale is used to resize scanned images. Images can be downscaled up to factor 8. 

  

Perspective correction 

Corrects the perspective distortions of an image taken with a camera. If you mix images from camera and from 
scanners, we recommend to separate them into different page types or document types. 

The 'Fit document with image boundaries' option is checked by default and will straighten the captured image to make 
it stick to the border of the image. 
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9.2 Data Extraction 

IRISPowerscan™ offers powerful data extraction features: it can extract data from scanned documents through OCR 
(optical character recognition), BCR (barcode recognition), PCR (patchcode recognition) and ICR (intelligent character 
recognition). The extracted data can be used in several ways: as variables to identify page types, as a separation 
method to separate documents and batches, and to fill in index fields. 

Note however that when you identify pages by means of Data Extraction, the identification depends on the data 
recognition. If part of the data extraction zone is not recognized, the identification will not work. 

9.2.1 Creating Data Extraction Zones 

There are two ways to create data extraction zones: in Navigation mode and in Designer mode. The data extraction 
zones you create in Navigation mode apply to all scanned images. In Designer mode on the other hand, you can choose 
on which level and for which specific batch, document and page type you want to create data extraction zones. 

Creating Data Extraction Zones in Navigation Mode 

• Open a project. 

• Scan some documents. 

• Click any page you scanned. 

• Use the mouse to drag a frame around the zone you want to add. 
A temporary zone is now created. 
The zone type is detected automatically. The content extracted from the zone is shown in tiny characters 
below the zone. 

 

Tip: if you need to create many zones, right-click the image and click Analyze. This function detects all 
possible zones on the scanned page. 

• To confirm the zone, either press Enter or click the Capture icon ( ). 

Tip: to use the content of the zone in a Condition (to do Page Identification or Document/Batch Separation), 

click the Wizard icon ( ). 

• The zone is now added to the Data Extraction module in the Designer Explorer. There you can define its 
Properties (see below). 
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Creating Data Extraction Zones in Designer Mode 

• Open a project. 

• Switch to Designer mode. 

• Double-click any of the sample images you added to your Project. This may be at the general level (applied to 
all scanned images) or for a specific page, document or batch type. 

 

• Select Data Extraction and use the mouse to drag a frame around the zone you want to add. 

• A pop-up window appears where you can immediately select the zone type. 

• Select the required zone type and set its properties. 

 

9.2.2 Defining Zone Properties 

IRISPowerscan™ can extract data from the following types of zones: 

• Text zones 

• Hand-print zones 

• Barcode zones 

• Patchcode zones 

• Checkmark zones 

• Anchor point (shape) 

• Anchor point (text) 

Note: click the question mark icon to display the variables that will be updated for that particular zone. 

 

WARNING: IRISPowerscan™ requires binarized images to recognize Checkmark zones and Anchor shapes. If you 
are scanning color images, make sure to add the Binarize operation as Image Processing Operation. 
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Text and Hand-print Options 

• Select the Language of the zone. 
You can add an additional language by clicking the plus sign. 
Selecting the correct language is also crucial to obtain good recognition results. 

• Condition: a condition can be added to the zone for blob filtering. 

Blobs are the smallest elements returned by the OCR and Barcode engines. 

The blobs returned by the OCR engine are rectangles containing each individual letter. 

The blobs returned by the Barcode engine are rectangles containing each individual barcode. 

    

Blob examples 

• Click the Wizard icon to specify a condition. 

You can also use the Expression Editor ( ) to build advanced expressions. 

 

• Enter the Mask you want to use. 

Note: when you have entered a mask, the Match Operator "Blob ^" is added to the condition. E.g. 
Blob ^= "AAAA". In this example only a blob containing exactly 4 characters will be kept. 

 

Masks are used to validate the value detected in the zone. A mask is made of characters that correspond 
to different values: 

A = alphabetic character (including space) 

9= a digit (from 0 to 9) 

D= a digit (similar to \d in Regex) 

X= any character 

W= alphabetic character (not including spaces and similar to \w in Regex) 

S= a space (similar to \s in Regex) 
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?= any alphanumeric character (so a digit or an alphabetic character) 

E.g. if the mask value is AA99, then the zone value is valid if it starts with two alphabetic characters 
followed by two digits. 

A portion of the mask might have to match a literal expression. This literal expression must then be 
written between quotes. 

E.g. if the mask value is AA"CONTRACT"99, then the zone value is valid if it starts with two alphabetic 
characters followed by the literal expression "CONTRACT", followed by two digits. 

Number type mask characters 

9 = numeric 

E.g. 9(3) => Numbers containing 0 to 3 digits. 

E.g. 999 => Numbers containing exactly 3 digits. E.g. 453 or 123 or 657, etc. 

Tip: to keep only numbers and remove the letters from an OCR zone, use Blob ^= "9". 

  

• Confidence: set the value that the OCR engine must return for the zone to be considered as valid. The 
default value is 100. 

• Index: select which recognition zone should be used. When you have multiple zones on an image you 
can choose to use first, last or other. When you select other you can enter the number of the zone 
that must be used. 

• Select the Position on the page where the zone is located: top, left, right or bottom. 

• Set the minimum and maxim values for the Width and Height of the zone. 

• Click Next in case you want to configure the Format options. The Format options allow 
IRISPowerscan™ to search for specific words. 
To skip the Format options click Finish. 

• Select the Format in which the Label is typed: Bold, Italic, Subscript, Superscript or 
Underlined. 

• In the Label field select the word IRISPowerscan™ must search for. 

• In the Position list select where the Label is located on the page: Top, Left, Right or Bottom. 

 

• Work depth: the depth of the detection. The higher the value, the higher the precision. 

• Minimum height: use the slider to adjust the minimum line height in order to avoid bad OCR results. The 
Default value is 20 (in 1/100 of an inch). 

• In case the zone contains special characters, click the browse icon next to Character set and select Custom 
character set. 
Then add the special characters you need to recognize. 
Note that you can also leave out unnecessary characters. 
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• Options: 

• Select Remove spaces to remove spaces and tabulation characters by spaces. 

• Select Remove format to remove line breaks. 

Barcode Options 

• Condition: a condition can be added to the zone for blob filtering. See the information above at Text and 
Handprint Options. 

• Select the Barcode type. 
IRISPowerscan™ supports the following barcodes: Australian post, Australian post parcel, Aztec, Codabar, Code 
11, Code 16K, Code 25, Code 25 ni, Code 39, Code 39 Ext, Code 39 HIBC, Code 39 OOS, Code 93, Code 93 Ext, 
Code 128, Code 128 OOS, Code 128 GS1, Databar, Datamatrix, Datamatrix GS1, Deutsche Post Ident code, 
Deutsche Post Leitcode, EAN 13, EAN 8, EAN 14, I2OF5, Italian Post 25, IATA2OF5, ISBN, ISSN, ISMN, ITF 14, ITF 
6, Matrix 2 of 5, PDF 417, Micro PDF 417, Macro PDF 417, Compact PDF 417, One Code, OPC, Pharmacode, 
Planet, Postnet, Postnet 32, Postnet 52, Postnet 62, PZN, QR Code, Micro QR Code, RM4SCC (Royal Mail 4 
State Customer), SSC14, SSCC18, Standard 2OF5, SwissPostParcel, UCC128, UPCA, UPCE, MSI, MSI PH, VIN. 

Note: when using QR codes it is recommended to boost the Contrast level. Add Binarize as Image 
Processing operation. Then set its Contrast value to 90.  

Tip: in this case do not use the Contrast Brightness settings to boost the contrast. 

• For each Barcode type we can activate multiple alternatives. The alternatives are tested sequentially in a top 
down order. The search is stopped as soon as a barcode is found. 

 

Note: it is also possible to combine multiple barcode types within a single zone. 

• Work depth: the depth of the detection. The higher the value, the higher the precision. 

• Threshold: when the Full page option is not activated, the Threshold value is used to speed up the barcode 
recognition based on the contrast of the zone. If the density of the pixels is higher than the Threshold value 
then IRISPowerscan™ tries to decode the barcode. If it is lower, IRISPowerscan™ skips the barcode. 

• Select the Direction of the barcode: Any, Horizontal or Vertical. 

• Set the minimum and maximum values for the Length and Height of the barcodes. 

• Options: 

• Select Full page to have IRISPowerscan™ look for barcodes on the entire page. 

• Select Detect Orientation to detect in which direction the barcode is printed. 

• Select Partial detection to have IRISPowerscan™ recognize the barcode even if only part of it is 
detected. 

• Select Significant skew for IRISPowerscan™ to accept skewed barcodes. 

• Select Remove spaces to remove spaces and tabulation characters by spaces. 

• Select Remove format to remove line breaks. 

Patch Code Options 

• Select the Patch Code Type: IRISPowerscan™ supports Patch I, Patch II, Patch III, Patch IV, Patch VI, Patch T. 

• Work depth: the depth of the detection. The higher the value, the higher the precision. 
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• Options: 

• Select Detect Orientation to detect in which direction the patch code is printed. 

• Select Significant skew for IRISPowerscan™ to accept skewed patch codes. 

Checkmark Options 

WARNING: checkmark detection only works on binarized images. 

• Set the Minimum threshold. 

This is the percentage of the zone that must be filled in order for the zone to be considered as 
checkmark zone. The default Minimum threshold is 30 %. 

• Set the Maximum threshold. 

If the zone is filled more than the Maximum threshold, the zone will be considered as crossed out 
(cancelled), instead of checked. 

• Select Remove noise to have IRISPowerscan™ to remove noise pixels from the zone. 

• Click the plus sign to add a sample image. 

Adding a sample is recommended to increase the recognition accuracy. Without a sample, 
IRISPowerscan™ examines the entire data extraction zone (indicated in green). With a sample, the pixels 
that are taken into account are only those inside the actual checkmark (checkmark included). 

 

Tip: if you want to apply the same properties values (both thresholds, noise removal and sample image) to all 

checkmarks in a same group of Data Extraction, you can click on 'Apply to all checkmarks' icon . 

Anchor point (shape) Options 

WARNING: Anchor shapes detection only works on binarized images. 

An anchor point is made of the intersection of 2 lines. The various possibilities are the following: 

• Top left corner 

• Top right corner 

• Bottom left corner 

• Bottom right corner 

• Cross 

• Edge bottom 

• Edge left 

• Edge top 

• Edge right 

Note that you need at least 1, and ideally 4 or more anchor points on an image. 

Black squares are not supported as Anchor shapes. 
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WARNING: use the type Anchor point (shape) if your anchor points do not contain text. If they do contain text, use 
the type Anchor point (text). 

Options 

• Line length: minimum length of a line to be considered. 

• Line thickness: maximum thickness of a line to be considered. 

• Distance: minimum distance from the image border (in order to avoid detecting image borders as anchors.) 

• Shape: select the expected shape of the anchor point.  It increases the precision of its detection when multiple 
patterns are found in the same zone.. 

 

Anchor point (text) Options 

• Enter a Name for the Anchor point (text) zone. 

• Enter the Text the Anchor point (text) zone will contain. 
Note that this settings is optional and serves to improve the recognition result. 

• Select the Language of the zone. 
You can add an additional language by clicking the plus sign. 
Selecting the correct language is also crucial to obtain good recognition results. 

• Select the Work depth, i.e. the depth of the detection. The higher the value, the higher the precision. 

• Use the arrows to adjust the minimum line height in order to avoid bad OCR results. The Default value is 5 (in 
1/100 of an inch). 

• In case the zone contains special characters, click the browse icon next to Character set and select Custom 
character set. 
Then add the special characters you need to recognize. 
Note that you can also leave out unnecessary characters. 

9.2.3 Using Data Extraction as Identification method 

Below you find an example of how Data Extraction can be used as Identification method. 

• Scan at least one page. 

• Select the page in the Navigation tree. 

• Draw a frame around the content you want to use as Data Extraction zone. 

• Then click the Wizard icon in the top right corner of the zone. 
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• Select Page Identification as Action. 

Tip: as you can see, Data Extraction can also be used to separate Documents and Batches. 

 

• Click Finish. 
Next time IRISPowerscan™ detects the same content in the indicated area, the page will be identified. 
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9.3 Blank Page Detection 

Blank Page Detection is obviously used to detect blank pages. It can also be used to separate Document and Batch 
Types. 

To apply Blank Page Detection: 

• Add Blank Page Detection as Operation via the Wizard. 

• If you configured multiple Page Types, you can choose to apply the Blank Page Detection to one particular 
page type or to every page. Select the option of your choice. 

• Then go to Designer mode to configure the detection options: in the Designer Explorer, select Operations > 
Blank Page Detection on the correct level (the general level or a particular Page Type). 

WARNING: the Sensitivity and Size fields cannot be combined. You must use one or the other. 

• Sensitivity: the higher the value, the sooner IRISPowerscan™ detects speckles on the image. The 
lower the value the sooner a page is considered blank. 

• Size: set the size below which the image is considered blank. Note that the size of your sample 
page is indicated right below this field. 

Note: the variable Image.IsBlank is true if the image is blank. The variable Page.IsBlank is true only if both the front 
and rear images are blank. 
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9.4 Extract Color 

The Extract Color operation allows you to extract a color code from an image. The color code can be used in variables 
to separate documents: you can configure IRISPowerscan™ to start a new document each time the color code of a 
scanned image matches the color code of the sample image.  

  

To apply the Extract Color operation: 

• First add a sample image. 
The color code of this image will be used as reference. 

• Click Wizard > Add an operation > Extract Color. 

• In Designer Explorer, expand Operations and click Extract Color. 

 

• Click the Color picker icon  and click inside the sample image. 

• When the color code matches, the value changes from 0 to a value between 70 and 80. 

Note: if the value doesn't change, click a different element in the Designer Explorer and then return to Extract 
Color. 

• Click the Wizard icon to automatically detect the background color. 

 

• When you use the Color picker and the Wizard, the values of Tolerance, Hue, Min value and Min saturation 
change automatically based on the color you picked. 
You can also change them manually: 

• Tolerance: this is the precision to obtain the correct color. The smaller the value, the higher the 
precision. 

• Hue: enter a value, spin the wheel or select one of the color squares to change the hue. The hue is the 
property of light by which the color of an object is classified as red, blue, green, or yellow in reference 
to the spectrum.  
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• Min value: a high value limits the dropout to light colors. 

• Min saturation: A high value limits too intense colors. 

• Work depth: the depth of the detection. The higher the value, the higher the precision. 

  

To use a color code in a variable: 

• Enter Color.Matching>70 in any Condition field. 

 

Example of document separation based on color matching 
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9.5 Fingerprint detection 

The main feature to identify pages is Fingerprint Detection. By means of Fingerprint Detection, IRISPowerscan™ 
examines the layout of the scanned images. If the layout of a scanned page matches the layout of the sample you 
added to your project for your particular Page Type, then the scanned page will be considered as being of that page 
type. 

The easiest way to identify a Page Type, is to add the Page Type via the Wizard and apply Fingerprint detection. 

• Start the Wizard (F12). 

• Click Add a Page Type. Then click Next. 

• Name the Page Type. E.g. PageType1 in our example. 

• Browse for an image to use as sample. 

WARNING: if you select a page in the Navigation Explorer, you automatically add that page as sample. You 
cannot browse for another image. 

• Select Based on Fingerprint as Identification method. 

Tip: the condition used to apply Fingerprint detection is Image.Fingerprint == <YourPageType>. Switch to 
Designer mode and go to the configured Page Type to check it. 

 

• Click Finish. 

Next time you scan a page and its layout matches the one of the sample, it will be recognized as the page type you 
defined. 

WARNING: The Fingerprint engine requires black and white (binarized) images. If your sample image is in color, IPS 
creates a binarized image with the default settings ('auto threshold', not adaptive). Yet in the image processing 
operation, the default settings of the binarization are using adaptive binarization.  
For best results with Fingerprint, we recommend to use the same binarization for your sample images that the one 
you will use in your project.  
The easiest way is to scan some images with the binarization enabled and copy/paste these black and white images 
in the sample image. 

 

If sample image is in color, include first the binarize image processing 
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9.6 Swap front and rear 

This operation swaps front and rear sides. A front side will become a rear side and vice versa. 
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9.7 Reorder 

The Reorder operation serves as Debookletting feature. Instead of scanning two pages of a book at a time, remove the 
staples from the book and feed the entire batch of sheets into a duplex scanner. By means of the Reorder operation 
you can reorder the scanned pages in the right order. 

Pages may either be Landscape or Portrait oriented. 

Notes:  
The Debookletting feature only works on Document level. It is not possible to reorder pages across different 
documents and batches.  
The Debookletting feature only works on an even page count. 

This is the only use case in which the Reorder operation can be used. The Reorder tool on the Edit tab of the main 
toolbar however also has other functions. Click the link for more information. 

Requirements: 

• Paper sheets must be of A4 or A3 size. 

• Your scanner must scan in Duplex mode. 

WARNING: do not use the Debookletting feature in Simplex mode when using a real scanner, for this will not work. 
When scanning from folders, the Duplex mode is not required. 

• Split horizontally must be selected as Arrangement option in the Sources settings. 

 

To use the Reorder operation: 

• Start the Wizard (F12), select Add an operation > Reorder. 

• The Reorder section is added to the Designer Explorer. 

 

• Select Automatic if you will be scanning your pages in the right order. 

WARNING: in Automatic mode the reordering only occurs at the end of a document. This has implications for 
projects in which separators are used. In such projects the separator must be the first image that comes after the 
page arrangement. 
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• Select Cover first if the cover page will be fed to the scanner first. 

• Select Cover last if the cover page will be fed to the scanner last. 

 

Note: instead of using the Reorder operation you can also use the Reorder tool in the main toolbar. The same 
scanning requirements apply. 

• Select OCR based if your pages will not be scanned in the right order. 
In this case they can be reordered based on their page number: 

• Add one of your pages as Sample. 

• Create a Data Extraction zone around the page number. 

• Select the zone your created in the Zone drop-down list. 

 

• Scan your pages in Duplex mode. They should be reordered correctly. 

WARNING: the number of pages you scan in a batch must be even. An odd number of pages cannot be reordered 
correctly. 

For more information on the Debookletting feature, see the How To Guide. 



IRISPowerscan 10.5 – User Guide 

126 

9.8 Page Deletion 

In case you want to delete certain pages from your documents use Page Deletion. 

• Add Page Deletion as Operation via the Wizard. 

• If you configured multiple Page Types, you can choose to apply the Page Deletion to one particular page type 
or to every page. Select the option of your choice. 

• Go to Designer mode to configure the Page Deletion options: in the Designer Explorer, select Operations > 
Page Deletion on the correct level (the general level or a particular Page Type). 

• Select one of the suggested conditions from the Condition drop-down list. 

• Page.IsBlank: both the front and rear side of the page must be blank for the page to be deleted. 

• Image.IsBlank: the page will be deleted if the image is blank. 

• Image.IsBlank && Image.Rear: the page will be deleted if the Rear image is blank. 

• Image.IsBlank && !Image.Rear: the page will be deleted if the Front image is blank. 

 

• Or click the pencil icon to open the Expression Editor to build advanced expressions. 
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9.9 Blank Page Deletion 

In case you want to delete blank pages from your documents use Blank Page Deletion. 

• Add Blank Page Deletion as Operation via the Wizard. 

• If you configured multiple Page Types, you can choose to apply the Blank Page Deletion to one particular page 
type or to every page. Select the option of your choice. 

Note:  
The Condition Page.IsBlank is applied automatically.  
To check this, go to the Designer Explorer, select Operations > Page Deletion on the correct level (the general level 
or a particular Page Type). 
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9.10 Image Deletion 

Image Deletion functions in the same way as Page Deletion. 
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9.11 Blank Image Deletion 

Blank Image Deletion functions in the same way as Blank Page Deletion. 
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9.12 Page Attachment 

By means of the Page Attachment operation a page is flagged as "Attached" if the condition you configured is met. If 
the condition is not met, the page is considered "Not attached". 

By flagging pages as "Attached" you can for instance sort the images during export; you can send the pages that are 
attached to one destination, and the ones that are not to another destination. Or you can configure IRISPowerscan™ to 
consider all pages that follow an Attached page as appendices that do not require processing for example. Again, the 
possibilities are vast. 

Note: when sending documents to IRISXtract, pages that are flagged as attached in IRISPowerscan™ are also 
flagged as attached in IRISXtract. 

To use the Page Attachment operation: 

• Start the Wizard (F12), select Add an operation > Page Attachment. 

• The Page Attachment section is added to the Designer Explorer. 

• Enter a condition that must be met for the page to be considered attached. 

Example: suppose all images that do not contain a barcode must be considered Attached. The pages that 
do contain a barcode must not be Attached. In that case enter the condition 
IsNullOrEmpty(Image.Barcode) and make sure you have a data extraction zone that covers the barcode. 

Tip: you can also Attach and Detach pages using the Attach tool on the main toolbar. 
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9.13 Set Variable 

The Set Variable operation can be used to define your own variables. 

• Start the Wizard (F12), select Add an operation > Set Variable. 

• The Set Variable section is added to the Designer Explorer. 

 

• Enter a name for the variable in the Variable field. 

• Then enter the expression you want to use. 
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9.14 Set Counter 

The Set Counter operation is used to determine in which variable the counter will be stored, when the counter will be 
incremented and when it will be reset. 

• Start the Wizard (F12), select Add an operation > Set Counter. 

• The Set Counter section is added to the Designer Explorer. 

 

• Enter a name for the variable in the Variable field. 

E.g. MyCounter. The counter will be stored in this variable. 

• Specify a boolean Condition. 

E.g. Image.IsBlank. This way the counter will be incremented when the current image is blank. 

• Set the value of the counter. The default value is 0. 

• Determine when the counter must be reset: Never, Every day or Every batch. 
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9.15 Batch Naming 

This operation allows you to rename batches. 

• Start the Wizard (F12), select Add an operation > Batch naming. 

• The Batch naming section is added to the Designer Explorer. 

• Click the pencil icon next to Condition to configure a condition. 

• Click the pencil icon next to Name to configure the naming options. 

• If the condition is met, the batch will be renamed. 

Example:  

• Enter Page.Index>2 as Condition. 

• Enter "Batch "+Batch.Index+"("+Page.index+")" as Name. 

 

• Scan a number of images. 

• The batch will be renamed based on the index. 
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9.16 Batch Separation 

This operation allows you to separate batches. 

• Before you start, make sure you have created different Batch types. 

• In Designer explorer, right-click Operations and click Create. 

• Select Batch separation and click Next. 

• Now select the Batch type you want IRISPowerscan™ to create, and then click Finish. 

• Click the pencil icon next to Condition to configure a condition. 

• Each time the condition is met, a batch of the type you selected will be created. 

Example: 

• Create a new Batch type "New Batch". 

• Follow the steps above. 

• Enter Page.Index>4 as Condition. 

• Scan at least 5 images. 
IRISPowerscan™ starts a new batch after the fourth image. 

Note: the Batch naming, Batch separation and Batch identification operations can be combined of course. 
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9.17 Batch Identification 

This operation allows you to change batch types into other batch types. 

• Before you start, make sure you have created different Batch types. 

• In Designer explorer, right-click Operations and click Create. 

• Select Batch identification and click Next. 

• Now select the Batch type to which a batch must be changed if the condition is met, and then click Finish. 

• Click the pencil icon next to Condition to configure a condition. 

• Each time the condition is met, the type of the current batch is changed into the one you selected. 
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9.18 Document Naming 

This operation allows you to rename documents. 

• Start the Wizard (F12), select Add an operation > Document naming. 

• The Document naming section is added to the Designer Explorer. 

• Click the pencil icon next to Condition to configure a condition. 

• Click the pencil icon next to Name to configure the naming options. 

• If the condition is met, the document will be renamed. 

Tip: see Batch Naming for an example. 



IRISPowerscan 10.5 – User Guide 

137 

9.19 Document Separation 

This operation allows you to separate documents. 

• Before you start, make sure you have created different Document types. 

• In Designer explorer, right-click Operations and click Create. 

• Select Document separation and click Next. 

• Now select the Document type you want IRISPowerscan™ to create, and then click Finish. 

• Click the pencil icon next to Condition to configure a condition. 

• Each time the condition is met, a document of the type you selected will be created. 

Example: 

• Create a new Document type "New Document". 

• Follow the steps above. 

• Enter Page.Index>4 as Condition. 

• Scan at least 5 images. 
IRISPowerscan™ starts a new document after the fourth image. 

Note: the Document naming, Document separation and Document identification operations can be combined of 
course. 
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9.20 Document Identification 

This operation allows you to change document types into other document types. 

• Before you start, make sure you have created different Document types. 

• In Designer explorer, right-click Operations and click Create. 

• Select Document identification and click Next. 

• Now select the Document type to which a document must be changed if the condition is met, and then click 
Finish. 

• Click the pencil icon next to Condition to configure a condition. 

• Each time the condition is met, the type of the current document is changed into the one you selected. 
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10. Identification of Pages 

As already mentioned previously in this documentation, one of the great novelties of IRISPowerscan 10 is its ability to 
uniquely identify pages. By uniquely identifying pages, you can apply operations (like image processing, data 
extraction, page deletion, etc.) only to the pages where they are required, which increases the processing speed of 
IRISPowerscan™. 

The main feature to identify pages is Fingerprint Detection. By means of Fingerprint Detection, IRISPowerscan™ 
examines the layout of the scanned images. If the layout of a scanned page matches the layout of the sample you 
added to your project for your particular Page Type, then the scanned page will be considered as being of that page 
type. 

Note however that you can also use other operations such as Data Extraction, Blank Page Detection, etc. to identify 
Page Types. 

In fact, any Condition can be used as page identification method. A few examples are given below. 

Identification Conditions Examples 

To apply page identification conditions: 

• Switch to Designer mode. 

• Go to a Page Type you want to configure (or create it if necessary). 

• Next to the Condition field, click the Expression Editor ( ) 

• Select a Variable from the list, then select an Operator and if necessary enter a Value. 
For instance: 

If a Page Type only contains color images: Image.IsColor (for 24bit images) and Image.IsTrueColor (for 
32bit images) 

If a Page Type exceeds a certain width: Image.Width > <YourWidth> 

If a Page Types exceeds a certain amount of bits per pixel: Image.Bpp > <NumberOfPixels> 

Needless to say, these are only a few examples as the possibilities are extremely vast. Also see Using Expressions. 

Once Page Types have been defined they can also be used to separate Document Types. 
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11. Separation of Documents and Batches 

IRISPowerscan™ classifies each stream of images/scans into a logical Batch > Document > Page structure. By default, 
you have 1 batch type, 1 document type and 1 page type. All pages you scan are added to the same document type. 

By adding document and batch types you can customize IRISPowerscan™ to fit the structure of your scans. You can also 
choose to apply certain operations only to certain document or batch types. 

Adding Document Types via the Wizard 

This is the easiest way to add Document Types. 

• Start the Wizard (F12). 

• Click Add a Document Type. Then click Next. 

• Name the Document Type. 

• Select the separation method: 

• None: IRISPowerscan™ doesn't carry out any document separation when it encounters this document 
type. 

• Based on page count: IRISPowerscan™ starts a new document after the indicated number of pages. 

• Based on blank pages: IRISPowerscan™ starts a new document every time it encounters a blank page. 

• Based on page type: IRISPowerscan™ starts a new document every time it encounters the selected 
page type. This option is only available if you have defined at least two page types. See the previous 
section Add a Page Type. 

• Based on Data Extraction IRISPowerscan™ examines the data extraction zones you have defined on 
your pages. If the content of the extraction zones matches the one you have defined, IRISPowerscan™ 
starts a new document. 

• Delete first page: this option is available when you selected Based on blank pages or Based on Data 
Extraction. It deletes the first page of the batch. 

• Complete the Wizard as explained in Add a Document Type. 

Creating Document Types manually in Designer mode 

• Switch to Designer mode. 

• Right-click Documents in the Designer Explorer and click Create. 

• Enter a Name and Description for the Document Type. 

• Configure the Naming Options as explained in Add a Document Type or click the pencil icon to open the 
Expression Editor to configure more complex naming options. 

• Configure the Condition manually by means of the Wizard or Expression Editor to define when 
IRISPowerscan™ needs to start this new Document Type. 

Tips: 
To reproduce the input document structure, use Input.PageIndex as Condition. 
To give your files the name of the input files, use one of the GetName functions: 
GetFileNameWithoutExtensions(Input.Path) or GetFileName(Input.Path). 

• Confidence: indicate a Confidence level between 1 (very low) and 100 (very high). If the recognition accuracy is 
not met for any child of the document, the entire document will be flagged as inaccurate and must be 
corrected manually. 



IRISPowerscan 10.5 – User Guide 

141 

IRISPowerscan™ always computes a confidence level for Data Extraction zones, Pages, Documents and 
Batches. In the Confidence field you can decide whether the Confidence level should be taken into 
account or not. 

The Confidence level of a Page is the minimum Confidence level of the Data Extraction zones defined on 
that Page. 

The Confidence level of a Document is the minimum Confidence level of its underlying Pages. 

The Confidence level of a Batch is the minimum Confidence level of its underlying Documents. 

If you enter 0 (default value) as Confidence value, then the Confidence level will not be taken into 
account. 

Tip: the Confidence level is displayed in the Tooltip of each Page, Document and Batch in the 
Navigation tree and also in the Tooltip of each Data Extraction zone. 

       

 

• Counter: By default IRISPowerscan™ starts counting from 1 at every batch and document. This number can be 
changed by entering another value or clicking the arrows. 

• Reset document counter on new batch: when this option is selected, IRISPowerscan™ resets the 
counter to the specified value on a new batch. 

• Delete first page: select this option in case you want to delete the first page of each new document. 

• Default document type: select this option to select this document type as default document type. 

The same instructions apply to separate Batch Types. 

Also see the next topic to see an example of how Page Type identification can be used to separate documents. 
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11.1 Example of Document Separation 

In this example all our documents have the following structure: each document consists of a cover page, multiple body 
text pages, and an appendix containing schematics. Each of these three elements has a distinctive layout so we use 
Fingerprint detection to identify each Page Type. 

Then we use the Page Type to create three corresponding Document Types (Cover, Body and Appendix). 

Finally we create a separate Output Type for each Document Type. The Cover will be converted to PDF, the Body to 
Word, and the Appendix to Multipage Tiff on which no recognition is done. 

Step 1: Create three Page Types: Cover, Body and Appendix by means of the Wizard 

• Start the Wizard and click Add a page type. 

• Name it "Cover". 

• Add a sample image of a cover page. 

• Select Based on Fingerprint as Identification method. 

• Do the same for the other two Page Types. 

Step 2: Create the three corresponding Document Types by means of the Wizard 

• Start the Wizard and click Add a document type. 

• Also name it "Cover'. 

• Select Based on page type as Separation method. 

• Complete the Wizard, and then do the same for the other two Page Types. 

Step 3: Create the three corresponding Output Types by means of the Wizard 

• Start the Wizard and click Add an output type. 

• In our example name the Output "Cover" and select PDF as Format. 

• Select a Color Filter. 

• Then select This output will be applied to one particular document type. 

• Select "Cover" as document type. 

• Select a Folder as Destination. 

• Complete the Wizard, and then do the same for the other two Output Types. 

Step 4: Scan and Process your documents 

• When you scan your documents, IRISPowerscan™ creates the three document types you configured. 

 

• When your process the documents, separate output files will be created for each document type. 
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12. Checking and Rearranging Scanned Documents 

Once documents have been scanned into a project they are displayed in Navigation mode. 

 

  

12.1 Checking Scanned Documents 

Multi-stream images 

If your scanner generates multi-stream images - meaning a color, black-and-white and/or grayscale version of the same 
scan - the multi-stream images are also maintained in IRISPowerscan™. 

Click a document to view the underlying pages. Pages that contain multi-stream images are indicated by slight shadow 
underneath them. 

 

To switch between the different streams: 

• Click the View tab and click the down arrow beneath Show. 

• Then select the required stream. 

 

Duplex images 

If you are using a duplex scanner and the Duplex function is activated in IRISPowerscan™, IRISPowerscan™ alternates 
between Front sides and Rear sides correctly. 
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In case sides must be swapped: 

• Ctrl-click the Front and Rear side you want to swap. 

• Click the down arrow beneath Reorder and click Swap sides. 

 

Note that it is now possible to select multiple pages simultaneously and swap sides. See Reorder Documents below. 

12.2 Rearranging Scanned Documents 

Scanned documents can be rearranged in several ways in Navigation mode: 

• Rearrange them in the Navigation Explorer. 

• Rearrange them in the Viewer. 

• Use the Navigation bar for easy navigation. 

Pages can be moved to different documents and batches. Documents can be moved to different batches. And batches 
can be switched from position. 

Note however that the structure batch > document > page must always be maintained. 

The following operations are available both in the Navigation Explorer and in the Viewer: 

• Drag-and-drop 

• Cut-and-paste 

• Split and Merge 

• Reorder elements 

• Manually create new batches and documents 

• Rotate Pages 

You can also: 

• Crop pages 

• Fill up parts of scanned pages, in case of confidential information for instance. 

Drag-and-Drop documents 

The batches, documents and pages can be dragged and dropped to other positions, both in the Navigation Explorer and 
in the Viewer. 
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Cut, Copy and Paste documents 

The batches, documents and pages can also be moved to another position by means of Cut and Paste. 

• Right-click the element you want to move, and click Cut or Copy. 

• Point the cursor to the position where you want to paste the element, and click Paste. 

Split and Merge documents 

Batches and Documents can also be split or merged with neighboring batches and documents respectively. 

To split a batch/document: 

• Select it and click Split on the Edit tab. 

• Or right-click it and select Split. 

To merge batches/documents: 

• Select the batch/document you want to merge with the next batch/document, and click Merge on the Edit 
tab. 

• Or right-click it and select Merge. 

Reorder elements 

Reorder 

The Reorder tool allows you to reorder the scanned documents. 

Note however that the first two commands - Cover first and Cover last - should only be used to reorder images that 
were scanned in Debookletting mode. See Operations > Reorder for more information. 

Reverse order 

To reverse the order of all scanned pages: 

• Click Reverse order. 

Note that this only works on Document level. Only the order of pages inside a single document will be reversed. 

Swap sides 

The Swap sides command allows you to swap pages and flip their sides. 

To swap pages from position, you need to select a pair number of pages. 

Example: 

When you select pages 1 to 4, page 1 and page 2 are swapped from position and page 3 and 4 are swapped from 
position. Their sides are also swapped, meaning Front becomes rear and vice versa. 

Note: if you select 5 pages, the fifth page will not change position, but its side will simply be flipped. 

Tip: hover the cursor over a page to check whether it is a Front or Rear side. 
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Note: you can select multiple pages across different documents and batches. Note however that the pages and 
sides stay within their original document and batch. They are not moved from one document or batch to another. 

In case you only want to flip the side of a page, then select a single page and click Swap sides. You'll notice that a Front 
becomes a Rear and vice versa. This needs to be done page per page. 

Tip: to undo any unwanted changes use Ctrl-Z. 

Manually create a new batch/document 

• Point the cursor to the position where you want to create a new batch/document. 

Note: new batches are always inserted at the end of the previous batch, not in the middle of documents. 

• Click the down arrow beneath Create on the Edit tab. 

 

• Select Batch or Document. 

• Name the Batch / Document. 

• Start scanning is selected by default. 
When the new Batch / Document is created IRISPowerscan™ automatically starts scanning. 

Rotate pages 

• Select a page you want to rotate. 

• Click the View tab and select one of the rotation options. 

Crop pages 

• Select a page you want to crop. 

• Draw a frame around the area to which you want to crop the page. 

• On the View tab, click Crop. 

Fill pages 

• Select a page on which you want to cover up certain parts. 

• Draw a frame around the area you want to cover up. 

• On the View tab, click the down arrow below Fill to select a fill color. 

• Then click Fill. 
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13. Indexing Scanned Documents 

IRISPowerscan™ is a powerful indexing solution. It allows you to define index fields on batch, document and page level. 
If you have defined multiple batch or document types, you can also create specific index fields for those types. 

The indexing values can be extracted directly from the scanned documents, based on Data Extraction elements such as 
OCR zones, barcode zones and ICR zones. The purpose of having powerful indexing features after all is not having to fill 
them in manually and/or to define strict validation criteria. 

When index fields are filled in automatically by IRISPowerscan™, you can choose to have the user validate them, or 
automate the index validation. In the latter case no user intervention is required. (See Processing Documents in 
IRISPowerscan 10). 

In IRISPowerscan™ you can also link index fields to external ODBC databases, like Microsoft Access. That way you can 
have a list of values to choose from when filling in index fields. 

The index fields you create in IRISPowerscan™ can be mapped to the index fields you already use in your DMS or Cloud 
system. That way you can export fully-indexed documents from IRISPowerscan™. 

In this chapter we explain how to: 

• Create Index Fields 

• Link Data Extraction Zones to Index Fields 

• Use Confidence Levels on Index Zones 

• Map IRISPowerscan™ index fields to the index fields in your DMS / Cloud System 

• Use a Data Source 

• Validate Index Fields 
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13.1 Creating Index Fields 

As of IRISPowerscan 10.4 index fields can only be created in Designer mode. 

Creating Index Fields in Designer mode 

• Open a project. 

• Switch to Designer mode. 

• Determine on which level, and for which Batch/Document/Page type to create index fields. 

• Right-click Fields, and click Create. 

 

13.1.1 Index Field Options 

When adding an index field you can define the following options: 

Name: enter a name that is meaningful to you. 

Label: the label identifies the index field. The label is the name of the field as it appears in the interface. 

Description: enter a description that is meaningful to you. 

Type: select one of the types from the list. The following index field types are available: 

• String: text string 

• Boolean: yes or no 

• Integer: integer number 

• Double: decimal value 

• Number: number with or without decimal. Click the pencil to access its options. 

• Currency: monetary value. Click the pencil to access its options. 

• Percentage: percentage value. Click the pencil to access its options 

• DateTime: time value. Click the pencil to access its options. 

• TableField: allows you to create line item fields. 

In order to recognize line items, IRISPowerscan™ requires 3 essential elements: the quantity, the unit price and 
the total price. The quantity multiplied by the unit price must be equal to the total price. 

• Click the plus sign to add a Table Field. 

• All the field types listed above are available as Table Field. 

Value: this expression defines which value is filled in in the index field by default. 
Example: suppose you created an extraction zone called "Zone1." If you select the variable Image.Zone1, then the 
content of that zone will be filled in in the index field. 

Tip:  
To extract a value on a particular page, you can use the ternary operator. E.g. ?(Page.Index==2, Image.Zone1, ""). 
This extracts a value on Page 2.  
In case you want to extract only certain words from an OCR zone, you can use the SubString or SubStrings functions 
combined with Blob filtering. E.g. SubString(Image.Zone3, "AA9". In this case only two letters followed by 1 digit 
will be kept. 
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Condition: this boolean expression defines the validity of the index field. 
Example: the Field variable contains the value of the current index field. As condition you can use Field == "abc" or ! 
IsNullOrEmpty(Field). The index field will only be valid if it contains "abc" or if its content is not empty. 

Format: this expression is computed each time the field is manually edited by the user to adjust the content of the 
index field. 

Tip: click here for more information about the Expression Editor. 

Options: 

• Overwrite: when selected, this option re-evaluates the default value even if the field already has a value. This 
could be useful to evaluate an expression on every page. 

• Read Only: field is visible but user cannot edit it. 

• Hidden: this option hides the index field in Navigation mode. Select this option when the index field is not 
meant to be validated. 

• History: this option shows the last five values entered in the index field when you click the field's drop-down 
list. 

WARNING: the History option is not available if you choose to display more than one line as Display option 
(below). 

Display: 

The Display options vary depending on the Type you select. 

• x Line(s): determines how many lines are displayed. 

WARNING: if you choose to display more than one line, the History option (above) will not be available. 

Data Source: by adding a Data Source via the Wizard you can link the index fields in IRISPowerscan™ to a list or 
predefined values or to an external ODBC database, like Microsoft Access. 

• Multi values: when you select this option the index field may contain one or multiple values. 

• Read only data source: when you select this option, IRISPowerscan™ only takes the values from the data 
source into account. 

  

When you have defined the settings of the different index fields you must link them to Data Extraction zones on the 
scanned documents. Otherwise the index fields cannot be filled in automatically. 
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13.2 Linking Data Extraction Zones to Index Fields 

The content of data extraction zone can be filled in in index fields. In order to do that, you must first create at least one 
Data Extraction zone and link it to an index field. 

• Create a Data Extraction zone as described in Data Extraction. 

WARNING: make sure to Capture ( ) the data extraction zone before trying to link it. If you don't capture 
the zone, it is only a temporary zone. Its contents will be filled in in the index field but it is not linked to the 
index field. 

• Drag the paperclip icon from the zone to the content of the index field you want to link it to. 
By default there is 1 index field on Batch level and 1 index field on Document level. 

Tip: you can also drag the paperclip icon to the Document / Batches pane directly, to create a new index 
field and link the zone to it immediately. 

 

• When the zone is linked to the index field, the index field is filled in. 

 

Tip: right-click the index field name and click Properties. Notice that Image.<YourZone> is now used as 
Value. 

 

In Designer mode 

• Switch to Designer mode. 

• Expand a Document/Batch type in the Designer Explorer. 

• Expand fields. 

• Then click an existing field or create a new one. 

• Click the down-arrow to see the list of available values. 

Note: if there are no data extraction zones in your project, the list will be unavailable. 
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13.3 Using Confidence Levels on Index Fields 

IRISPowerscan™ always computes a confidence level for Data Extraction zones. The Confidence level is shown in the 
Tooltip of the Data Extraction Zone. 

 

When Data Extraction Zones are linked to Index Fields, you can apply a Confidence Condition to the Index Field. This 
means that if the confidence in the recognition accuracy is below an indicated level, the Index Field will be flagged as 
inaccurate. 

Note: the Data Extraction Zones must be of the type Text, Hand-Print or Barcode. 

To use a confidence level on an Index field: 

• Create a Data Extraction zone of the type Text, Hand-Print or Barcode. E.g. Zone1. 

• Link it to the default Index field Field1 of the default Document type. 
To do so, enter Image.Zone1 as Value. 

• Then enter the Confidence Condition. 
In our example Image.Zone1.Confidence>50. 
In this case the field will be flagged as inaccurate if the confidence level of the Data Extraction Zone 
Image.Zone1 is below 50. 
The confidence value must be an integer between 1 (very low confidence) and 100 (very high confidence). 

 

• The Document and Batch containing the inaccurate index field will also be flagged as inaccurate and will 
require validation. 

• Do the Validation and modify the results if necessary. 

Note however that the color of the index field does not change, even when you have corrected it. 

Note that confidence levels can also be applied on Page, Document, and Batch level.  

The confidence level of a page is stored in the variables: 

• Page.Confidence 

• <Page.Type>.Confidence 
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The confidence level of a document is stored in variables: 

• Document.Confidence 

• <Document.Type>.Confidence 

The confidence level of a batch is stored in variables: 

• Batch.Confidence 

• <Batch.Type>.Confidence 
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13.4 Mapping IRISPowerscan™ index fields to DMS / Cloud System Fields 

The index fields you create in IRISPowerscan™ can be mapped very easily to any index fields you might already use in 
our Document Management or Cloud System. This way IRISPowerscan™ can export fully-indexed documents. 

To map index fields: 

• Switch to Designer mode. 

• Expand Outputs in the Designer Explorer. 

• Select the OutputType you configured, or add a new one by right-clicking Outputs and selecting Create. 

 

• If you already configured a DMS or Cloud system as Destination, click the settings icon to access it settings. 

• If you have not configured a destination yet, click the plus sign to add a destination. 

 

• Enter or confirm the Server, User Name and Password. 

• Specify the exact destination, and click Next until you reach the field mapping window. 

Note: the steps you go through differ depending on the DMS / Cloud system. 

• The list of index fields that are used in your Destination system are displayed. 

• Select a field you want to map to an IRISPowerscan™ index field. 

• Click the down arrow at the right, and select to which IRISPowerscan™ field to map it. 

 

• Repeat these steps for all the fields you want to map, and then click Finish. 

Note: if you use the Wizard to create a new project and you select a DMS destination, the index fields are created 
automatically to reflect the available fields in the DMS. The mapping between the IRISPowerscan™ index fields and 
the DMS index fields is also defined automatically. 
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13.5 Using a Data Source 

By adding a Data Source via the Wizard you can link the index fields in IRISPowerscan™ to a list of values or to an 
external ODBC database, like Microsoft Access. 

  

WARNING: It is highly recommended to limit the number of items to 10000 in the data sources. In addition, in 
order to work smoothly with drop down lists in the Navigation mode (cf. Dependent fields below), the number of 
items should not exceed 1000.  

  

Below we explain how to add a Microsoft Access database as data source. Our example database contains one table 
and four columns. 

 

Adding a Data Source using the Wizard 

• Start the Wizard (F12). 

• Select Add a data source. Then click Next. 

• Enter a Name that is meaningful to you. 

• Select the Source of the Data Source - list, odbc or excel - and click Next. 

• The Data Source is now added to the Designer tree. 

Switch to Designer mode to continue configuring it. 

Configuring the Data Source in Designer mode 

• Click Data sources in the Designer Explorer. 

• Select the Data source you added. 

ODBC 

• Select an example Connection string from the drop-down list. 

 

• Enter a correct SQL command, and click Test to test the connection. 

• The Rows option at the bottom allows you to indicate how many rows may be retrieved. 
The standard value is 0, which means the number of rows is unlimited. 
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List 

• Type in the values manually and press Enter after each value. 

 

Excel 

• Enter the Path to the Excel data source file, or click the browse button to browse for it. 
You can choose to use an absolute or relative path. 

Note: the Excel data source file is not copied to the project folder. 

 

• In the Sheet drop-down list select the worksheet you want to use. 

• In the Key drop-down list, select the column of which you want to use the values. 

• If your Excel file is made up of a Key column - which contains article codes for instance - and a Label 
column - which contains the article descriptions, also select the latter column in the Label drop-down 
list.  
In the example below, column B is the Key column, while column C is the Label column. 

 

Example Excel file 

• The values of the Key column and Label column are displayed in the Values field. 
Click Test to test the values. 
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• In case you do not want all values displayed you can apply a Filter. 
Select which column you want to use as Filter. Then enter a value in the Equals field. In the example 
above, only the lines for which there is an "X" in the "I" column will be displayed. 

When you are done, link the Database to your index fields. 

  

Linking the Data source to an index field 

• Create index fields on the required level: page, document or batch. 

• Click the down arrow next to the Data source field, and select the data source you created. 

 

• A drop-down list is now available in the selected index fields, from which you can select the Data source 
values. 

Note: when you are using an Excel data source, use the Data source name to display the values of Key 
column or add ":0:1" to the Data source name to display the values of the Label column. 

• When scanning documents, the fields from the database are available as index field in IRISPowerscan™. 
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13.5.1 Creating Dependent Fields when using an ODBC Data Source 

When using an ODBC Data Source you can create Dependent Fields in IRISPowerscan™. This way, when the content of 
a field is modified, the content of the fields that depend on it will be modified automatically. 

Hereunder we give an example of how to create dependent fields. 

• Create an Access Database with the following content: 
In our example the Database is named Database1. 

 

• Go to Control Panel > Administrative Tools > Data Sources (ODBC). 

WARNING: when using a 64-bit Operating System, start Data Sources (ODBC) from 

C:\Windows\SysWOW64\odbcad32.exe. 

• Click the System DSN tab and click Add. 

• Select Microsoft Access Driver (*.mdb, *.accdb) and click Finish. 

• In IRISPowerscan™ create four Index fields of the type String on Document level. 

See Creating Index Fields if necessary. 

 

• Add a Data Source of the type ODBC as described above (13.5). 

• Click the down arrow in the Connection string list and select the Database you created. (DataBase1 in our 
example). 

 

• Enter the following SQL command: "SELECT Value1, Value2 FROM Table1 WHERE Value3 = '" + 
Document.Field1 + "'" 

• Click Test to test the expression. 
This expression uses Field1 of the document type Document. 

• In Field2 we will display the second column of the Database: 

• In Designer mode, go to Documents > Document > Fields > Field2. 

• Type "DataSource1:1" in the Data source field. 
:1 stands for the second column of the Data source named "DataSource1". 
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• Now we link Field3 to Field2. Field3 will become a dependent field of Field2 and its value will be updated when 
the value of Field2 is updated. 
To do so: 

• In Designer mode, go to Documents > Document > Fields > Field3. 

• Enter the following value in the Value field: $(Document.Field2, 0) 
Field3 is now linked to the first column of the DataSource of Field2. 

Tip: to link Field3 to a different column - let's say column 2 - replace $(Document.Field2, 0) by 
$(Document.Field2, 1) 

• In Field4 we will use key/value pairs. The keys will be stored and exported. The values will be displayed. 
To do so: 

• In Designer mode, go to Documents > Document > Fields > Field4. 

• Enter the following value in the Value field: DataSource1:0:1. 
This means the keys are in the first column and the values are in the second column. 

  

To check the results: 

• Scan the samples from the default Folders source: System.InputDirectory. 

• Select Document 1 in the Navigation tree. 
The Index fields are now empty. 

 

• Now enter a value in Field1: either AAA or BBB (as in the Database we created). 
The lists of Field2 and Field3 are now updated and contain values. 

 

• Now select a value from the list in Field2. 
The value of Field3 (the dependent field) will be updated. 

• Select Indexes.xml as Output Format, and click Process to check how the values are exported. 

 

13.5.2 Creating Dependent Fields when using a List Data Source 

When using a List Data Source you can create dependent fields using the Dependency operator. 

Below you'll find an example of how to create such dependent fields. 

• Add a Data Source of the type List as described above (13.5). 

• Go to Designer > Data sources > DataSource1. 
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• Create two columns of Values. 
In our example: 
100;BXL 
200;NLE 
300;LUX 

• Create two Index fields of the type String on Document level. 

See Creating Index Fields if necessary. 

 

• Now link the first index field to the Data Source: 

• Select the field in the Designer tree. 

• Click the down arrow next to the Data source field and select the Data source you created. 

• Add :0:1 to the name of the Data source. ":0:1" means the following: 

• The value in the first column (index=0) will be stored. 

• The value in the second column (index=1) will be displayed. 

 

• Now go to the second index field you created, and enter the following Value: Dependency(Document.Field, 
"Document.Field[0]") or $(Document.Field, "Document.Field[0]") 

 

• The index field Subfolder is now dependent on Document.Field. 
The value of the field Subfolder will be the first column of Document.Field. 
And the value of SubFolder is updated as soon as the value of Document.Field is changed. 
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13.6 Validating Index Fields 

When index fields have been linked to data extraction zones or mapped to input Cloud systems in the right way, they 
are filled in automatically during scanning in IRISPowerscan™ and they are ready for validation. 

WARNING: when processing invoices, the validation is done in Web Verify, and cannot be done directly in 
IRISPowerscan™. 

 

Example index fields in Navigation mode 

• Correct values are marked in white. 

• Manually modified fields are marked in yellow. 

• Invalid values are marked in red. 

To switch between index fields: 

• Press the Tab key to go to the next index field. 

• Press Shift + Tab to go to the previous field. 

To switch between the different invalid index fields: 

• Click the backward/forward buttons. 

 

To modify an index field: 

• Manually type in a new value. 

• Use drag and drop OCR: click inside the index field, then draw a data extraction zone on the image in the 
Viewer. 
The content of the zone will be filled in in the index field. 

Tip: to concatenate several values into the same index field, press and hold on the Ctrl key and use drag 
and drop OCR as many times as needed..  
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• Use the Double-click Text Selector: click inside the index field, then double-click a word in the image to add to 
the index field. Or Ctrl-double-click to enter an entire line of text. 

 

• Click the down arrow next to the index field and select one of the values. 
IRISPowerscan™ remembers the 5 values that were last entered. 

Note: the values in the drop-down list may also come from a Data source (in case you configured one). 

To undo/redo operations: 

• Use the undo/redo arrows on the Quick Access toolbar. 

To validate an index field: 

• Press F8. Pressing F8 or selecting Validate when right-clicking on the label of the field will force the validation 
of an incorrect value marked in red. The field is then marked green as the pre-defined rules are overridden. 
Attention, after using F8, the validation cannot be undone.  
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14. Configuring the Output 

IRISPowerscan™ converts scanned documents into a wide range of output formats and can send them to many possible 
destinations. 

The Output can be selected either when creating a project or in Designer mode. 

Accessing the Output settings in Designer mode 

• Switch to Designer mode. 

• In the Designer Explorer, expand Outputs, and select the OutputType you want to configure. 

• To add a new OutputType, right-click Outputs and click Create. 

 

Note: as you can see in the image, you can also apply Operations to specific output configurations. This works in 
the same way as adding Operations on general, page, document and batch level, except that you cannot use the 
Wizard. 

Output Options 

Name 

Enter a name for the OutputType. 

Condition 

If necessary you can apply conditions to the OutputType. 

Example: 

Suppose you defined multiple Document Types inside a project. In that case you can choose to export only a 
certain document type in a certain output format. Let's say the document type "Body" contains the text you 
want to convert to compressed text-searchable PDF. And the document type "Appendices" only contains images 
you want to save as TIFF files. In that case use a condition that says the Document.Type must equal "Body": 

• Click the Wizard icon next to Condition. 

• Select the Filter: Color, Grayscale, Black and white, Automatic, Front and Rear. 

• Select "Color" in our example. 

 

• Choose to apply the condition to one particular document type, and click Next. 

• Select the document type. "Body" in our example. 

• Click Finish. 
The following condition is added to the Condition field: Image.IsColor && Document.Type == "Body" 

• Now do the same for the document type Appendix. 
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Naming 

Determine how the output documents must named. 

You can either type in a fixed name between quotation marks and add a counter or click the Wizard icon to create a 
Naming formula. 

WARNING: it is recommended to add a counter to the Naming options. Otherwise IRISPowerscan™ might 
overwrite the files that are already in the destination folder. 

 

Prefix: enter a prefix that must be added in front of each output document name. 

Add field: the content of data extraction zones can also be added to the name. 

Note: in order to add a zone, you must have created at least one data extraction zone inside your project. 

Add date: select the date format you want to add from the list. 

Add time: select the time format you want to add from the list. 

Delimiter: select by which delimiter the different parts of the name must be separated. 

Format 

Select the required Format from the list. Then click the pencil to determine its settings. 

Destination 

Click the plus sign to add a Destination. 
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14.1 Select the Output Format 

1. PDF 

• Select PDF from the list. 

• Click the pencil icon to access the options. 

 

Generalities tab 

Type 

Image 

This type of PDF file contains the scanned image. It does not contain recognized text. You cannot search for text inside 
this file type. 

ImageText 

This file type is most commonly used. It contains two layers: the recognized text, and the original image on top of the 
text. This way, you have both access to the recognized text and you still see the original image. Another advantage of 
ImageText files is that they can be indexed by a file system such that a file search can find files containing the search 
text, in addition to finding files by the name of the file. 

TextImage 

This file type is the opposite of PDF Image-Text. It contains the original image in the background, and the recognized 
text on top of the image. 

Text 

This file type contains the recognized text, but does not contain the original image of your document. Any images in the 
original document are included as graphics in the PDF file. 

Version 

Select which PDF Version you want to generate: 

• 1.4: Adobe Acrobat 5.0 or higher is required to open these PDF files. 

• 1.4.A1a: this is a constrained form of Adobe PDF version 1.4 intended to be suitable for long-term preservation 
of page-oriented documents for which PDF is already being used in practice.  Level A conformance (PDF/A-1a) 
indicates complete compliance with the ISO 19005-1 requirements, including those related to structural and 
semantic properties of documents. 
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• 1.4.A1b: this is also a constrained form of Adobe PDF version 1.4 intended to be suitable for long-term 
preservation of page-oriented documents for which PDF is already being used in practice. Level B conformance 
(PDF/A-1b) indicates minimal compliance to ensure that the rendered visual appearance of a conforming file is 
preservable over the long term. 

• 1.5: Adobe Acrobat 6.0 or higher is required to open these PDF files. 

• 1.6: Adobe Acrobat 7.0 or higher is required to open these PDF files. 

• 1.7: Adobe Acrobat 8.0 or higher is required to open these PDF files. 

• 1.7-A2a: this is a constrained form of Adobe PDF version 1.7 intended to be suitable for long-term preservation 
of page-oriented documents for which PDF is already being used in practice. Level A conformance (PDF/A-2a) 
indicates complete compliance with the ISO 19005-2 requirements, including those related to structural and 
semantic properties of documents. 

• 1.7-A2b: this is a also constrained form of Adobe PDF version 1.7 intended to be suitable for long-term 
preservation of page-oriented documents for which PDF is already being used in practice.  Level B 
conformance (PDF/A-2b) indicates minimal compliance to ensure that the rendered visual appearance of a 
conforming file is preservable over the long term. 

• 1.7.3: extension level 3 of PDF 1.7. For more information consult the Adobe website. 

• 1.7.5: extension level 5 of PDF 1.7. For more information consult the Adobe website. 

• 1.7.8: extension level 8 of PDF 1.7. For more information consult the Adobe website. 

Languages 

Select the language of your documents. Selecting the right language is essential to obtaining good recognition results. 

To add a secondary language, click the plus sign, then select the required language. Languages that cannot be combined 
with the primary language you selected are grayed out. The recognition can combine up to four languages. 

Options 

The available options depend on the PDF Type and Version you select. 

Create bookmarks: bookmarks are types of links inside a PDF document, which contain representative information 
about the section they are linked to. Bookmarks give structure to your PDF documents. They are grouped in the 
Bookmarks panel in the Navigation pane of your PDF viewer.  

If you define the Output settings as follows: 

• Naming: Batch.Name 

• Format: PDF > Edit Options > Create bookmarks (checked) 

• Destinations: Append to existing file (checked) 

then one PDF is created per batch and the batch's documents define the bookmark name and location in the final PDF. 

 

Creating PDF bookmarks per batch 

  

JPEG 2000 compression: when saving files in PDF, IRISPowerscan™ can apply JPEG 2000 compression to the color-
grayscale images stored inside those files. 

Include graphics: includes graphics in the output documents. 

Retain colors of text: keeps the original color of the text in your source documents. 
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Embed fonts: embeds - or includes - the original fonts of your documents in the PDF file. This way, other users will 
always see the documents in their original fonts on their computer, even if they don't have the particular font you used 
installed on their computer. 

JPEG Quality slider: when the option JPEG 2000 compression is selected, you can determine the JPEG Quality with the 
slider. Move the slider to the left to decrease the JPEG Quality. Move the slider to the right to increase it. 

Security tab 

The PDF documents you generate with IRISPowerscan™ can be password-protected. You can set a password to open 
the documents, and a password that restricts modifications to the documents. 

• When you set an open document password, you will be prompted to enter that password when opening the 
PDF output. 

• When you set a permissions password, you will only be able to perform the actions specified in the security 
settings. If you do want to change these settings, you must enter the permissions password. 

The IRISPowerscan™ security settings are similar to the standard protection features offered by Adobe Acrobat. 

Note that in IRISPowerscan™ the open document password and permissions password must be different. 

Signature 

The PDF documents you generate with IRISPowerscan™ can be digitally signed. Digital signatures identify the person 
who created the PDF documents; they authenticate the identity of the author, certify a document and help prevent 
unwanted changes to PDF documents. 

Note, however, that IRISPowerscan™ does not generate digital signatures. You need to have a digital signature at your 
disposal to generate signed documents with IRISPowerscan™. You can create digital signatures with Adobe Acrobat or 
obtain them from companies like VeriSign. 

Metadata tab 

Enter the PDF document properties and keywords you want the output files to contain. These metadata will be 
embedded in the PDF files, and can be used to index these files. 

2. PDF iHQC (intelligent High Quality Compression) 

• Select PDF iHQC from the list. 

• Click the pencil icon to access the options. 

Generalities tab 

Version 

The same options are available as for PDF. See the PDF section above. 

Type 

Select the iHQC level you want to generate: 

• Level I: This level offers the lowest compression, but it is compatible with PDF version 1.4 - and its two 
subtypes - and higher. 

• Level II_a:This is the default compression level. It is compatible with PDF version 1.5 and higher. 

• Level II_b: This level offers the second highest compression. It is compatible with PDF version 1.5 and higher. 

• Level III: This level offers the highest compression. It is compatible with PDF version 1.5 and higher. 

For each level you can move the slider to choose between different Good size and Good quality options. Try the 
different settings to obtain optimal results. 
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Languages 

The same options are available as for PDF. See the PDF section above. 

Options 

Create bookmarks: See the PDF section above. 

Image-only: select this option to generate image-only PDF iHQC documents, without text recognition. 

Security tab and Metadata tab 

The same options are available as for PDF. See the PDF section above. 

3. XPS 

Similar options are available as for PDF. See the PDF section above. 

4 XPS iHQC 

Similar options are available as for PDF iHQC. See the PDF iHQC section above. 

5. Text Documents 

IRISPowerscan™ can generate Word (.docx) and RTF documents. 

Several layout settings are available for Word and RTF documents. Again, a slider is available that allows you to obtain 
the best possible compression ratio. 

Note that Text documents do not have any layout or compression options. They only contain recognized text with no 
images. 

 

Languages 

Select the language of your documents. Selecting the right language is essential to obtaining good recognition results. 

To add a secondary language, click the plus sign, then select the required language. Languages that cannot be combined 
with the primary language you selected are grayed out. The recognition can combine up to four languages. 

Layout 

• The option Create body text generates a continuous, running line of text. The result is a document without any 
formatting. The formatting is to be done manually, by the user. 

• The option Retain word and paragraph formatting keeps the general format structure of your scanned 
document. 
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The font type, size and type style are maintained across the recognition process. 

The tabs and the alignment of each block are recreated. 

The text blocks and columns aren't recreated; the paragraphs just follow each other. 

Tables are recaptured correctly. 

Pictures are not captured. 

• The option Recreate source document tries to stay as close to the original layout as possible. 

The text blocks, tables and pictures are re-created in the same place as the original. 

The word and paragraph formatting are maintained. 

Hyperlinks are re-created too. 

• The option Use columns instead of frames creates columns instead of text frames to position the 
information on the page. 

Columnized texts are easier to edit than documents containing multiple frames: the text flows 
naturally from one column to the next. 

Note: should IRISPowerscan™ be unable to detect columns in the source document, then frames are 
still used as substitute solution. 

Tip: use this option when generating Word documents. 

• The option Insert column breaks inserts a hard column break at the end of each column, which 
maintains the format of the text. Any text you edit, add or remove, remains inside its column; no text 
flows automatically across a column break. 

Tip: disable this option (Insert column breaks) when you have body text that contains columns. 
You'll ensure the natural flow of the text from one column to the next. 

• The option Add image as page background places the scanned image as page background beneath 
the recognized text. 

Note: this option increases the file size of the output files substantially. 
The format PDF Text-Image modifies PDF files in the same manner. 
To avoid the file increase discussed above,  select the option Retain colors of background in the 
Options section. This provides a similar but less drastic, more compact alternative. 

Options 

• The option Merge lines into paragraphs enables automatic paragraph detection. 

IRISPowerscan™ wordwraps the recognized text until a new paragraph starts, and reglues hyphenated 
words at the end of a line. 

• The option Include graphics does exactly what it says; it includes images in your output documents. 

Clear this option in case you only need lay-outed text. 

• The option Retain colors of text keeps the original color of the text in your source documents. 

• The option Retain colors of background recreates the background color of each document. 

6. Indexes (.xml) 

• Select Indexes (.xml) from the list. 

• Click the pencil icon to access the options. 

• Select the Encoding: ASCII, UTF8 or UTF16. 

• Select when the index file must be created: per batch or per document. 
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7. Indexes (.csv) 

• Select Indexes (.csv) from the list. 

• Click the pencil icon to access the options. 

• Select the Encoding: ASCII, UTF8 or UTF16. 

• Specify the content of the header. The default value is Document.Fields.Header. 

• Specify the content of each row. The default value is Document.Fields.Value. 

These values create a csv file that contains the names and values of all index fields. Note that any 
other variables can be used. See Using Expressions. 

• Specify the frequency of a file creation: per batch or per document. 

8. Indexes (.xlsx) 

• Select Indexes (.xlsx) from the list. 

• No options can be configured via the pencil icon. The options are fixed: 

• One file is created per batch. 

• Document fields of the type TableField are not exported. All other types are. 

• All fields are exported to the first worksheet of the Excel file. 

• The field names are entered on the first line of the Excel file. 

• The document indexes are entered from the second line onward. One document index is entered per 
line. 

Note: if the project parameter CollisionHandlingAppend is set to Yes, IRISPowerscan™ appends the new content if 
an existing file of the same name is encountered. 

9. Image Files 

IRISPowerscan™ can generate the following image files: JPEG, PNG, BMP, Single Page TIFF and Multipage TIFF. 

Image Types 

JPEG 

JPEG is a compressed image file format. JPEG images can contain colorful, high-resolution image data. Note however, 
that JPEG is a lossy format. If the images are compressed too much, the image quality decreases. 

JPEG images are often used on the Web. 

PNG 

PNG stands for Portable Network Graphic. It is a lossless format, which means it doesn't lose any detail when it is 
compressed. PNG uses indexed colors and supports up to 48-bit color or 16-bit grayscale. 

Single page TIFF and Multi page TIFF 

TIFF stands for Tagged Image File Format. TIFF is a high-quality graphics format that supports color depths from 1 to 24-
bit. It is designed to be a standard image format for storing high-quality color images, such as photos, on multiple 
computer platforms. 

Single page TIFF files contain only one page, while Multi page TIFF files can contain multiple pages. 
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TIFF images can be compressed in several ways. See Image Settings below. 

BMP 

BMP is short for bitmap. It is an uncompressed raster image made up of a rectangular grid of pixels. The BMP format 
stores color data for each pixel in the image without any compression. This method of storing allows for crisp, high-
quality graphics but also produces large image files. 

BMP images are often used for printable images. 

Image Settings 

JPEG and TIFF 

A slider is available that allows you to obtain the best possible compression ratio. 

 

Compression slider 

TIFF settings 

More advanced compression options are available for TIFF files. 

IRISPowerscan™ can compress the color, grayscale and black-and-white image inside the documents. 

Grayscale and color image compression options 

• TIFF JPEG compression 

TIFF JPEG compression is a lossy form of compression. The degree of compression can be adjusted allowing a 
selectable trade-off between storage size and image quality. 

• LZW compression 

LZW compression is a universal lossless data compression algorithm. This means it produces no loss of image 
quality at all. This form of compression results in somewhat bigger output files. 

• Packbits 

Packbits is a fast and lossless compression scheme for run-length encoding of data. 

• Uncompressed 

Uncompressed avoids compression altogether. 

Black and white image compression 

• TIFF Group 4 compression 

TIFF Group 4 compression is a method of image compression used in Group 4 fax machines. It is only used for 
monochrome (black and white) images. Group 4 compresses files at a rate of 20:1. 

• TIFF Group 3 compression 

TIFF Group 3 compression is an older fax compression. 

• LZW compression 
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LZW compression is a universal lossless data compression algorithm. This form of compressions results in 
somewhat bigger output files. 

• Packbits 

Packbits is a fast and lossless compression scheme for run-length encoding of data. 

• Uncompressed 

Uncompressed avoids compression altogether. 
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14.2 Select the Destination 

If necessary, see Configuring the Output to learn how to access the Output Formats. 

 

WARNING: for trouble-free exports, we strongly recommend that you limit large documents to no more than 1000 
pages per document.  
If really needed, that limit can be increased up to 4000 pages per document (200 or 300 dpi color) by adding and 
setting the parameter BigDocumentExport to 'Yes'. See Configuration Pane > Parameters 

14.2.1 Overview of the Destinations 

Email 

To:  

o Or choose an e-mail address. Enter the recipient in the To field, or click To to select a recipient from one of 
your address lists.  

o Or choose an expression. Enter your expression in the To field, or click the pencil button to select an 
expression from the Expression editor.  

WARNING: the e-mail address must be between double quotation marks. E.g. 
"john.smith@iriscorporate.com". 

Cc: enter a recipient in Carbon copy. Or click Cc to select a recipient from one of your address lists. 

Subject: the subject of the email is set to the document name by default. Note that Document.Name is simply the 
variable that makes sure the right document name is used. You can also use other variables. 

Body: the body content of the email is set to "The Document.Name is attached" by default. Again, you can also use 
other variables. 

Size: enter the maximum size an email may have. The default size is 2048 Kb. 

Split: select Split to send one email per document. 

Options (Email protocol): mapi (default, to send from your local mail client) or Smtp (for Webmail). 

When Smtp is selected: 

o Enter the Host name and Port number. 

o Set the Timeout time after which IRISPowerscan™ stops trying to send the email. The default 
time is 60 seconds. 

o If necessary select Use SSL to use a Secure Socket Layer. 

o Enter your User name and Password. 

WARNING: when the Export is being done by the Service, Mapi cannot be used. Only SMTP works in that 
configuration. 
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Folder 

Path 

The default folder is set to System.OutputDirectory + "\" +  System.ProjectName + "\" + Batch.Name. 

• System.OutputDirectory corresponds to the user's Documents folder. 

• System.ProjectName corresponds to the name of the current project. 

• Batch.Name corresponds to the name of the exported batch. 

 

To customize the expression click the pencil icon to open the Expression Editor. 

WARNING: when customizing the expression, make sure to put '+ "\" +' between the different elements. 

Note that you can also use fixed values between double quotation marks. For example "C:\Images". 

WARNING: should you add the variables System.Now or System.Today to the Path, make sure the Culture 
of your Windows System Account corresponds to the language of your Windows User Account. After all, in 
some cultures dates are formatted as dd/mm/yyyy while in others they are formatted as mm/dd/yyyy. To 
do so, see How to synchronize Date formats between IRISPowerscan™, your Windows System Account 
and your Windows User Account in the How To Guide. 

To select a different folder, click the browse icon and then browse for the folder. 

Tip: to put the default folder back, just press Esc and IRISPowerscan™ completes the default location. This 
works for every expression. 

If the folder you want to scan to is protected by a password, click the padlock icon ( ). 

• Enter your (domain ) User name. E.g. IRIS_DOM\MyName. 

• Enter your Password. 

• Confirm the password, and click OK. 

 

Signal 

Enter a path in the Signal field if you want to use Connected Projects on a single IRISPowerscan™ workstation. See 
Using Connected Projects for more information. 

  

Options 

Overwrite existing file: when this option is selected and a file of the same name is encountered in the output folder, 
IRISPowerscan™ will overwrite the existing file with the new one.  

Append to existing file: when this option is selected and a file of the same name is encountered in the output folder, 
IRISPowerscan™ will add the new content to the existing file.  
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• The Append option is available for the following output formats: PDF, PDF-iHQC, TIF, XLSX, CSV and 
DOCX. However, using the DOCX format with large files or with files including images might lead to 
errors. In this case, we recommend that your file does not exceed 500 pages.  

• The Append option cannot be used on signed PDF files. 

• The Append option and the Overwrite option cannot be selected at the same time. You must select 
one or the other. If neither of these two options is selected, and a file of the same name is encountered 
in the output folder, a Copy File window is displayed in which you can choose whether to save the file 
under a new name, overwrite the existing file, append to the existing file or skip the file. 

Note: the Do this for all conflicts option only applies to the current output format. If you are exporting in 
multiple output formats and an existing file is encountered for one of the other output formats the Copy 
File window will be displayed again. 

 

Printer 

WARNING: Output to a Printer is not supported as a Service  

• Select a printer from the drop-down list. 

o Click the settings icon to access the printer options. 

o Select the options of your choice. When you are done, click Finish to close the printer options. 

• Select the Scaling options: 

o Actual size: this option keeps the absolute size of the image. E.g. an A4 image will match the size of an 
A4 printer sheet, regardless the printer and image resolutions. 

o Fit the page: this option makes the image fit the printer sheets, whatever their size is. 

o Actual pixel: this option prints the image pixel for pixel, regardless the printer and image resolutions. 

• Select Show Preview if you want IRISPowerscan™ to show a preview of the print result before actually sending 
the results to the printer. 

SharePoint 

Step 1 

• Enter the Server url. 

• Enter the User name and Password, if required. 

Whether or not a user name and/or password are required depends on your configuration. If necessary, contact 
your System Administrator. 

If your computer is located in a domain, you may need to add the domain name followed by a back slash in front 
of the User name. E.g. Your_Domain\jsmith. 
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• Click Next to establish the connection. 

Step 2 

• If the connection is successful, and if your server contains any libraries, the list of available libraries is 
displayed. 

• Select a library to which you want to send the documents, and click Next. 

Step 3 

• Now you can select a specific folder inside the library where the documents will be sent. 
If you do not select a folder, the documents are stored in the root of the library. 

Step 4 

• Select a content type. 
The scanned pages will be stored as this type of object. 

Step 5 

• The index fields you have defined for the selected content type in your target system are displayed. 

• You can now map them to your IRISPowerscan™ index fields. 

 

• When you are done, click Finish. 

Therefore, IRISNext, CMIS, FileNet 

• Enter the Server url. 

• Enter the User name and Password, if required. 

Whether or not a user name and/or password are required depends on your configuration. If necessary, contact 
your System Administrator. 

If your computer is located in a domain, you may need to add the domain name followed by a back slash in front 
of the User name. E.g. Your_Domain\jsmith. 

• Click Next to establish the connection. Then follow the steps of the Wizard. 

Box, Dropbox, Google Drive, OneDrive 

• Enter the User name and Password of your account. 

• Click Next to establish the connection and to optionally select a subfolder. 
If you do not select a subfolder, the scans are sent to the root directory. 

• When you are done, click Finish. 

Evernote 

• Enter the User name and Password of your account. 

• Click Next to establish the connection and select a subfolder. 

Note that you cannot send documents to the root of Evernote. 

• When you are done, click Finish. 
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IRISXtract™ 

• Browse for the folder that will be used as Input folder by IRISXtract™. 

  

Notes:  
When sending documents to this folder, the necessary Signal and Data folders (required by IRISXtract™) are 
created automatically. 
The para.dat file inside the Signal folder contains the index fields per document. 

IRISConnect™ 

By means of IRISConnect™you can configure other destinations that the ones for which you have a specific connector in 
IRISPowerscan™. 

If you already have an IRISConnect .xml configuration file: 

• Click the browse icon and select the file. 

• Now click the pencil to access the IRISConnect™interface. 

You can now continue the configuration. For instance to map the fields of your destination file system to the fields you 
created in IRISPowerscan™. 

 

If you do not have a configuration file yet: 

• Click the plus icon. 

• Select a target from the list and click OK to continue. 
Now you can do the configuration. 

For information on how to do the configuration, see the IRISConnect™documentation. 
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15. Using Expressions and Scripts 

15.1 Using Expressions 

Expressions 

Expressions are evaluated at run time in IRISPowerscan™ and are used for batch and document naming, indexing, etc. 

An expression consists of literal values, variables, operators and functions. 

Literal values are either numeric (e.g. 123) or alphanumeric (e.g. "abc"). 

Note that string literals are delimited by double quotation marks. 

Variables are updated by operations. 

Examples 

The operation Blank Page Detection updates the variables Image.IsBlank and Page.IsBlank. 

The operation Attach Page updates the variable Page.IsAttached. 

The operation Extract Data updates multiple variables for each OCR or BCR zone. 

The operation Set Variable can be used to create new variables. 

New functions can easily be added by means of scripting. 

Note: these expressions are not related to standard regular expressions (RegEx). However, standard regular 
expressions can be added via functions and scripting. 

Conditions 

A condition is a Boolean expression, which means an expression whose value is either true or false. 

Conditions can for instance be used to uniquely identify pages, separate documents and batches, check the validity of 
index fields, filter output types, etc. 

Conditions can be created by means of the Wizard ( ) and the Expressions editor ( ). 

 

Use of Expressions 

Expressions can be used in IRISPowerscan™ to configure naming options, conditions, formulas, etc. The Expressions 
Editor is indicated by a pencil icon. Click the icon to open it. 
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In the Expression Editor you can build complex expressions. 

 

15.1.1 Overview of the available variables 

The list below is the default list. Notice the different elements within the Expression Editor: 

• Variables are marked by a yellow star. 

• Index fields are marked by an orange grid. 

• Data Extraction zones are marked by a white square. 

• Functions are marked by a scroll. 

Note that any data extraction zones you create are added to the variables list. 

Zone variables Description 

Batch.Field1 Default index field of the batch 

Document.Field1 Default index field of the document 

Field Value of the current index field*. 

Fields.Header Fields header (CSV format) = new Document.Fields.Header 

Fields.Values Fields values (CSV format)= new Document.Fields.Values 

Batch variables Description 

Batch.Confidence Confidence level between 1 (very low) and 100 (very high) 

Batch.Count Batch count 

Batch.Counter Number of batches 

Batch.Counters[Batch] Number of batches of a particular batch type. 

The number is indicated between the brackets. 

Batch.Index Batch index 

Batch.IsExported True if the current batch has already been exported. 

Batch.Name Name of the current batch 

Batch.Type Type of the current batch (after classification) 
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Batch.Fields.Header Fields Header of the batch (CSV format) 

Batch.Fields.Values Fields Header of the batch (CSV format) 

Document variables Description 

Document.Confidence Confidence level between 1 (very low) and 100 (very high) 

Document.Count Document count within the current batch 

Document.Counter Number of documents 

Document.Counters[Document] Number of documents of a particular document type. 

The number is indicated between the brackets. 

Document.Index Document index within the current batch 

Document.IsExported True if the current document has already been exported. 

Document.Name Name of the current document 

Document.Type Type of the current document (after classification) 

Document.Fields.Header Fields Header of the Document within the current batch (CSV format) 

Document.Fields.Values Fields Values of the Document withing the current batch (CSV format) 

Image variables Description 

Image.Bpp Bits per pixel 

Image.Count Image count within the current page 

Image.Endorser The printed value that IRISPowerscan receives from the imprinter functionality 
of the scanner 

Image.Front True if the current image is on front side 

Image.Height Height of the current image 

Image.Index Index of the image 

Image.IsBest True if the current image is the best image (highest BPP) 

Image.IsBitonal True if the current image is bitonal 

Image.IsBlackAndWhite True if the current image is black and white 

Image.IsBlank Is only available when a Blank Page Detection operation has been defined. 

Image.IsBlank is true if the image is blank. 

Image.IsColor True if the current image is a color image 
(Bpp == 24) 

Image.IsGrayscale True if the current image is grayscale 

Image.IsLandscape True is the current image is in landscape mode 

Image.IsOriginal True if the current image is original (not modified) 

Image.IsPortrait True if the current image is in portrait mode 

Image.IsTrueColor True if the current image is in true color 

Image.Rear True if the current image is on rear side 

Image.Resolution Resolution of the current image 

Image.Size Size of the current image 

Image.Title.Detected True if a title has been detected 
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Image.Fingerprint Is only available when a Fingerprint Detection operation has been defined. 

Image.Fingerprint is the page type returned by the Fingerprint (layout) 
recognition engine. 

Image.Width Width of the current image 

Input variables Description 

Input.Extension Extension of the input file 

Input.FileName File name of the input file 

Input.PageIndex Page index within multipage input file 

Input.Path Path of the input file 

Mail variables Description 

Mail.Cc Cc recipients' email address(es) 

Mail.Cc.DisplayNames Displays Cc recipients' display names 

Mail.Date Sent date 

Mail.From Sender's email address 

Mail.From.DisplayNames Displays sender's display name 

Mail.Name XMail Fetcher subfolder. E.g. Mail00000001) 

Mail.PageIndex Index within each email (Which will be used for document separation) 

Tip: to create one document per email use the Condition Mail.PageIndex == 0 

Mail.Path XMail Fetcher Output path 

Mail.Received Reception date 

Mail.ReplyTo Recipients' email address 

Mail.ReplyTo.DisplayNames Displays recipients' display names 

Mail.Subject Email subject 

Mail.To Recipient's email address(es) 

Mail.To.DisplayNames Displays recipients' display names 

Output variables Description 

Output.Name Name of the output document. 

Is only available during export. 

Output.Type Type of the output. 

Is only available during export. 

Page variables Description 

Page.Confidence Is only available when a Page type has been defined. 

Confidence level between 1 (very low) and 100 (very high) 

Page.Count*** Page count within the current document 

Page.Index*** Page index within the current document 

Page.IsBlank Is only available when a Blank Page Detection operation has been defined. 

Page.IsBlank is true if both the rear and front images of the page are blank. 

Page.IsAttached True if the page is attached 

Page.Type Type of the current page (after identification) 
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System variables Description 

System.DefaultExportDirectory Default export directory 

System.DefaultImportDirectory Default import directory 

System.FileName Current file name 

System.InputDirectory Current input directory 

System.MachineName Machine name 

System.Now** Current time 

System.OutputDirectory Current output directory 

System.ProjectDirectory Project directory 

System.ProjectName Project name 

System.ScanningDirectory Scanning directory 

System.Today** Current date 

System.UserName User name 

System.WindowsUserName Windows user name 

  

IMPORTANT 

1. Other index field can be referenced as follows: 

<document type>.<field name> 

Or <batch type>.<field name> 

E.g. If you have defined a document type called “MyType” containing two fields “Field1” and “Field2” then the 
variable MyType.Field1 contains the value of the index field Field1 and the variable MyType.Field2 contains 
the value of the index field Field2. 

2. Should you add the variables System.Now or System.Today to the Path, make sure the Culture of your 
Windows System Account corresponds to the language of your Windows User Account. After all, in some 
cultures dates are formatted as dd/mm/yyyy while in others they are formatted as mm/dd/yyyy. To do so, see 
How to synchronize Date formats between IRISPowerscan™, your Windows System Account and your 
Windows User Account in the How To Guide. 

3. In the previous versions of IRISPowerscan 10, a page used to be the scanned equivalent of a paper sheet, i.e. 
containing both the Front and Rear side. 

This has implications for Duplex scanning projects where the variables Page.Index or Page.Count is used to 
separate Documents or Batches. Suppose you configured the project to start a new Document every 2 pages: 
Page.Index>2. Because of the new Page structure in IRISPowerscan™ this must be changed to Page.Index>4. 
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15.1.2 Overview of the available operators 

Common Operators 
(can be applied to any type) 

Examples / Description 

Equals (==) Value 1 == Value 2. Value 1 is equal to Value 2. 

Not equals (!=) Value 1 != Value 2. Value 1 is not equal to Value 2. 

Greater than (>) Value 1> Value 2. Value 1 is greater than Value 2. 

Greater than or Equals (>=) Value 1 >= Value 2. Value 1 is greater than or equal to Value 2. 

Less than (<) Value 1 < Value 2. Value 1 is less than Value 2. 

Less than or Equals (<=) Value 1 <= Value 2. Value 1 is less than or equal to Value 2. 

String Operators Examples / Description 

String ("") Concatenates values. E.g. "a" + "bc" == "abc" 

Boolean Operators Examples / Description 

Not (!) logical NOT 

And (&&) logical AND 

Or (||) logical OR 

Is Null or Empty True if the parameter is null or an empty string 

Is Not Null or Empty True if the parameter is not null or an empty string 

Contains ("") True is the parameter is found in the string 

Not Contains (!Contains"") True if the parameter is not found in the string 

Numeric Operators Examples / Description 

Add (+) Value 1 + Value 2. Adds Value 1 to Value 2. 

Subtract (-) Value 1 - Value 2. Subtracts Value 2 from Value 1. 

Multiply (*) Value 1 * Value 2. Multiplies Value 1 by Value 2. 

Divide (/) Value 1 / Value 2. Divides Value 1 by Value 2. 

Modulo (%) Value 1 % Value 2. The remainder of the division of Value 1 by Value 2. E.g. (Value 
1 % 2) == 1 means that Value 1 is odd. 

Conversion Operators Examples / Description 

String(Value) Converts Value into a String 

Integer(Value) Converts Value into an Integer 

Double(Value) Converts Value into a Double 

Ternary Operator Examples / Description 

Ternary (?) ?(<condition>,<value if the condition is true>, <value if the condition is false>). 

E.g. ?(Page.Index < 1, true, false). Returns true if the page index is less than 1. 

  

E.g. ?(Page.Index == 2, Image.Zone1, ""). This extracts Image.Zone1 on the 
second page. 

  

Note: in IRISPowerscan™ unknown variables are by default replaced by an empty string. For instance, if the 
variable Page.Index is unknown or not found in the expression “Page (“ + Page.Index + “), then the expression will 
be evaluated as “Page()”. 
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To avoid that expressions which contain unknown variables are evaluated, go to the Configuration pane and set the 
StrictIndexEvaluation parameter to 'Yes'. If this parameter is set to 'Yes' and an unknown variable is encountered, the 
expression will not be evaluated and the index field will be empty. 

15.1.3 Variables Example 

Since the Expression possibilities are extremely vast, we will limit ourselves to an example. 

Suppose you want IRISPowerscan™ to start a new Document each time it encounters a certain OCR zone AND a certain 
barcode on a page. To accomplish this you need to use a combined expression. 

• First add a Sample page that contains the required OCR zone and the required barcode. 

 

Example 

• Go to Data Extraction in the Designer Explorer. 

• Draw a frame around the OCR zone you want to use. 

• Select Text as Type. 

• Enter a Name for the zone. 

• Select the correct Language of the zone. 

 

• Click OK to confirm. 

• Then draw a frame around the Barcode zone you want to use. 

• Select Barcode as Type. 

• The correct barcode type is selected automatically. 

• Enter a Name for the zone. 

 

• Click OK to confirm. 

• Go to the default Document type in the Designer Explorer. 
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• Click the pencil next to Condition. 

• Scroll down the list and double-click the OCR zone you created. In our example: Image.OCRzone. 

• Double-click Equals (==). 

• Enter the value of the OCR zone between quotation marks. In our example: "Form". 

• Double-click And (&&). 

• Scroll down the list and double-click the Barcode zone you created. In our example: Image.BarcodeZone. 

• Double-click Equals (==). 

• Enter the value of the Barcode zone between quotation marks. In our example: "Insurance contract". 

• Click OK to confirm. 
The expression now looks like this. 

 

Note: the different elements of an expression can be edited to test the expression. 

 

Note: in IRISPowerscan™ unknown variables are by default replaced by an empty string. For instance, if the 
variable Page.Index is unknown or not found in the expression “Page (“ + Page.Index + “), then the expression will 
be evaluated as “Page()”. 

To avoid that expressions which contain unknown variables are evaluated, go to the Configuration pane and set the 
StrictIndexEvaluation parameter to 'Yes'. If this parameter is set to 'Yes' and an unknown variable is encountered, the 
expression will not be evaluated and the index field will be empty. 
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15.2 Using Scripts 

Scripts can be used to extend the functions that are used in the expressions. You can define your own functions and call 
them in any expression. 

To add a script: 

• In the Designer Explorer, right-click Script and click Create. 

• Double-click the Script you have added to open its configuration window. 

 

• Click the browse icon to indicate the path of the script you want to call. 
The default script is located in C:\Users\<YourUser>\AppData\Roaming\IPSx. 

 

Example script 

WARNING: scripts must be written in C#. VB scripts are not longer tested, therefore not recommended. 
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16. The IRISPowerscan™ Agent 

The Agent application is by default installed. Unless you cleared the option System Tray icon during setup. 

The Agent is available in the System Tray. 

 

It allows you to do the following quick actions: 

• Open IRISPowerscan™ by clicking the icon. 

• Right-click the icon to display the context menu: 

Open...: opens IRISPowerscan™. 

Scan: scans documents to IRISPowerscan™. 

Update: installs updates if available. 

About: displays version information. 

Exit: exits the context menu. 

The Agent also alerts you when scanned batches are available, even when the IRISPowerscan™ main application is not 
running. 
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17. Keyboard Shortcuts 

The following shortcuts can be used in IRISPowerscan™: 

Navigation 

Show Navigation mode Ctrl + 1 

Show Designer mode Ctrl + 2 

Edit tab Alt + H 

View tab Alt + V 

Next field Tab 

Previous field Shift + Tab 

Next invalid field Ctrl + Tab 

Previous invalid field Ctrl + Shift + Tab 

Go to page Ctrl + G 

Up BackSpace 

First image Alt + Home 

Last image Alt + End 

Previous image Alt + Up 

Next image Alt + Down 

Search previous text Shift + F3 

Search next text F3 

Move up (Navigation or Designer Explorer) up arrow 

Move down (Navigation or Designer 
Explorer) 

down arrow 

Browse backward (previous element in 
history) 

Alt + left arrow 

Browse forward (next element in history) Alt + right arrow 

Expand Ctrl +  * 

Expand all Ctrl + Shift + * 

Collapse Ctrl + / 

Collapse all Ctrl + Shift + / 

Expand element (Navigation or Designer 
Explorer) 

right arrow 

Close element (Navigation or Designer 
Explorer) 

left arrow 

Open the Open section (of the Application 
menu) 

Ctrl + O 
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Open the Create section (of the Application 
menu) 

Ctrl + N 

Open the Manage section (of the 
Application menu) 

Ctrl + M 

Toggle Focus (Navigation mode) Ctrl + W 

Scroll sample images (Designer 
Explorer/Operations) 

Alt + down/up arrow 

Commands 

Help F1 

Display key tips Alt 

Quick access toolbar 
Alt + digit or letter in commands 
order 

Save Ctrl + S 

Cut Ctrl + X 

Cancel Cut Escape 

Copy Ctrl + C 

Paste Ctrl + V 

Quiet delete Shift + Delete or Delete 

Undelete Ctrl + Delete 

Redo Ctrl + Y 

Undo Ctrl + Z 

Scan F4 

Stop Scan Shift + F4 

Rescan F5 

Settings F6 

Split F7 

Merge Shift + F7 

Merge previous Ctrl + F7 

Merge next Ctrl + F8 

Attach Insert 

Detach Ctrl + Insert 

Delete Delete 

Export F9 

Wizard F12 

Zoom In Ctrl + Num+ 
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Zoom Out Ctrl + Num- 

Zoom fit page Ctrl + Num . 

Zoom actual size Ctrl + Num 0 

Display 1 page in the Viewer 1 

Display 2 pages in the Viewer 2 

Display 4 pages in the Viewer 4 

Display 8 pages in the Viewer 8 

Rotate Left Ctrl + L 

Rotate Right Ctrl + R 

Auto rotate Alt + A 

Create document Ctrl + D 

Create batch Ctrl+ B 

Rename F2 

Capture recognition zone Enter 
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18. Connect to the IRISPowerscan Server™ 

In order for users to collaborate on projects that are managed by the IRISPowerscan Server™, they must connect their 
IRISPowerscan™ Client to the IRISPowerscan Server™ and log in using the credentials that were defined in the 
IRISPowerscan Server™. 

Prerequirements 

• The IRISPowerscan Server™ must be installed correctly in a location to which the IRISPowerscan™ Client has 
access. 

Note: the IRISPowerscan Server™ can be found on the IRISPowerscan™ installation cd and on 
www.irislink.com/downloadcenterpro. 

• The IRISPowerscan Server™ Service must be started. 
To check if it is started: 

• Open the IRISPowerscan Server™ application. 

• Click the traffic light icon in the bottom ribbon, and make sure "Starting Service" appears in the pop-
up window. 

 

• The Central Management add-on must be activated in the IRISPowerscan™ Client. 

Note: this add-on must be installed on each IRISPowerscan™ Client that wants to connect to the 
IRISPowerscan Server™. 

• By default port 8080 must be open to connect to the server. 
In case that port is used by another application, you can change the port for IRISPowerscan™. 
To change the port: 

• Start the IRISPowerscan Server™ Service as described above. 

• On the computer where IRISPowerscan Server™ is installed, open a browser and go 
to %programdata%\IPSxServer\LocalProjects. 

• Right-click settings.xml and click Edit. 

• Change the port from 8080 to another one. 

 

• Save the settings.xml file. 

• Click the traffic lights icon again to stop and then to restart the IRISPowerscan Server™ Service. 

• Now go to File > Info > Generalities in the IRISPowerscan™ Client. 

• In the IRISPowerscan 10 Server field, enter the server address mentioning the new port in the 
following format <server>:<port>. For instance jsmith.iris.com:8020. Or if the server is installed on 
your local machine 127.0.0.1:8020. 

  

http://www.irislink.com/downloadcenterpro
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Step 1: Connect an IRISPowerscan™ Client to the IRISPowerscan Server™ 

• Open the IRISPowerscan™ Client. 

• Click File > Info > Generalities. 

• In the IRISPowerscan 10 Server section, enter the address where the IRISPowerscan Server™ is installed. 

• Then click Connect. 

 

• When the connection is established, click Restart now to restart the application. 

Step 2: Log in from the IRISPowerscan™ Client 

• Open the IRISPowerscan™ Client. 

• Click File > Login. 

• Click Yes to restart the application. 

• When the application restarts, enter your Domain\Username and Password and click OK. 

 

• Select the Project you want to open. 
The Projects that are listed here are the ones managed by the Server. 

• Carry out the actions for which you have permissions and click Process to process the documents. 

• The batches of documents that you process are shown in the Manage section of the Application menu. 
Click the pencil icon to view the Batch history. 

Note: a Client only sees the batches to which he has access. 

 

The Administrator can check the status of all Batches in the Batches section of the IRISPowerscan Server 
application. 
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The Administrator can also check the Logs for more information about the activities. 

 

  

Connection status on Client side 

In the bottom ribbon, a witness icon informs you of the connection status with the server. 

Connected:  or disconnected:  
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19. Using Connected Projects 

To speed up the processing you can use Connected Projects on a single IRISPowerscan™ workstation. This way you can 
for instance create one Project in which only the Image Processing is done, and another project in which the 
Identification and Separation are done. 

In order to connect Projects, Signal files and Watched Folders are used. 

Note: using Connected Projects has nothing to do with connecting IRISPowerscan™ workstations to the 
IRISPowerscan Server™. 

To connect Projects: 

• Create a new Project and select Folder as Destination. 

In this Project you will do one part of the processing. E.g. the Scanning and Image Processing operations. 

• Go to Designer > Properties and set the Validation and Export Activities to Service. 

• Go to Designer > Outputs > Output. 

• Enter a Path where the output documents will be stored. E.g. "C:\Input\" + Batch.Name. 

• Enter the Signal folder where the signal files will be stored. E.g. "C:\Signals\" + Batch.Name. 

WARNING: make sure to put a back slash at the end of the folder name. 

 

• Create a second Project and make sure to select Folders as Source. 

• Go to Designer > Properties and set the Capture Activity to Service. 
The Folder will now be a Watched Folder. 

 

• Enter the Path of the Folder you defined as Output Folder in the previous Project. 
In our example, this is "C:\Input\". 

• Enter the Signal folder you defined in the previous Project. 
In our example, this is "C:\Signals\". 
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• Return to the previous Project and process your documents. 
When all documents have been exported a signal file is created in the Folder you defined. In our case 
C:\Signals\. 

• Only when the Watched Folder of the second Project detects this signal file it will import the documents into 
the Project. 

In our example the subfolder "Batch 1" of the Watched Folder "C:\Input\" will be processed only if the 
Signal folder "c:\Signals\" contains a signal file named "Batch 1". 

• Return to the second Project and process the documents. They are now sent to the Output folder. 



IRISPowerscan 10.5 – User Guide 

195 

20. Using the Button Manager 

If your scanner is equipped with one or more scanner buttons, the IRISPowerscan™ Button Manager allows you to 
configure those buttons to start IRISPowerscan™ directly, open the Scan Project of your choice and start scanning 
documents, all at the touch of a button. 

The Button Manager is compatible with virtually any Twain-based scanner that uses Twain version 1.9 and higher. 

If you are using an ISIS-based scanner, make sure the ISIS-Driver Add-on has been activated. 

Before you configure the Button Manager: 

• Go to the Windows Control Panel > Devices and Printers. 

• Right-click your scanner and click Properties. 

• In the Events list select Start the Program. 

• Select IRISPowerscan 10 as application. 

In case this menu does not exist for your scanner: 

• Open your scanner's Scan Utility. 
E.g. Canon imageFormula Utility. 

• Configure the utility to access IRISPowerscan™ when you press the scanner button. 

 

Example 

Now configure the IRISPowerscan™ Button Manager: 

• Open the Button Manager from the Windows Programs list. 

 

• The scanner you configured is displayed in the Scanner list. 

• Select the button you want to configure, and then click Setup. 

 

• Enter a name for the Button. 

• Select one of the available Actions: 

• Open project: IRISPowerscan™ simply starts and opens your project when you press the scanner 
button. 

• Scan - new batch: IRISPowerscan™ starts, opens your project and creates a new batch. 

• Scan - new document: IRISPowerscan™ starts, opens your project and creates a new document. 

• Scan: IRISPowerscan™ starts, opens your project and scans. The scanned pages are added to the 
current batch and document. 

• Select the Project the Button Manager must open: the project you used last, or another specific project. 
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Note: only the projects that have a scanner as input source are listed here. 

• When you are done click OK to close the Settings. 

• Now press the scanner button to start scanning. 
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